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4 [U] 1 Read this—it will help

A Complete Stata Documentation Set contains more than 11,000 pages of information in the following
manuals:

[GS] Getting Started with Stata (Mac, Unix, or Windows)
U] Stata User’s Guide

R] Stata Base Reference Manual

D] Stata Data Management Reference Manual

G] Stata Graphics Reference Manual

XT]  Stata Longitudinal-Data/Panel-Data Reference Manual
ME]  Stata Multilevel Mixed-Effects Reference Manual

[MI] Stata Multiple-Imputation Reference Manual

[MV]  Stata Multivariate Statistics Reference Manual

[PSS]  Stata Power and Sample-Size Reference Manual

P] Stata Programming Reference Manual

SEM] Stata Structural Equation Modeling Reference Manual
SVY] Stata Survey Data Reference Manual

ST] Stata Survival Analysis and Epidemiological Tables Reference Manual
TS] Stata Time-Series Reference Manual

TE] Stata Treatment-Effects Reference Manual:
Potential Outcomes/Counterfactual Outcomes

[1] Stata Glossary and Index

[M] Mata Reference Manual

In addition, installation instructions may be found in the Installation Guide, which comes in the
DVD case.

1.1 Getting Started with Stata

There are three Getting Started manuals:

[GSM] Getting Started with Stata for Mac
[GSU] Getting Started with Stata for Unix
[GSW] Getting Started with Stata for Windows

1. Learn how to use Stata—read the Getting Started (GSM, GSU, or GSW) manual.

2. Now turn to the other manuals; see [U] 1.2 The User’s Guide and the Reference manuals.

1.2 The User’s Guide and the Reference manuals

The User’s Guide is divided into three sections: Stata basics, Elements of Stata, and Advice. The
table of contents lists the chapters within each of these sections. Click on the chapter titles to see the
detailed contents of each chapter.

The Guide is full of a lot of useful information about Stata; we recommend that you read it. If
you only have time, however, to read one or two chapters, then read [U] 11 Language syntax and
[U] 12 Data.
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The other manuals are the Reference manuals. The Stata Reference manuals are each arranged
like an encyclopedia—alphabetically. Look at the Base Reference Manual. Look under the name of
a command. If you do not find the command, look in the index. A few commands are so closely
related that they are documented together, such as ranksum and median, which are both documented
in [R] ranksum.

Not all the entries in the Base Reference Manual are Stata commands; some contain technical
information, such as [R] maximize, which details Stata’s iterative maximization process, or [R] error
messages, which provides information on error messages and return codes.

Like an encyclopedia, the Reference manuals are not designed to be read from cover to cover.
When you want to know what a command does, complete with all the details, qualifications, and
pitfalls, or when a command produces an unexpected result, read its description. Each entry is written
at the level of the command. The descriptions assume that you have little knowledge of Stata’s
features when they are explaining simple commands, such as those for using and saving data. For
more complicated commands, they assume that you have a firm grasp of Stata’s other features.

If a Stata command is not in the Base Reference Manual, you can find it in one of the other
Reference manuals. The titles of the manuals indicate the types of commands that they contain. The
Programming Reference Manual, however, contains commands not only for programming Stata but
also for manipulating matrices (not to be confused with the matrix programming language described
in the Mata Reference Manual).

1.2.1 PDF manuals

Every copy of Stata comes with Stata’s complete PDF documentation.

The PDF documentation may be accessed from within Stata by selecting Help > PDF Documen-
tation. Even more convenient, every help file in Stata links to the equivalent manual entry. If you are
reading help regress, simply click on [R] regress in the Title section of the help file to go directly
to the [R] regress manual entry.

We provide recommended settings for your PDF viewer to optimize it for Stata’s documentation at
http://www.stata.com/support/fags/res/documentation.html.

1.2.1.1 Video example

PDF documentation in Stata

1.2.2 Example datasets

Various examples in this manual use what is referred to as the automobile dataset, auto.dta. We
have created a dataset on the prices, mileages, weights, and other characteristics of 74 automobiles
and have saved it in a file called auto.dta. (These data originally came from the April 1979 issue
of Consumer Reports and from the United States Government EPA statistics on fuel consumption;
they were compiled and published by Chambers et al. [1983].)

In our examples, you will often see us type

. use http://www.stata-press.com/data/r13/auto


http://www.stata.com/support/faqs/res/documentation.html
http://www.stata.com/videos13/pdf-documentation/
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We include the auto.dta file with Stata. If you want to use it from your own computer rather than
via the Internet, you can type

. sysuse auto

See [D] sysuse.

You can also access auto.dta by selecting File > Example Datasets..., clicking on Example
datasets installed with Stata, and clicking on use beside the auto.dta filename.

There are many other example datasets that ship with Stata or are available over the web. Here is
a partial list of the example datasets included with Stata:

auto.dta 1978 Automobile Data

auto2.dta 1978 Automobile Data

autornd.dta Subset of 1978 Automobile Data

bplong.dta fictional blood pressure data

bpwide.dta fictional blood pressure data

cancer.dta Patient Survival in Drug Trial

census.dta 1980 Census data by state

citytemp.dta City Temperature Data

citytemp4.dta City Temperature Data

educ99gdp.dta Education and GDP

gnp96.dta U.S. GNP, 1967-2002

lifeexp.dta Life expectancy, 1998

networkl.dta fictional network diagram data

networkla.dta fictional network diagram data

nlsw88.dta U.S. National Longitudinal Study of Young Women (NLSW, 1988 extract)
nlswidel.dta U.S. National Longitudinal Study of Young Women (NLSW, 1988 extract)
pop2000.dta U.S. Census, 2000, extract

sandstone.dta Subsea elevation of Lamont sandstone in an area of Ohio
sp500.dta S&P 500

surface.dta NOAA Sea Surface Temperature

tslinel.dta simulated time-series data

tsline2.dta fictional data on calories consumed

uslifeexp.dta U.S. life expectancy, 1900-1999

uslifeexp2.dta U.S. life expectancy, 1900-1940

voter.dta 1992 presidential voter data

xtlinel.dta fictional data on calories consumed

All of these datasets may be used or described from the Example Datasets... menu listing.

Even more example datasets, including most of the datasets used in the reference manuals, are
available at the Stata Press website (http://www.stata-press.com/data/). You can download the datasets
with your browser, or you can use them directly from the Stata command line:

. use http://www.stata-press.com/data/r13/nlswork

An alternative to the use command for these example datasets is webuse. For example, typing

. webuse nlswork

is equivalent to the above use command. For more information, see [D] webuse.


http://www.stata-press.com/data/
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1.2.2.1 Video example

Example data included with Stata

1.2.3 Cross-referencing

The Getting Started manual, the User’s Guide, and the Reference manuals cross-reference each

other.

[R] regress

[D] reshape

[XT] xtreg
The first is a reference to the regress entry in the Base Reference Manual, the second is a reference
to the reshape entry in the Data Management Reference Manual, and the third is a reference to the
xtreg entry in the Longitudinal-Data/Panel-Data Reference Manual.

[GSwW] B Advanced Stata usage
[GSM] B Advanced Stata usage
[GSU] B Advanced Stata usage

are instructions to see the appropriate section of the Getting Started with Stata for Windows, Getting
Started with Stata for Mac, or Getting Started with Stata for Unix manual.

1.2.4 The index

At the end of each manual is an index for that manual. The Glossary and Index contains a combined
index for all the manuals.

To find information and commands quickly, you can use Stata’s search command; see [R] search.
At the Stata command prompt, type search geometric mean. search searches Stata’s keyword
database and the Internet to find more commands and extensions for Stata written by Stata users.

1.2.5 The subject table of contents

A subject table of contents for the User’s Guide and all the Reference manuals except the Mata
Reference Manual is located in the Glossary and Index. This subject table of contents may also be
accessed by clicking on Contents in the PDF bookmarks.

If you look under “Functions and expressions”, you will see

[U] Chapter 13 .. ... i Functions and expressions
[D] datetime ...............ciiiiiiiiin.. Date and time (%t) values and variables
[D] egen ... Extensions to generate
[D] functions .. ...ttt e e e Functions

1.2.6 Typography

We mix the ordinary typeface that you are reading now with a typewriter-style typeface that looks
like this. When something is printed in the typewriter-style typeface, it means that something is a
command or an option—it is something that Stata understands and something that you might actually
type into your computer. Differences in typeface are important. If a sentence reads, “You could list
the result ...”, it is just an English sentence—you could list the result, but the sentence provides
no clue as to how you might actually do that. On the other hand, if the sentence reads, “You could
list the result ...”, it is telling you much more—you could list the result, and you could do that
by using the 1ist command.


http://www.youtube.com/watch?v=_qb-qEkd-_c
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We will occasionally lapse into periods of inordinate cuteness and write, “We described the data
and then 1listed the data.” You get the idea. describe and list are Stata commands. We purposely
began the previous sentence with a lowercase letter. Because describe is a Stata command, it must
be typed in lowercase letters. The ordinary rules of capitalization are temporarily suspended in favor
of preciseness.

We also mix in words printed in italic type, such as “To perform the rank-sum test, type ranksum
varname , by (groupvar)”. Italicized words are not supposed to be typed; instead, you are to substitute
another word for them.

We would also like users to note our rule for punctuation of quotes. We follow a rule that is often
used in mathematics books and British literature. The punctuation mark at the end of the quote is
included in the quote only if it is a part of the quote. For instance, the pleased Stata user said she
thought that Stata was a “very powerful program”. Another user simply said, “I love Stata.”

In this manual, however, there is little dialogue, and we follow this rule to precisely clarify what
you are to type, as in, type “cd c:”. The period is outside the quotation mark because you should not
type the period. If we had wanted you to type the period, we would have included two periods at the
end of the sentence: one inside the quotation and one outside, as in, type “the orthogonal polynomial
operator, p.”.

We have tried not to violate the other rules of English. If you find such violations, they were
unintentional and resulted from our own ignorance or carelessness. We would appreciate hearing
about them.

We have heard from Nicholas J. Cox of the Department of Geography at Durham University, UK,
and express our appreciation. His efforts have gone far beyond dropping us a note, and there is no
way with words that we can fully express our gratitude.

1.2.7 Vignette

If you look, for example, at the entry [R] brier, you will see a brief biographical vignette of Glenn
Wilson Brier (1913—1998), who did pioneering work on the measures described in that entry. A few
such vignettes were added without fanfare in the Stata 8 manuals, just for interest, and many more
were added in Stata 9, and even more have been added in each subsequent release. Ten new vignettes
were added in Stata 13. A vignette could often appropriately go in several entries. For example,
George E. P. Box deserves to be mentioned in entries other than [TS] arima, such as [R] boxcox.
However, to save space, each vignette is given once only, and an index of all vignettes is given in
the Glossary and Index.

Most of the vignettes were written by Nicholas J. Cox, Durham University, and were compiled
using a wide range of reference books, articles in the literature, Internet sources, and information
from individuals. Especially useful were the dictionaries of Upton and Cook (2008) and Everitt and
Skrondal (2010) and the compilations of statistical biographies edited by Heyde and Seneta (2001)
and Johnson and Kotz (1997). Of these, only the first provides information on people living at the
time of publication.

1.3 What’s new

This section is intended for users of the previous version of Stata. If you are new to Stata, you
may as well skip to [U] 1.3.12 What’s more.

As always, Stata 13 is 100% compatible with the previous releases, but we remind programmers
that it is important to put version 12.1, version 12, or version 11, etc., at the top of old do-
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and ado-files so that they continue to work as you expect. You were supposed to do that when you
wrote them, but if you did not, go back and do it now.

We will list all the changes, item by item, but first, here are the highlights.

1.3.1 What’s new (highlights)

Here are the highlights. There are more, and do not assume that because we mention a category,
we have mentioned everything new in the category. Detailed sections follow the highlights.

1. Long strings/BLOBs.
The maximum length of string variables increases from 244 to 2,000,000,000 characters. The
standard string storage types strl, str2, ..., str244 now continue to str2045, and after that
comes strL, pronounced sturl. All of Stata’s string functions work with two-billion-character-long
strings, as do the rest of Stata’s features, including importing, exporting, and ODBC. strL variables
can contain binary strings. New functions, fileread() and filewrite (), make it easy to read
and write entire files to and from strLs.

See [U] 12.4 Strings.
(BLOB stands for binary large object, jargon used by database programmers.)

2. Treatment effects.
A new suite of features allows you to estimate average treatment effects (ATE), average treatment
effects on the treated (ATET), and potential-outcome means (POMs). Binary, multilevel, and multi-
valued treatments are supported. You can model outcomes that are continuous, binary, count, or
nonnegative.

Treatment-effects estimators measure the causal effect of treatment on an outcome in observational
data.

Different treatment-effects estimators are provided for different situations.

When you know the determinants of participation (but not the determinants of outcome), inverse-
probability weights (IPW) and propensity-score matching are provided.

When you know the determinants of outcome (but not the determinants of participation), regression
adjustment and covariate matching are provided.

When you know the determinants of both, the doubly robust methods augmented IPW and IPW
with regression adjustment are provided. These methods are doubly robust because you need to
be right about only the specification of outcome, or of participation.

Also provided are two estimators that do not require conditional independence. Conditional inde-
pendence means that the treatment and observed outcome are uncorrelated conditional on observed
covariates. Put another way, conditional independence implies selection on observables. New esti-
mation commands etregress and etpoisson relax the assumption. (etregress is an updated
form of old command treatreg; etpoisson is new.)

See the all-new Stata Treatment-Effects Reference Manual, and in particular, see [TE] teffects
intro.

By the way, if treatment effects interest you, also see [SEM] example 44g, where we use gsem—
another new feature of Stata 13—to fit an endogenous treatment-effects model that can be modified
to allow for generalized linear outcomes and multilevel effects.

3. Multilevel mixed effects and generalized linear structural equation modeling (SEM).
In addition to standard linear SEMs, Stata now provides what we are calling generalized SEMs for
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short. Generalized SEMs allow for generalized linear response functions and allow for multilevel
mixed effects.

Generalized linear response functions include binary outcomes (probit, logit, cloglog), count
outcomes (Poisson, negative binomial), categorical outcomes (multinomial logit), ordered outcomes
(ordered probit, ordered logit, ordered cloglog), and more, which is to say, generalized linear models
(GLMs).

Multilevel mixed effects include nested random effects such as effects within patient within doctor
within hospital and crossed random effects. Multilevel mixed effects also include random intercepts
and random slopes.

In the language of SEM, “multilevel mixed effects” means latent variables at different levels of the
data. This means Stata 13 can fit multilevel measurement models and multilevel structural equation

models.
bernoulli bernoulli bernoulli bernoulli bernoulli bernoulli bernoulli bernoulli
qt a2 a3 q4 as a6 q7 a8
logit logit logit logit logit logit logit logit

See [SEM] intro 1.

Economists: See [SEM] example 43g, where we show how to use Stata 13’s new SEM features
to fit the Heckman selection model, which can be extended to generalized linear outcomes and
random effects and random slopes.

4. New multilevel mixed-effects models.
Multilevel mixed-effects estimation has been improved and expanded and is now the subject of its
own manual. Stata had 3 multilevel estimation commands; now it has 11.
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The eight new multilevel mixed-effects estimation commands are

melogit logistic regression

meprobit probit regression

mecloglog complementary log-log regression
meologit ordered logistic regression
meoprobit ordered probit regression
mepoisson Poisson regression

menbreg negative binomial regression
meglm generalized linear models

These new estimation commands allow for constraints on variance components, provide robust and
cluster—robust standard errors, and are fast.

The three existing multilevel estimation commands have been renamed: xtmixed is now mixed,
xtmelogit is now meqrlogit, and xtmepoisson is now meqrpoisson. All three now present
results by default in the variance metric rather than the standard deviation metric.

As we said, multilevel mixed-effects modeling is now the subject of its own manual. See Stata
Multilevel Mixed-Effects Reference Manual, and in particular, see [ME] me.

. Forecasts based on systems of equations.
Stata’s new forecast command allows you to combine estimation results from multiple Stata
commands or other sources to produce dynamic or static forecasts and produce forecast intervals.

You begin by fitting the equations of your model using Stata’s estimation commands, or you
can enter results that you obtained elsewhere. Then you use forecast to specify identities and
exogenous variables to obtain a baseline forecast. Once you produce the baseline forecast, you
can specify alternative paths for some variables and obtain forecasts based on those alternative
paths. Thus you can produce forecasts under alternative scenarios and explore impacts of differing
policies.

You can use forecast, for example, to produce macroeconomic forecasts.

Dynamic Forecasts

Total Income Consumption
° o
8 R
8
e y 3 ~
) L
@ ~4 o
e 3
3
° °
q‘ T T T T ﬁw T T T T
1920 1925 1930 1935 1940 1920 1925 1930 1935 1940
year year
Investment Private Wages
0 8
°
3
- : f//\//\/
)
8
0
I o
T T T T T N\ T T T T
1920 1925 1930 1935 1940 1920 1925 1930 1935 1940

year year

Solid lines denote actual values.
Dashed lines denote forecast values.
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In addition, forecast is particularly easy to use because forecast also provides an intuitive,
interactive control panel to guide you and, if you do something wrong, forecast itself offers

advice on how to fix the problem.
See [TS] forecast.

6. Power and sample size.

The new power command performs power and sample-size analysis. Included are

Comparison
Comparison
Comparison
Comparison

Comparison
Comparison
Comparison
Comparison

Comparison
Comparison

of a mean to a reference value

of a proportion to a reference value
of a variance to a reference value
of a correlation to a reference value

of two independent means

of two independent proportions
of two independent variances
of two independent correlations

of two paired means
of two paired proportions

Results can be displayed in customizable tables and graphs.

Power (1-B)

Estimated power

ttest
Ho: L= o versus Ha:pl=po

T T T

10 20 30 40
Sample size (N)
—— 1,=.8, o=1 —— 1,=.8,0=15
—— =1, 0=1 —&— p;=1,0=15

Parameters: o = .05, {p = 0

An integrated GUI lets you select your analysis type, input assumptions, and obtain desired results.

Power and sample size is the subject of its own manual. See Stata Power and Sample-Size Reference

Manual; start by seeing [PSS] intro.
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7. New and extended panel-data estimators.
Two new random-effects panel-data estimation commands are added:

xtoprobit ordered probit regression
xtologit ordered logistic regression

These new commands allow for cluster—robust standard errors.

The following previously existing random-effects panel-data estimation commands now allow for
cluster-robust standard errors:

xtprobit probit regression

xtlogit logistic regression

xtcloglog complementary log-log regression
xtpoisson Poisson regression

See [XT] xt for a complete list of all of Stata’s panel-data estimators.

8. New commands are provided for calculating effect sizes after estimation in the way behavioral
scientists, and especially psychologists, want to see them. Cohen’s d, Hedges’s g, Glass’s A, n?,
and w?, with confidence intervals, are now provided:

a. New commands esize and esizei calculate effect sizes comparing the difference between
the means of a continuous variable for two groups. See [R] esize.

b. New postestimation command estat esize computes effect sizes for linear models after anova
and regress. See [R] regress postestimation.

9. Project Manager.
The new Project Manager lets you organize your analysis files—your do-files, ado-files, datasets,
raw files, etc. You can have multiple projects, and each can contain hundreds of files, or just a
few.

You can see all the files in a project at a glance, filter on filenames, and click to open, edit, or run.

Projects are portable, meaning that you can pick the whole collection up at once and move it
across computers or share it with colleagues.
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Take a look:

Project ‘3‘

Filter project here

[+ [ builder

(& [ cert

[ [y data
] bernoulli.dta
] bincmial_sem01_2.dta
] gamma.dta
[ logit2x.dta
[ mlogit.dta
[ mr.dta
[ mrgamma2.dta
[ mrmlegit.dta
[ mrpoisson.dta
[Inbinomial.dta
Jordinal.dta
] poisson.dta

H & gllamm
gbml_clug\ugl.du
2] bin2_cloglog2.log
2] bin2_logit2.do
2 bin2_logitZleg

Properties ks
=l ltem A
Name gsem
Type Project
Location
Relative Path
Full Path C\users\stata\Docu ¥

Try it. Get started from the Do-file Editor by selecting File > New > Project . ..
See [P] Project Manager.

10. Java plugins.
You can now call Java methods directly from Stata. You can take advantage of the plethora of
existing Java libraries or write your own Java code. You call Java using Stata’s new javacall
command. See [P] java and see the Java-Stata API specification at http://www.stata.com/java/api/.

Java recently encountered some negative publicity regarding security concerns. That publicity was
about Java and web browsers automatically loading and running Java code from untrusted websites.
It does not apply to Stata’s implementation of Java. Stata’s implementation is about running Java
code already installed on your computer from known and trusted sources.

1.3.2 What’s new that you will want to know

11. You can clear the Results window.
Use the new cls command. See [R] cls.

12. Value labels of factor variables used to label output.
You use variable i.sex, and output now shows male and female in your model rather than 0O
and 1 if variable sex has a value label. You can control how output looks. See more details below
in [U] 1.3.3 What’s new in statistics (general).
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13.

14.

15.

16.

17.

18.

20.

Programmers can create Word and Excel files from Stata.
You can add paragraphs, insert images, insert tables, poke into individual cells, and more.

See [M-5] _docx*() to create Word documents.
See [P] putexcel and [M-5] xI() to interact with Excel files.
By the way, Stata could already import and export Excel files; see [D] import excel.

Searching is better.
Here’s why:

a. Help > Search... and the search command now default to searching the Internet as well as
Stata’s local keyword database. If you do not want that, type set searchdefault local,
permanently to set Stata 13 to the old default.

b. search without options now displays its results in the Viewer rather than in the Results window.
(If any options are specified, however, results appear in the Results window.)

c. Existing command findit is no longer documented but continues to work. Changes to search
make search into the equivalent of findit.

See [R] search.

help now searches when no help is found.
help xyz now invokes search xyz if xyz is not found. See [R] help.

Stata now supports secure HTTP (HTTPS) and FTP. You can, for instance, use datasets from sites
using either of the protocols. See [U] 3.6 Updating and adding features from the web.

Concerning the Data Editor,
a. noncontiguous column selections are now allowed.

b. encode, decode, destring, and tostring have been added as operations that can be performed
on selected variables.

c. the Delete key can now be used to drop data.

See [GS] 6 Using the Data Editor (GSM, GSU, or GSW).
Concerning the Do-file Editor,

a. matching braces are highlighted.

b. an adjustable column guide has been added.

c. you can now zoom in and out.

d. you can convert between the different types of end-of-line characters used by Windows and by
Mac and Unix.

See [GS] 13 Using the Do-file Editor (GSM, GSU, or GSW).

. Concerning Stata’s GUI,

a. the Properties window now displays the sorted-by variables.
b. the Jump To menu in the Viewer now allows you to jump to the top of the page.
c. Stata for Windows now supports Windows high-contrast themes.

.dta file format has changed.
The file format has changed because of the new strL variables. Stata 13 can, of course, read
old-format datasets. If you need to create datasets in the previous format—used by Stata 11 and
Stata 12—use the saveold command. See [D] save. If you want to know the details of the new
.dta format, type help dta.
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21.

22.

23.

24.

25.

Official directory ado/updates no longer used.

Official ado-file updates are no longer stored in directory installation-directory/ado/updates/.
Updates are now applied to ado/base directly. Modern operating systems do not approve of
applications such as Stata having multiple files of the same name. The updates process remains
the same.

Videos.
Type help videos to list and link to the videos on Stata’s YouTube channel. We provide dozens
of tutorials on Stata’s features.

Fast PDF-manual navigation.
There are now links at the top of each manual entry to jump directly to section headings, and on
each page’s header, there is a link to take you to the beginning of the entry.

If you did not know already, clicking on the blue manual reference in the title of a help file jumps
to the PDF documentation.

Manuals have color graphs.
If you want to use the same color graph scheme we use in the manuals, type set scheme
s2gcolor. See [G-4] scheme s2.

Ten new vignettes.
Scientific history buffs will want to read about the following:

a. Florence Nightingale
b. Florence Nightingale David, a different person from Florence Nightingale
Charles William Dunnett

IS

Andrew Charles Harvey
William Lee Hays

Fred Nichols Kerlinger

Janet Elizabeth Lane-Claypon

5 0. - 0

martingale
Elizabeth L. “Betty” Scott

j- John Snow

—

The following two items were added during the Stata 12 release:

26.

27.

New command icc computes intraclass correlation coefficients for one-way random-effects models,
two-way random-effects models, and two-way mixed-effects models for both individual and average
measurements. Intraclass correlations measure consistency of agreement or absolute agreement.
See [R] icc.

New postestimation command estat icc computes intraclass correlations at each nesting level
for nested random-effects models fit by mixed and melogit. See [ME] mixed postestimation and
[ME] melogit postestimation.
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1.3.3 What’s new in statistics (general)

Already mentioned as highlights of the release were treatment effects, generalized SEMs, multilevel

mixed-effects models, power and sample size, and panel-data estimators. The following are also new:

28.

29.
30.

31

32.

33.

34.

35.

Concerning sample-selection estimation commands,

a. new estimation command heckoprobit fits the parameters of an ordered probit model with
sample selection. See [R] heckoprobit.

b. existing estimation command heckprob is renamed heckprobit. See [R] heckprobit.
Existing estimation command hetprob is renamed hetprobit. See [R] hetprobit.

New estimation command ivpoisson fits the parameters of a Poisson regression model with
endogenous regressors. Estimates can be obtained using the GMM or control-function estimators.
See [R] ivpoisson.

New command mlexp allows you to specify maximum likelihood models without writing an
evaluator program. You can instead specify an expression representing the log-likelihood function
in much the same way you would with nl, nlsur, or gmm. See [R] mlexp.

Concerning fractional polynomials,

a. new prefix command fp: replaces fracpoly for fitting models with fractional polynomial
regressors. You type

. fp ...: estimation command
Results are the same. The new fp command supports more estimation commands, it is easier to
use, and it is more flexible. You can substitute the same fractional polynomial into multiple places

of the estimation command, which is especially useful in multiple-equation models. You may now
use factor-variable notation in the estimation command.

b. fp generate replaces fracgen.
c. fp plot replaces fracplot.
d. fp predict replaces fracpred.

e. commands fracpoly and fracgen are no longer documented but continue to work. Commands
fracplot and fracpred are still documented for use after mfp.

See [R] fp.
Concerning quantile-regression estimation commands,
a. existing estimation command greg now accepts option vce (robust).

b. existing estimation commands qreg, iqreg, sqreg, and bsqreg now allow factor variables
to be used.

See [R] qreg.

Syntax and methodology for predict after boxcox have changed. Predicted values are now
calculated using Duan’s smearing method by default. The previous back-transformed predicted-
values estimates are provided if predict’s btransform option is specified and under version
control. See [R] boxcox postestimation.

Value labels of factor variables are now used by default to label estimation output. The numeric
values (levels) were previously used and continue to be used if the factor variables are unlabeled.
There are three new display options that may be used with estimation commands affecting how
this works:



18 [U] 1 Read this—it will help

36.

37.

38.

a. Option nofvlabel displays factor-variable level values, just as Stata 12 did previously. (You
can set fvlabel off to make nofvlabel the default.)

b. Option fvwrap(#) specifies the number of lines to allow when long value labels must be
wrapped. Labels requiring more than # lines are truncated. fvwrap(1) is the default. You can
change the default by using set fvwrap #.

c. Option fvwrapon() specifies whether value labels that wrap will break at word boundaries.
fvwrapon(word) is the default, meaning to break at word boundaries.

fvwrapon(width) specifies that line breaks may occur arbitrarily so as to maximize use of
available space.

You can change the defaults by using set fvwrapon width or set fvwrapon word.

Current default settings are shown by query and also stored in c(fvlabel), c(fvwrap), and
c(fvwrapon).

See [R] set showbaselevels and [P] creturn.

Existing estimation command proportion now uses the logit transform when computing the limits
of the confidence interval. The original behavior of using the normal approximation is preserved
under version control or when the new citype (normal) option is specified. See [R] proportion.

Concerning existing command margins,

a. option at() has new suboption generate(), which allows you to specify an expression to
replace the values for any continuous variable in the model. For example, you can compute the
predictive margins at x+1 by typing

. margins, at(x = generate(x+1))
at (generate()) can be combined with contrasts to estimate the effect of giving each subject
an additional amount of x,

. margins, at((asobserved) _all) at(x= generate(x+1)) contrast(at(r._at))

See Estimating treatment effects with margins in [R] margins, contrast.

b. margins automatically uses the ¢ distribution for computing p-values and confidence intervals
when appropriate, which is after linear regression and ANOVA and whenever degrees of freedom
are posted to e(df_r).

The previous default behavior of always using the standard normal distribution for all p-values
and confidence intervals is preserved under version control.

c. new option df (#) specifies that margins is to use the ¢ distribution when it otherwise would
not.
See [R] margins.

nlcom and predictnl now use the standard normal distribution for computing p-values and
confidence intervals. Original behavior was to compute the p-values and CIs based on the ¢
distribution in some cases. Original behavior is preserved under version control. In addition, if you
want p-values and confidence intervals calculated using the ¢ distribution, use new option df (#)
to specify the degrees of freedom.

testnl’s calculated test statistic is now 2 rather than F unless you specify the df () option.

See [R] nlcom, [R] predictnl, and [R] testnl.
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39.

40.

41.

42.

43.

contrast, pwcompare, and 1incom have new option df (#) to use the ¢ distribution in computing
p-values and confidence intervals. For contrast, this option also causes the Wald table to use
the F' distribution.

See [R] contrast, [R] pwcompare, and [R] lincom.

estimates table’s option label is renamed varlabel. Original option label is allowed under
version control. See [R] estimates table.

The previously existing sampsi command is no longer documented because it is replaced by the
new power command—a highlight of the release. See [PSS] power.

Existing functions normalden(x,u,0) and lnnormalden(z,u,o) now allow you to omit
argument p or arguments ¢ and 0. ;4 = 0 and 0 = 1 is assumed. See help normalden(), help
lnnormalden(), and [D] functions.

The following new functions are added:

t(df ,t) cumulative Student’s ¢ distribution

invt (df ,p) inverse cumulative Student’s ¢ distribution

ntden(df ,np,t) density of noncentral Student’s ¢ distribution

nt (df ,np,t) cumulative noncentral Student’s ¢ distribution

npnt (df ,t,p) noncentrality parameter of noncentral Student’s ¢ distribution
nttail (df ,np,t) right-tailed noncentral Student’s ¢ distribution
invnttail(df,np,p) inverse of right-tailed noncentral Student’s ¢ distribution

nF (dfy1,df2,np, f) cumulative noncentral F' distribution

npnF (dfy ,dfs, f,p) noncentrality parameter of noncentral F’ distribution
chi2den(df ,x) density of x? distribution

fileread(f) return the contents of a file as a string

filewrite(f ,s[ ,r}) create or overwrite file with the contents of a string
fileexists(f) check whether a file exists

filereaderror(s) use results returned by fileread() to determine whether an

1/O error occurred

See help functionname() and [D] functions.

1.3.4 What’s new in statistics (SEM)

We have already mentioned a highlight of the release, the new gsem command, for fitting generalized

SEMs. The following are also new:

44.

45.
46.
47.

Existing estimation command sem has new option noestimate, which is useful when you are
having convergence problems; you can use it to get the starting values into a Stata matrix (vector)
that you can then modify to use as alternative starting values. See [SEM] intro 12.

sem now supports time-series operators on all observed variables. See [SEM] sem.
You can now use postestimation command margins after sem. See [SEM] intro 7.

sem no longer reports in the estimation output any zero-valued constraints on covariances between
exogenous variables; absence of the covariance indicates the presence of the constraint. Original
behavior is preserved under version control.
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48.

49.

1.3.5

The new options for controlling display of factor variables with value labels mentioned in [U] 1.3.3
What’s new in statistics (general)—nofvlabel, fvwrap(#), and fvwrapon(word \ width)—
work with varname of sem, group(varname). sen itself does not allow factor variables, but the
factor-variable display options nonetheless work with group (varname).

Thus old options wrap() and nolabel are now officially fvwrap() and fvnolabel, although
the old option names continue to work as synonyms. See [SEM] sem reporting options.

We now show how to construct path diagrams at the end of each estimation example in the manual.
See [SEM] example 1, [SEM] example 3, . ...

What’s new in statistics (time series)

We have already mentioned a highlight of the release, the new forecast command. The following

are also new:

50.

51.

1.3.6

1.3.7
52.

53.

New command import haver (available with Stata for Windows only) replaces old command
haver. import haver imports economic and financial data from Haver Analytics databases. See
[D] import haver.

Existing command tsreport now provides better information about gaps in time-series and panel
datasets, including the length of each gap.

In addition, tsreport will provide information about missing values in variables even where there
are no gaps.

See [TS] tsreport.

Also see item 55 in [U] 1.3.8 What’s new in data management for information on the new
command bcal create.

What’s new in statistics (longitudinal/panel data)

We have already mentioned a highlight of the release, new and extended panel-data estimators.

What’s new in statistics (survival analysis)

Shared frailty survival models can no longer be fit when there is delayed entry or there are gaps in
time under observation. Said differently, stcox and streg no longer allow option shared () when
there are delayed entry or gaps. The use of shared frailty models to fit truncated survival data leads to
inconsistent results unless the frailty distribution is independent of the covariates and the truncation
point, which rarely happens in practice. If you have such data and can make the independence
assumption—which is unlikely—estimation can be forced by specifying undocumented option
forceshared. See [ST] stcox and [ST] streg. See help st_forceshared for information on the
forceshared option.

Output produced by existing commands stset, streset, and cttost more accurately labels
time at risk. What was labeled “total time at risk” is now labeled “total time at risk and under
observation”. See [ST] stset and [ST] cttost.
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1.3.8 What’s new in data management

54.

55.

56.

We have already mentioned a highlight of the release, long strings/BLOBs.

New commands import delimited and export delimited supersede old commands insheet
and outsheet. This is not just a renaming.

import delimited supports several different quoting methods. Some packages, for instance, use
"" in the middle of a string to represent an embedded double quote. Others do not.

import delimited now allows column and row ranges (subsets).

Use import delimited’s GUI to see a preview of the data and how they will be read. You can
also customize the GUI.

= Import delimited text data = =

File ko import:

CiiUsersistatalDocumentsiauko, csv

Delimiter:

Aukomatic v [] Treat sequential delimiters as one
Use first row For variable names: ‘ariable case:

Autamatic W Lower LY

Quote binding: Quoke stripping:

Loose W Automatic w

Floating point precision:

Use default W Set range...
Preview:
# make ptice mpg rep?s headroari trunk. e
2 AMC Concord 4099 22 3 2.5 11 A
3 AMC Pacer 4749 17 3 3 11
4 AMC Spirit 3799 22 3 12
5 Buick Century 45816 20 3 4.5 16
6 Buick Electra 727 15 4 4 20
7 Buick LeSabre 5788 18 3 4 21
g Buick Opel 4453 6 3 10
el Buick Regal 5189 20 3 2 16
10 Euick. Riviera 10372 16 3 3.5 17
11 Biuick. Skeylark. 4052 19 3 3.5 13
12 Cad. Devile 11335 14 3 4 20
13 Cad. Eldarada 14500 14 2 3.5 16
14 ~ad Cauilla 1Eane 1 k] k] 12 R
>
Ok Cancel

Of course, import delimited and export delimited support Stata 13’s new strLs.
See [D] import delimited.

existing command bcal has new subcommand create to create a business calendar from the
current dataset automatically. bcal create infers business holidays and closures from gaps in the
data. See [D] bcal.

String expressions now support string duplication via multiplication. For example, 3*"abc" eval-
uates to "abcabcabc". See help strdup() or [D] functions.
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57.

1.3.9

58.

59.

60.

Concerning long strings, that is, strLs,

a. existing command compress has new option nocoalesce in support of the new strL string
storage type. By default, compress coalesces the storage used to store duplicated strL values.
nocoalesce prevents this.

In addition, compress always considers demoting strL variables to str# variables if that
would save memory.

See [D] compress.

b. the output of existing command memory has changed to include information on new string
storage type strL. See [D] memory.

c. the options of existing command ds, such as has() and not(), now understand string to
mean both strL and str#, strL to mean strL, and str# to mean stril, str2, ..., str2045.
See [D] ds.

d. existing command type has new option lines(#) to list the first # lines of the file. See
[D] type.

Also see item 50 in [U] 1.3.5 What’s new in statistics (time series) for information on the new
command import haver.

What’s new in Mata
Programmers can create Word and Excel files from Stata.
You can add paragraphs, insert images, insert tables, poke into individual cells, and more.
See [M-5] _docx™() to create Word documents.
See [P] putexcel and [M-5] xI() to interact with Excel files.
By the way, Stata could already import and export Excel files; see [D] import excel.

New functions in solvenl () allow you to solve arbitrary systems of nonlinear equations. Gauss—
Seidel, damped Gauss—Seidel, Broyden—Powell, and Newton—Raphson techniques are provided.
See [M-5] solvenl().

The same statistical functions added to Stata have been added to Mata, namely,

Noncentral Student’s t
p = ntldf, np, 1)
d = ntden(df, np, t)
g = nttaild(df, np, t)
t = invnttail (df, np, q)
np = npnt (df, t, p)

Student’s t
p =tdf, D
t = invt (df, p)

Noncentral F
p = nF(df1, dfa, np, f)
np = npnF (dfy, dfz, f, p)

d = chi2den(df, x)

See [M-5] normal().
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61.

New function selectindex() returns a vector of indices for which v[j] # 0. For instance,
if v =(6,0,7,0,8), then selectindex(v) = (1,3,5). selectindex() is useful with logical
expressions, such as x[selectindex(x:>1000)]. See [M-5] select().

1.3.10 What’s new in programming

We have already mentioned the Project Manager and Java plugins as highlights of the release. The

following are also new:

62.

63.
64.

New command putexcel writes Stata expressions, matrices, and stored results to an Excel file.
Excel 1997/2003 (.x1s) files and Excel 2007/2010 (.x1sx) files are supported. See [P] putexcel.

Mata programmers will also be interested in [M-5] xI(), a class to interact with Excel files.

A new set of Mata functions provide the ability to create Word documents. See [M-5] _docx*().
Concerning strLs,

a. strL is now a reserved word.

b. the maximum length of a string in string expressions increases from 244 to 2-billion characters.
See [R] limits.

c. new c(maxstrlvarlen) returns the maximum possible length for strL variables.

d. confirm ... variable now understands str# to mean any strl, str2, ..., str2045
variable; strL to mean strL; and string to mean str# or strL. See [P] confirm.

e. new function fileread (filename [ , startpos [ s length] ]) returns the contents of filename.
See help fileread() and [D] functions.

f. new function filewrite (filename, s [ , 11 2}) writes s to the specified filename, optionally
overwriting 1 or appending 2. See help filewrite() and [D] functions.

g. new function fileexists (filename) returns 1 if the specified filename exists, and returns O
otherwise.

h. new function filereaderror(s) returns O or a positive integer, said value having the inter-
pretation of a return code. It is used like this
. generate strL s = fileread(filename) if fileexists (filename)

. assert filereaderror(s)==0
or this

. generate strL s = fileread(filename) if fileexists (filename)

. generate rc = filereaderror(s)
That is, filereaderror(s) is used on the result returned by fileread (filename) to determine
whether an 1/0 error occurred.

In the example, we only fileread() files that fileexist (). That is not required. If the file
does not exist, that will be detected by filereaderror() as an error. The way we showed
the example, we did not want to read missing files as errors. If we wanted to treat missing files
as errors, we would have coded

. generate strL s = fileread(filename)

. assert filereaderror(s)==0
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65.

66.

67.

68.
69.

1.3.11

or

. generate strL s = fileread(filename)

. generate rc = filereaderror(s)

New command expr_query exp returns in r() the variables used in expression exp. See help
undocumented and see help expr_query.

The maximum number of elements in a numlist increases from 1,600 to 2,500. See [U] 11.1.8 num-
list.

Existing command ereturn post now allows posting of noninteger as well as integer dof ()
values.

New c(hostname) returns the computer’s hostname. See [P] creturn.

New c(maxvlabellen) returns the maximum possible length for a value label.

What’s new, Mac only

In addition to all the above What’s New items, which apply to all platforms, Stata for Mac has

several of its own new features:

70.

71.
72.

73.

74.
75.

76.

The Do-file Editor in Stata for Mac has been completely rewritten. It now includes

e code folding

e more robust syntax highlighting that is consistent with highlighting in Windows and Unix
e more color options for customizing its appearance

e the ability to save the syntax-highlighting colors as separate themes

e line ending preservation and normalization, which is useful for working in a mixed platform
environment where do-files are exchanged between Windows and Macs

e text-size zooming without having to change the font or font size

e more drag-and-drop options

e more control over the appearance of printed files

The Command window now has the same syntax highlighting as the Do-file Editor.

There is a new path control that not only shows the current working directory but also can change
the current working directory and open Stata files without having to use the Open dialog.

Mac OS X 10.7 GUI enhancements such as full-screen support and textured backgrounds for
spring-back scrolling are now supported.

There is a new interface for saving and managing saved preferences.

Applescript is better supported and enables users to directly access Stata macros, scalars, stored
results, and datasets.

Stata for Mac is now 64-bit only and allows the application’s file size to be roughly 67% smaller.
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1.3.12 What’s more

We have not listed all the changes, but we have listed the important ones.

Stata is continually being updated. Those between-release updates are available for free over the
Internet.

Type update query and follow the instructions.

We hope that you enjoy Stata 13.
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A brief description of Stata

Stata is a statistical package for managing, analyzing, and graphing data.

Stata is available for a variety of platforms. Stata may be used either as a point-and-click application
or as a command-driven package.

Stata’s GUI provides an easy interface for those new to Stata and for experienced Stata users who
wish to execute a command that they seldom use.

The command language provides a fast way to communicate with Stata and to communicate more
complex ideas.

Here is an extract of a Stata session using the GUI:

(Throughout the Stata manuals, we will refer to various datasets. These datasets are all available from
http://www.stata-press.com/data/r13/. For easy access to them within Stata, type webuse dataset_name,
or select File > Example Datasets... and click on Stata 13 manual datasets.)

. webuse lbw
(Hosmer & Lemeshow data)

We select Data > Describe data > Summary statistics and choose to summarize variables low,
age, and smoke, whose names we obtained from the Variables window. We click on OK.

= summarize - Summary statistics  —
Main | bydifdin | Weights

anables: [leave empty for all vanables)

lowe age zmaoke W
Ewamples: wre all vanables starting with "y’
wyz-abo all variables between sz and abc
Options

(®) Standard display

() Dizplay additional statistics

() Mo display; just caleulate mean
[JUse variable's display format

55| Separatar ine every M variables [set O for none)

Factor-wvariable dizplay options

o0 Cancel Subrnit

27
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. summarize low age smoke

Variable Obs Mean Std. Dev. Min Max
low 189 .3121693 .4646093 0 1

age 189 23.2381 5.298678 14 45
smoke 189 .3915344 .4893898 0 1

Stata shows us the command that we could have typed in command mode—summarize low age
smoke—before displaying the results of our request.

Next we fit a logistic regression model of low on age and smoke. We select Statistics > Binary
outcomes > Logistic regression (reporting odds ratios), fill in the fields, and click on OK.

&= logistic - Logistic regression, reporting odds ratios -
Model | byiffin | Weights | SE/Pobust | Feporting | Masimization

Dependent varniable: |Independent variables:

o W [aen age smoke )

|:| Suppress constant kerm

Options

Offzet variable:

b

[ Retain perfact predictor varishles

Constraints:
W Manage...
[ Keep colinear variables [rarsly used)
e @ Cancel Submit

. logistic low age smoke
Logistic regression Number of obs = 189
LR chi2(2) = 7.40
Prob > chi2 = 0.0248
Log likelihood = -113.63815 Pseudo R2 = 0.0315
low | Odds Ratio  Std. Err. z P>zl [95% Conf. Intervall]
age .9514394 .0304194 -1.56 0.119 .8936482 1.012968
smoke 1.997405 .642777 2.15 0.032 1.063027 3.753081
_cons 1.062798 .8048781 0.08 0.936 .2408901 4.689025

Here is an extract of a Stata session using the command language:
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. use http://www.stata-press.com/data/r13/auto
(1978 Automobile Data)

. summarize mpg weight

Variable | Obs Mean Std. Dev. Min Max
mpg 74 21.2973 5.785503 12 41
weight 74 3019.459 777.1936 1760 4840

The user typed summarize mpg weight and Stata responded with a table of summary statistics.
Other commands would produce different results:

. generate gplOOm =

100/mpg

. label var gpl00m "Gallons per 100 miles"
. format gp100m %5.2f

G

correlate gplOOm weight

bs=74)
gplOOm  weight
gp100m 1.0000
weight 0.8544 1.0000
. regress gplOOm weight gear_ratio
Source Ss df MS Number of obs = 74
F( 2, 71) = 96.65
Model 87.4543721 2 43.7271861 Prob > F = 0.0000
Residual 32.1218886 71 .452420967 R-squared = 0.7314
Adj R-squared = 0.7238
Total 119.576261 73 1.63803097 Root MSE = .67262
gp100m Coef.  Std. Err. t P>t [95% Conf. Intervall
weight .0014769 .0001556 9.49 0.000 .0011665 .0017872
gear_ratio .1566091 .2651131 0.59 0.557 -.3720115 .6852297
_cons .0878243 1.198434 0.07 0.942 -2.301786 2.477435
. scatter gplOOm weight, by(foreign)
Domestic Foreign
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Graphs by Car type

The user-interface model is type a little, get a little, etc., so that the user is always in control.
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Stata’s model for a dataset is that of a table—the rows are the observations and the columns are
the variables:

. list mpg weight gp1OOm in 1/10

mpg  weight gp100m
1. 22 2,930 4.55
2. 17 3,350 5.88
3. 22 2,640 4.55
4. 20 3,250 5.00
5. 15 4,080 6.67
6. 18 3,670 5.56
7. 26 2,230 3.85
8. 20 3,280 5.00
9. 16 3,880 6.25
10. 19 3,400 5.26

Observations are numbered; variables are named.

Stata is fast. That speed is due partly to careful programming, and partly because Stata keeps the
data in memory. Stata’s file model is that of a word processor: a dataset may exist on disk, but the
dataset in memory is a copy. Datasets are loaded into memory, where they are worked on, analyzed,
changed, and then perhaps stored back on disk.

Working on a copy of the data in memory makes Stata safe for interactive use. The only way to
harm the permanent copy of your data on disk is if you explicitly save over it.

Having the data in memory means that the dataset size is limited by the amount of computer
memory. Stata stores the data in memory in an efficient format—you will be surprised how much
data can fit. Nevertheless, if you work with extremely large datasets, you may run into memory
constraints. You will want to learn how to store your data as efficiently as possible; see [D] compress.

Video example

Tour of the Stata 13 interface


http://www.stata.com/videos13/stata-interface/
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3.1 Overview

The Getting Started manual, User’s Guide, and Reference manuals are the primary tools for learning
about Stata; however, there are many other sources of information. A few are listed below.

Stata itself. Stata has a search command that makes it easy search a topic to find and to
execute a Stata command. See [U] 4 Stata’s help and search facilities.

The Stata website. Visit http://www.stata.com. Much of the site is dedicated to user support;
see [U] 3.2.1 The Stata website (www.stata.com).

The Stata YouTube Channel. Visit http://www.youtube.com/user/statacorp. The site is regularly
updated with video demonstrations of Stata.

The Stata Blog, Twitter, and Facebook. Visit http://blog.stata.com/, http://twitter.com/stata, and
http://facebook.com/statacorp. See [U] 3.2.3 The Stata Blog—Not Elsewhere Classified and
[U] 3.2.4 Stata on Twitter and Facebook.

The Stata Press website. Visit http://www.stata-press.com. This site contains the datasets used
throughout the Stata manuals; see [U] 3.3 Stata Press.
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The Stata listserver. An active group of Stata users communicate over an Internet listserver,
which you can join for free; see [U] 3.4 The Stata listserver.

The Stata Journal and the Stata Technical Bulletin. The Stata Journal contains reviewed papers,
regular columns, book reviews, and other material of interest to researchers applying statistics
in a variety of disciplines. The Stata Technical Bulletin, the predecessor to the Stata Journal,
contains articles and user-written commands. See [U] 3.5 The Stata Journal.

The Stata software distribution site and other user-provided software distribution sites. Stata
itself can download and install updates and additions. We provide official updates to Stata—type
update query or select Help > Check for Updates. We also provide user-written additions to
Stata and links to other user-provided sites—type net or select Help > SJ and User-written
Programs; see [U] 3.6 Updating and adding features from the web.

NetCourses. We offer training via the Internet. Details are in [U] 3.7.2 NetCourses.

Public training courses. We offer in-depth training courses at third-party sites around the United
States. Details are in [U] 3.7.3 Public training courses.

On-site training courses. We can come to your institution to provide customized training. Details
are in [U] 3.7.4 On-site training courses.

Books and support materials. Supplementary Stata materials are available; see [U] 3.8 Books
and other support materials.

Technical support. We provide technical support by email, telephone, and fax; see [U] 3.9 Tech-
nical support.

3.2 Stata on the Internet (www.stata.com and other resources)

3.2.1 The Stata website (www.stata.com)

Point your browser to http://www.stata.com and click on Support. More than half our website is
dedicated to providing support to users.

The website provides answers to FAQs (frequently asked questions) on Windows, Mac, Unix,
statistics, programming, Internet capabilities, graphics, and data management. These FAQs run
the gamut from “I cannot save/open files” to “What does ‘completely determined’ mean in my
logistic regression output?” Most users will find something of interest.

Visiting the website is one way that you can subscribe to the Stata listserver; see [U] 3.4 The
Stata listserver.

The website provides detailed information about NetCourses, along with the current schedule;
see [U] 3.7.2 NetCourses.

The website provides information about Stata courses and meetings, both in the United States
and elsewhere. See [U] 3.7.1 Conferences and users group meetings, [U] 3.7.3 Public training
courses, and [U] 3.7.4 On-site training courses.

The website provides an online bookstore for Stata-related books and other supplementary
materials; see [U] 3.8 Books and other support materials.

The website provides links to information about statistics: other statistical software providers,
book publishers, statistical journals, statistical organizations, and statistical listservers.


http://www.stata.com
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e The website provides links to resources for learning Stata at
http://www.stata.com/links/resources.html. Be sure to look at these materials, as many outstand-
ing resources about Stata are listed here.

In short, the website provides up-to-date information on all support materials and, where possible,
provides the materials themselves. Visit http://www.stata.com if you can.

3.2.2 The Stata YouTube Channel

Visit Stata’s YouTube Channel at http://www.youtube.com/user/statacorp to view video demonstra-
tions on a wide variety of topics ranging from basic data management and graphics to more advanced
statistical analyses, such as ANOVA, regression, and SEM. New demonstrations are regularly added.

3.2.3 The Stata Blog—Not Elsewhere Classified

Stata’s official blog can be found at http://blog.stata.com/ and contains news and advice related
to the use of Stata. The articles appearing in the blog are individually signed and are written by the
same people who develop, support, and sell Stata.

The Stata Blog also has links to other blogs about Stata, written by Stata users around the world.

3.2.4 Stata on Twitter and Facebook

StataCorp has an official presence on Twitter and Facebook. You can follow us on Twitter at
http://twitter.com/stata and find us on Facebook at http://facebook.com/statacorp. These are both good
ways to stay up-to-the-minute with the latest Stata information.

3.2.5 Other Internet resources on Stata

Many other people have published information on the Internet about Stata such as tutorials, examples,
and datasets. Visit http://www.stata.com/links/ to explore other Stata and statistics resources on the
Internet.

3.3 Stata Press

Stata Press is the publishing arm of StataCorp LP and publishes books, manuals, and journals
about Stata statistical software and about general statistics topics for professional researchers of all
disciplines.

Point your browser to http://www.stata-press.com. This site is devoted to the publications and
activities of Stata Press.

e Datasets that are used in the Stata Reference manuals and other books published by Stata
Press may be downloaded. Visit http://www.stata-press.com/data/. These datasets can be used
in Stata by simply typing use http://www.stata-press.com/data/r13/dataset_name; for
example, type use http://www.stata-press.com/data/r13/auto. You could also type
webuse auto; see [D] webuse.

e An online catalog of all our books and multimedia products is at
http://www.stata-press.com/catalog.html. We have tried to include enough information, such as
table of contents and preface material, so that you may tell whether the book is appropriate for
you.

e Information about forthcoming publications is posted at
http://www.stata-press.com/forthcoming.html.
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3.4 The Stata listserver

The Stata listserver (Statalist) is an independently operated, real-time list of Stata users on the
Internet. Anyone may join. Instructions for doing so can be found at http://www.stata.com/statalist/.

Many knowledgeable users are active on the list, as are the StataCorp technical staff. We recommend
that new users subscribe, observe the exchanges, and, if it turns out not to be useful, unsubscribe.

A searchable archive of Statalist postings from 2002 through the present can be found at
http://www.stata.com/statalist/archive/.

3.5 The Stata Journal

The Stata Journal (SJ) is a printed and electronic journal, published quarterly, containing articles
about statistics, data analysis, teaching methods, and effective use of Stata’s language. The Journal
publishes reviewed papers together with shorter notes and comments, regular columns, tips, book
reviews, and other material of interest to researchers applying statistics in a variety of disciplines.
The Journal is a publication for all Stata users, both novice and experienced, with different levels of
expertise in statistics, research design, data management, graphics, reporting of results, and in Stata,
in particular.

Tables of contents for past issues and abstracts of the articles are available at http://www.stata-
journal.com/archives.html. PDF copies of articles published at least three years ago are available for
free from the Stata Journal website.

We recommend that all users subscribe to the SJ. Visit http://www.stata-journal.com to learn more
about the Stata Journal and to order your subscription.

To obtain any programs associated with articles in the SJ, type
. net from http://www.stata-journal.com/software

or

e Select Help > SJ and User-written Programs
e Click on Stata Journal

The Stata Technical Bulletin

For 10 years, 1991-2001, the Stata Technical Bulletin (STB) served as the means of distributing
new commands and Stata upgrades, both user-written and “official”. After 10 years of continual
publication, the STB evolved into the Stata Journal. The Internet provided an alternative delivery
mechanism for user-written programs, so the emphasis shifted from user-written programs to more
expository articles. Although the STB is no longer published, many of the programs and articles that
appeared in it are still valuable today. PDF copies of all issues of the STB are available for free at
http://www.stata.com/bookstore/stbj.html. To obtain the programs that were published in the STB, type

. net from http://www.stata.com
. net cd stb

3.6 Updating and adding features from the web

Stata itself can open files on the Internet. Stata understands http, https, and ftp protocols.
First, try this:

. use http://www.stata.com/manual/oddeven, clear
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That will load an uninteresting dataset into your computer from our website. If you have a home
page, you can use this feature to share datasets with coworkers. Save a dataset on your home page,
and researchers worldwide can use it. See [R] net.

3.6.1 Official updates

Although we follow no formal schedule for the release of updates, we typically provide updates
to Stata approximately once a month. Installing the updates is easy. Type

. update query

or select Help > Check for Updates. Do not be concerned; nothing will be installed unless and until
you say so. Once you have installed the update, you can type

. help whatsnew

or select Help > What’s New? to find out what has changed. We distribute official updates to fix
bugs and to add new features.

3.6.2 Unofficial updates

There are also “unofficial” updates—additions to Stata written by Stata users, which includes
members of the StataCorp technical staff. Stata is programmable, and even if you never write a Stata
program, you may find these additions useful, some of them spectacularly so. Start by typing

. net from http://www.stata.com

or select Help > SJ and User-written Programs.

Be sure to visit the Statistical Software Components (SSC) archive, which hosts a large collection
of free additions to Stata. The ssc command makes it easy for you to find, install, and uninstall
packages from the SSC archive. Type

. ssc whatsnew

to find out what’s new at the site. If you find something that interests you, type

. ssc describe pkgname

for more information. If you have already installed a package, you can check for and optionally install
updates by typing

. adoupdate pkgname

To check for and optionally install updates to all the packages you have previously installed, type

. adoupdate all

Periodically, you can type
. news
or select Help > News to display a short message from our website telling you what is newly available.

See [U] 28 Using the Internet to keep up to date.
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3.7 Conferences and training

3.7.1 Conferences and users group meetings

StataCorp organizes the annual Stata Conference in the United States. Other conferences and users
group meetings are held in several countries around the world each year.

These meetings provide in-depth presentations from experienced Stata users and experts from
StataCorp. They also provide you with the opportunity to interact directly with the people who
develop Stata and to share your thoughts and ideas with them.

Visit http://www.stata.com/meeting/ for a list of upcoming conferences and meetings.

3.7.2 NetCourses

We offer courses on Stata at both introductory and advanced levels. Courses on software are
typically expensive and time consuming. They are expensive because, in addition to the direct costs
of the course, participants must travel to the course site. Courses over the Internet save everyone time
and money.

TM

We offer courses over the Internet and call them Stata NetCourses™ .

What is a NetCourse?
A NetCourse is a course offered through the Stata website that varies in length from 7 to 8
weeks. Everyone with an email address and a web browser can participate.

How does it work?

Every Friday a lecture is posted on a password-protected website. After reading the lecture
over the weekend or perhaps on Monday, participants then post questions and comments on a
message board. Course leaders typically respond to the questions and comments on the same
day they are posted. Other participants are encouraged to amplify or otherwise respond to the
questions or comments as well. The next lecture is then posted on Friday, and the process
repeats.

How much of my time does it take?
It depends on the course, but the introductory courses are designed to take roughly 3 hours per
week.

There are three of us here—can just one of us enroll and then redistribute the NetCourse
materials ourselves?

We ask that you not. NetCourses are priced to cover the substantial time input of the course
leaders. Moreover, enrollment is typically limited to prevent the discussion from becoming
unmanageable. The value of a NetCourse, just like a real course, is the interaction of the
participants, both with each other and with the course leaders.

I’ve never taken a course by Internet before. I can see that it might work, but then again,
it might not. How do I know I will benefit?

All Stata NetCourses come with a 30-day satisfaction guarantee. The 30 days begins after the
conclusion of the final lecture.

You can learn more about the current NetCourse offerings by visiting http://www.stata.com/netcourse.

NetCourseNow

A NetCourseNow offers the same material as NetCourses but it allows you to choose the time
and pace of the course, and you have a personal NetCourse instructor.


http://www.stata.com/meeting/
http://www.stata.com/netcourse
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e What is a NetCourseNow?
A NetCourseNow offers the same material as a NetCourse, but allows you to move at your own
pace and to specify a starting date. With a NetCourseNow, you also have the added benefit of
a personal NetCourse instructor whom you can email directly with questions about lectures and
exercises. You must have an email address and a web browser to participate.

o How does it work?
All course lectures and exercises are posted at once, and you are free to study at your own
pace. You will be provided with the email address of your personal NetCourse instructor to
contact when you have questions.

o How much of my time does it take?
A NetCourseNow allows you to set your own pace. How long the course takes and how much
time you spend per week is up to you.

3.7.3 Public training courses

Public training courses are intensive, in-depth courses taught by StataCorp at third-party sites
around the United States.

e How is a public training course taught?
These are interactive, hands-on sessions. Participants work along with the instructor so that
they can see firsthand how to use Stata. Questions are encouraged.

e Do I need my own computer?
Because the sessions are in computer labs running the latest version of Stata, there is no need
to bring your own computer. Of course, you may bring your own computer if you have a
registered copy of Stata you can use.

e Do I get any notes?
You get a complete set of notes for each class, which includes not only the materials from the
lessons but also all the output from the example commands.

See http://www.stata.com/training/public.html for all course offerings.

3.7.4 On-site training courses

On-site training courses are courses that are tailored to the needs of an institution. StataCorp
personnel can come to your site to teach what you need, whether it be to teach new users or to show
how to use a specialized tool in Stata.

e How is an on-site training course taught?
These are interactive, hands-on sessions, just like our public-training courses. You will need a
computer for each participant.

o What topics are available?
We offer training in anything and everything related to Stata. You work with us to put together
a curriculum that matches your needs.

o How does licensing work?
We will supply you with the licenses you need for the training session, whether the training
is in a lab or for individuals working on laptops. We will ship the licensing and installation
instructions so that you can have everything up and running before the session starts.

See http://www.stata.com/training/onsite.html for all the details.
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3.8 Books and other support materials

3.8.1 For readers

There are books published about Stata, both by us and by others. Visit the Stata bookstore at
http://www.stata.com/bookstore/. For the books that we carry, we include the table of contents and
comments written by a member of our technical staff, explaining why we think this book might
interest you.

3.8.2 For authors

If you have written a book related to Stata and would like us to consider carrying it in our
bookstore, email bookstore @stata.com.

If you are writing a book, join our free Author Support Program. Stata professionals are available
to review your Stata code to ensure that it is efficient and reflects modern usage, production specialists
are available to help format Stata output, and editors and statisticians are available to ensure the
accuracy of Stata-related content. Visit http://www.stata.com/authorsupport/.

If you are thinking about writing a Stata-related book, consider publishing it with Stata Press.
Email submissions @statapress.com.

3.9 Technical support

We are committed to providing superior technical support for Stata software. To assist you as
efficiently as possible, please follow the procedures listed below.

3.9.1 Register your software

You must register your software to be eligible for technical support, updates, special offers, and
other benefits. By registering, you will receive the Stata News, and you may access our support staff
for free with any question that you encounter. You may register your software either electronically
or by mail.

Electronic registration: After installing Stata and successfully entering your License and Activation
Key, your default web browser will open to the online registration form at the Stata website. You
may also manually point your web browser to http://www.stata.com/register/ if you wish to register
your copy of Stata at a later time.

Mail-in registration: Fill in the registration card that came with Stata and mail it to StataCorp.

3.9.2 Before contacting technical support

Before you spend the time gathering the information our technical support department needs, make
sure that the answer does not already exist in the help files. You can use the help and search
commands to find all the entries in Stata that address a given subject. Be sure to try selecting
Help > Contents. Check the manual for a particular command. There are often examples that address
questions and concerns. Another good source of information is our website. You should keep a
bookmark to our frequently asked questions page (http://www.stata.com/support/faqs/) and check it
occasionally for new information.

If you do need to contact technical support, visit http://www.stata.com/support/tech-support/ for
more information.
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3.9.3 Technical support by email

This is the preferred method of asking a technical support question. It has the following advantages:

e You will receive a prompt response from us saying that we have received your question and
that it has been forwarded to Technical Services to answer.

e We can route your question to a specialist for your particular question.

e Questions submitted via email may be answered after normal business hours, or even on
weekends or holidays. Although we cannot promise that this will happen, it may, and your
email inquiry is bound to receive a faster response than leaving a message on Stata’s voicemail.

e If you are receiving an error message or an unexpected result, it is easy to include a log file
that demonstrates the problem.

Please see visit http://www.stata.com/support/tech-support/ for information about contacting tech-
nical support.

3.9.4 Technical support by phone or fax

Our installation support telephone number is 979-696-4600. Please have your serial number handy.
It is also best if you are at your computer when you call. Telephone support is reserved for installation
questions. If your question does not involve installation, the question should be submitted via email
or fax.

Send fax requests to 979-696-4601. If possible, collect the relevant information in a log file and
include the file in your fax.

Please see visit http://www.stata.com/support/tech-support/ for information about contacting tech-
nical support.

3.9.5 Comments and suggestions for our technical staff

By all means, send in your comments and suggestions. Your input is what determines the changes
that occur in Stata between releases, so if we do not hear from you, we may not include your most
desired new feature! Email is preferred, as this provides us with a permanent copy of your request.
When requesting new features, please include any references that you would like us to review should
we develop those new features. Email your suggestions to service @stata.com.
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4.1 Introduction

To access Stata’s help, you will either
1. select Help from the menus, or

2. use the help and search commands.
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Regardless of the method you use, results will be shown in the Viewer or Results windows. Blue
text indicates a hypertext link, so you can click to go to related entries.

4.2 Getting started

The first time you use help, try one of the following:

1. select Help > Advice from the menu bar, or

2. type help advice.

Either step will open the help_advice help file within a Viewer window; it will be similar to the

following:

M
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b | Viewer - help help_advice = =

File Edit History Help

@ = ~f+ help help_advice 2
help help_advice X - X
r Also See -
~
Advice on finding help
Let's say you are trying to find out how to do something. With owver 2,000
help files and 11,000 pages of PDF docwuwmentation, we hawve probably
explained how to do whatewver you want. The documentation is filled with
worked examples that you can run onh supplied datasets. Whatever your
gquestion, try the following firstc:
1. Select Help from the Stata wenn and click on Search....
Z. Type sowme keywords sbout the topic that interests you, say, "logistic
regression™.
3. Look through the resulting list of awvailable resources, inecluding help
file=s, FAQ=s, Stata Journsl articles, and other resources.
4, Select the resource whose description looks most helpful. Usually, this
description will he & help file and will include " ({help <xyz*)"™, or, as
in our example, perhaps "(help logistic)™. Click on the blue link
flogistic™.
W
Ready CAP || MUM (| OWR

The advice file provides you with steps to search Stata to find information on topics and commands
that interest you. The steps show an example of finding all there is to know about “logistic regression”
within Stata.

4.3 help: Stata’s help system

When you

1. Select Help > Stata Command...
Type a command name in the Command edit field
Click on OK, or

2. Type help followed by a command name

you access Stata’s help files. These files provide shortened versions of what is in the printed manuals.
Let’s access the help file for Stata’s ttest command. Do one of the following:

1. Select Help > Stata Command...
Type ttest in the Command edit field
Click on OK, or

2. Type help ttest
Regardless of which you do, the result will be
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= Viewer - help ttest = &
File Edit History Help
@' = —f+ help ttest a
help ttest X v X
s Dialog=| &lso See~ | Jump To~
~
Title
[R] ttest — t tests (mean-comparison tests)
Syntax

One-sample t© test

ttest varname == # [if] [in] [, level(#)]

Two-sample £t test using groups

ttest varpame [iF] [in] , b¥{groupvar) [optionsi]

Two-sample £t test using variables

ttest rarpamel == varnameZ [if] [in], unpaired [unequal welch lewvel{)]

Paired t test

ttest varpamel == varnamef [if] [in] [, level{#)]

Ready CAP ||NUM || OWR

The trick is in already knowing that Stata’s command for testing equality of means is ttest and
not, say, meanstest. The solution to that problem is searching.

4.4 Accessing PDF manuals from help entries

Every help file in Stata links to the equivalent manual entry. If you are reading help ttest,
simply click on [R] ttest in the Title section of the help file to go directly to the [R] ttest manual
entry.

We provide recommended settings for your PDF viewer to optimize it for Stata’s documentation at
http://www.stata.com/support/fags/res/documentation.html.

4.5 Searching
If you do not know the name of the Stata command you are looking for, you can search for it by
keyword,

1. Select Help > Search...
Type keywords in the edit field
Click on OK

2. Type search followed by the keywords


http://www.stata.com/support/faqs/res/documentation.html

44 [U] 4 Stata’s help and search facilities

search matches the keywords you specify to a database and returns matches found in Stata
commands, FAQs at www.stata.com, official blogs, and articles that have appeared in the Stata Journal.
It can also find user-written additions to Stata available over the web.

search does a better job when what you want is based on terms commonly used or when what
you are looking for might not already be installed on your computer.

4.6 More on search

However you access search—command or menu—it does the same thing. You tell search what
you want information about, and it searches for relevant entries. By default, search looks for the
topic across all sources, including the system help, the FAQs at the Stata website, the Stata Journal,
and all Stata-related Internet sources including user-written additions.

search can be used broadly or narrowly. For instance, if you want to perform the
Kolmogorov—Smirnov test for equality of distributions, you could type

. search Kolmogorov-Smirnov test of equality of distributions

[R] ksmirnov . . . . . . Kolmogorov-Smirnov equality of distributions test
(help ksmirnov)

In fact, we did not have to be nearly so complete—typing search Kolmogorov-Smirnov
would have been adequate. Had we specified our request more broadly—looking up equality
of distributions—we would have obtained a longer list that included ksmirnov.

Here are guidelines for using search.
e Capitalization does not matter. Look up Kolmogorov-Smirnov or kolmogorov-smirnov.
e Punctuation does not matter. Look up kolmogorov smirnov.
e Order of words does not matter. Look up smirnov kolmogorov.

e You may abbreviate, but how much depends. Break at syllables. Look up kol smir. search
tends to tolerate a lot of abbreviation; it is better to abbreviate than to misspell.

e The words a, an, and, are, for, into, of, on, to, the, and with are ignored. Use them—Iook up
equality of distributions—or omit them—Ilook up equality distributions—it
makes no difference.

e search tolerates plurals, especially when they can be formed by adding an s. Even so, it is
better to look up the singular. Look up normal distribution, not normal distributions.

e Specify the search criterion in English, not in computer jargon.
e Use American spellings. Look up color, not colour.

e Use nouns. Do not use -ing words or other verbs. Look up median tests, not testing
medians.

e Use few words. Every word specified further restricts the search. Look up distribution,
and you get one list; look up normal distribution, and the list is a sublist of that.

e Sometimes words have more than one context. The following words can be used to restrict
the context:

a. data, meaning in the context of data management. Order could refer to the order of
data or to order statistics. Look up order data to restrict order to its data management
sense.

b. statistics (abbreviation stat), meaning in the context of statistics.
Look up order statistics to restrict order to the statistical sense.
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c. graph or graphs, meaning in the context of statistical graphics. Look up median
graphs to restrict the list to commands for graphing medians.

d. utility (abbreviation util), meaning in the context of utility commands. The
search command itself is not data management, not statistics, and not graphics; it
is a utility.

e. programs or programming (abbreviation prog), to mean in the context of program-
ming. Look up programming scalar to obtain a sublist of scalars in programming.

search has other features, as well; see [U] 4.8 search: All the details.

4.7 More on help

Both help and search are understanding of some mistakes. For instance, you may abbreviate
some command names. If you type either help regres or help regress, you will bring up the
help file for regress.

When help cannot find the command you are looking for among Stata’s official help files or any
user-written additions you have installed, Stata automatically performs a search. For instance, typing
help ranktest causes Stata to reply with “help for ranktest not found”, and then Stata performs
search ranktest. The search tells you that ranktest is available in the Enhanced routines for
IV/GMM estimation and testing article in Stata Journal, Volume 7, Number 4.

Stata can run into some problems with abbreviations. For instance, Stata has a command with the
inelegant name ksmirnov. You forget and think the command is called ksmir:

. help ksmir
No entries found for search on "ksmir"

A help file for ksmir was not found, so Stata automatically performed a search on the word. The
message indicates that a search of ksmir also produced no results. You should type search followed
by what you are really looking for: search kolmogorov smirnov.

4.8 search: All the details

The search command actually provides a few features that are not available from the Help menu.
The full syntax of the search command is

search word [word ] [, [all\loca1|net] author entry exact faq

historical or manual sj|
where underlining indicates the minimum allowable abbreviation and [brackets] indicate optional.

all, the default, specifies that the search be performed across both the local keyword database and
the net materials.

local specifies that the search be performed using only Stata’s keyword database.

net specifies that the search be performed across the materials available via Stata’s net command.
Using search word [word } , net is equivalent to typing net search word [word ]
(without options); see [R] net.

author specifies that the search be performed on the basis of author’s name rather than keywords.
entry specifies that the search be performed on the basis of entry IDs rather than keywords.

exact prevents matching on abbreviations.
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faq limits the search to entries found in the FAQs at http://www.stata.com.

historical adds to the search entries that are of historical interest only. By default, such entries
are not listed. Past entries are classified as historical if they discuss a feature that later became an
official part of Stata. Updates to historical entries will always be found, even if historical is
not specified.

or specifies that an entry be listed if any of the words typed after search are associated with the
entry. The default is to list the entry only if all the words specified are associated with the entry.

manual limits the search to entries in the User’s Guide and all the Reference manuals.

sj limits the search to entries in the Stata Journal and the Stata Technical Bulletin.

4.8.1 How search works

search has a database—files—containing the titles, etc., of every entry in the User’s Guide,
Reference manuals, undocumented help files, NetCourses, Stata Press books, FAQs posted on the
Stata website, videos on StataCorp’s YouTube channel, selected articles on StataCorp’s official blog,
selected user-written FAQs and examples, and the articles in the Stata Journal and in the Stata Technical
Bulletin. In this file is a list of words associated with each entry, called keywords.

When you type search xyz, search reads this file and compares the list of keywords with xyz.
If it finds xyz in the list or a keyword that allows an abbreviation of xyz, it displays the entry.

When you type search xyz abc, search does the same thing but displays an entry only if it
contains both keywords. The order does not matter, so you can search linear regression or
search regression linear.

How many entries search finds depends on how the search database was constructed. We have
included a plethora of keywords under the theory that, for a given request, it is better to list too much
rather than risk listing nothing at all. Still, you are in the position of guessing the keywords. Do you
look up normality test, normality tests, or tests of normality? Normality test would be best, but all
would work. In general, use the singular, and strike the unnecessary words. We provide guidelines
for specifying keywords in [U] 4.6 More on search above.

4.8.2 Author searches

search ordinarily compares the words following search with the keywords for the entry. If you
specify the author option, however, it compares the words with the author’s name. In the search
database, we have filled in author names for Stata Journal and STB articles, Stata Press books,
StataCorp’s official blog, and FAQs.

For instance, in [R] kdensity, you will discover that Isaias H. Salgado-Ugarte wrote the first version
of Stata’s kdensity command and published it in the STB. Assume that you have read his original
and find the discussion useful. You might now wonder what else he has written in the STB. To find
out, type

. search Salgado-Ugarte, author
(output omitted )

Names like Salgado-Ugarte are confusing to some people. search does not require you specify the
entire name; what you type is compared with each “word” of the name, and, if any part matches,
the entry is listed. The hyphen is a special character, and you can omit it. Thus you can obtain the
same list by looking up Salgado, Ugarte, or Salgado Ugarte without the hyphen.
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Actually, to find all entries written by Salgado-Ugarte, you need to type

. search Salgado-Ugarte, author historical
(output omitted )

Prior inserts in the STB that provide a feature that later was superseded by a built-in feature of Stata
are marked as historical in the search database and, by default, are not listed. The historical option
ensures that all entries are listed.

4.8.3 Entry ID searches

If you specify the entry option, search compares what you have typed with the entry ID. The
entry ID is not the title—it is the reference listed to the left of the title that tells you where to look.
For instance, in

[R] regress . . . . . + +« « « +« « +« 4« +« « « « « . . . . Linear regression
(help regress)

“[R] regress” is the entry ID. In

GS C e e e e e e . . . . . . . . . . . ... .. .Getting Started manual

“GS” is the entry ID. In

SJ-6-4 st0113 . Testing for cross-sectional dependence in panel-data models
(help xtosd if installed) . . . . . . R. E. De Hoyos and V. Sarafidis
Q4/06  SJ 6(4): 482--496
tests for the presence of cross-sectional dependence in
panels with many cross-sectional units and few time-series
observations

“SJ-6-4 st0113” is the entry ID.
search with the entry option searches these entry IDs.
Thus you could generate a table of contents for the Reference manuals by typing

. search [R], entry
(output omitted )

You could generate a table of contents for the 16th issue of the STB by typing

. search STB-16, entry historical
(output omitted )

The historical option here is possibly important. STB-16 was published in November 1993, and
perhaps some of its inserts have been marked as historical.

You could obtain a list of all inserts associated with dm36 by typing

. search dm36, entry historical
(output omitted )

Again, we include the historical option if any of the relevant inserts have been marked historical.

4.8.4 FAQ searches

To search across the FAQs, specify the faq option:

. search logistic regression, faq
(output omitted )
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4.8.5 Return codes

In addition to indexing the entries in the User’s Guide and all the Stata Reference manuals, search
also can be used to look up return codes.

To see information about return code 131, type

. search rc 131

[R] error messages . . . . . .« + + + « + « +« « « « . . . Return code 131
not possible with test;
You requested a test of a hypothesis that is nonlinear in the
variables. test tests only linear hypotheses. Use testnl.

To get a list of all Stata return codes, type

. search rc
(output omitted )

4.9 net search: Searching net resources

When you select Help > Search..., there are two types of searches to choose. The first, which
has been discussed in the previous sections, is to Search documentation and FAQs. The second is
to Search net resources. This feature of Stata searches resources over the Internet.

When you choose Search net resources in the search dialog box and enter keywords in the field,
Stata searches all user-written programs on the Internet, including user-written additions published in
the Stata Journal and the STB. The results are displayed in the Viewer, and you can click to go to
any of the matches found.

Equivalently, you can type net search keywords on the Stata command line to display the results
in the Results window. For the full syntax for using the net search command, see [R] net search.
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5.1 Platforms

Stata is available for a variety of computers, including

Stata for Windows, 64-bit x86-64
Stata for Windows, 32-bit x86

Stata for Mac, 64-bit Intel

Stata for Linux, 64-bit x86-64
Stata for Linux, 32-bit x86
Stata for Solaris, 64-bit SPARC
Stata for Solaris, 64-bit x86-64

Which version of Stata you run does not matter— Stata is Stata. You instruct Stata in the same way
and Stata produces the same results, right down to the random-number generator. Even files can be
shared. A dataset created on one computer can be used on any other computer, and the same goes
for graphs, programs, or any file Stata uses or produces. Moving files across platforms is simply a
matter of copying them; no translation is required.

Some computers, however, are faster than others. Some computers have more memory than others.
Computers with more memory, and faster computers, are better.

The list above includes both 64- and 32-bit computers. 64-bit Stata runs faster than 32-bit Stata
and 64-bit Stata will allow processing data in excess of 2 gigabytes, assuming you have enough
memory. 32-bit Stata will run on 64-bit hardware.

When you purchase Stata, you may install it on any of the above platforms. Stata licenses are not
locked to a single operating system.

5.2 Stata/MP, Stata/SE, Stata/lC, and Small Stata

Stata is available in four flavors, although perhaps sizes would be a better word. The flavors are,
from largest to smallest, Stata/MP, Stata/SE, Stata/IC, and Small Stata.

Stata/MP is the multiprocessor version of Stata. It runs on multiple CPUs or on multiple cores,
from 2 to 64. Stata/MP uses however many cores you tell it to use (even one), up to the number
of cores for which you are licensed. Stata/MP is the fastest version of Stata. Even so, all the details
of parallelization are handled internally and you use Stata/MP just like you use any other flavor of
Stata. You can read about how Stata/MP works and see how its speed increases with more cores in
the Stata/MP performance report at http://www.stata.com/statamp/report.pdf.

49


http://www.stata.com/statamp/report.pdf

50 [U] 5 Flavors of Stata

Stata/SE is like Stata/MP, but for single CPUs. Stata/SE will run on multiple CPUs or multiple-core
computers, but it will use only one CPU or core. SE stands for special edition.

Both Stata/MP and Stata/SE have the same limits and the same capabilities and are intended for
those who work with large datasets. You may have up to 32,767 variables with either. Statistical
models may have up to 11,000 variables.

Stata/IC is standard Stata. Up to 2,047 variables are allowed. Statistical models may have up to
800 variables.

Stata/MP, Stata/SE, and Stata/IC all allow up to 2,147,583,647 observations, assuming you have
enough memory.

Small Stata is intended for students and limited to 99 variables and 1,200 observations.

5.2.1 Determining which version you own

Check your License and Activation Key. Included with every copy of Stata is a License and
Activation Key that contains codes that you will input during installation. This determines which
flavor of Stata you have and for which platform.

Contact us or your distributor if you want to upgrade from one flavor to another. Usually, all you
need is an upgraded License and Activation Key with the appropriate codes. All flavors of Stata are
on the same DVD.

If you purchased one flavor of Stata and want to use a lesser version, you may. You might want to
do this if you had a large computer at work and a smaller one at home. Please remember, however,
that you have only one license (or however many licenses you purchased). You may, both legally and
ethically, install Stata on both computers and then use one or the other, but you should not use them
both simultaneously.

5.2.2 Determining which version is installed

If Stata is already installed, you can find out which Stata you are using by entering Stata as you
normally do and typing about:

. about

Stata/MP 13.0 for Windows (64-bit x86-64)
Revision date
Copyright 1985-2013 StataCorp LP
10-user 32-core Stata network perpetual license:
Serial number: 5013041234
Licensed to: Alan R. Riley
StataCorp

5.3 Size limits of Stata/MP, SE, IC, and Small Stata

Here are some of the different size limits for Stata/MP, Stata/SE, Stata/IC, and Small Stata. See
[R] limits for a longer list.



[U] 5 Flavors of Stata 51

Maximum size limits for Stata/MP, Stata/SE, Stata/IC, and Small Stata

Stata/MP and SE Stata/IC Small Stata
Number of observations limited only by memory limited only by memory fixed at 1,200
Number of variables 32,767 2,047 fixed at 99
Width of a dataset 393,192 24,564 800
Maximum # of right-hand-side variables 10,998 798 99
Number of characters in a macro 1,081,511 165,200 13,400
Number of characters in a command 1,081,527 165,216 13,416

Stata/MP and Stata/SE allow more variables, larger models, longer macros, and a longer command
line than Stata/IC. The longer command line and macro length are required because of the greater
number of variables allowed. Larger models means that Stata/MP and Stata/SE can fit statistical
models with more independent variables.

Small Stata is limited. It is intended for student use and often used in undergraduate labs.

5.4 Speed comparison of Stata/MP, SE, IC, and Small Stata

We have written a white paper comparing the performance of Stata/MP with Stata/SE; see
http://www.stata.com/statamp/report.pdf. The white paper includes command-by-command perfor-
mance measurements.

In summary, on a 2-CPU or dual-core computer, Stata/MP will run commands in 71% of the time
required by Stata/SE. There is variation; some commands run in half the time and others are not
sped up at all. Statistical estimation commands run in 59% of the time. Numbers quoted are medians.
Average performance gains are higher because commands that take longer to execute are generally
sped up more.

Stata/MP running on four CPUs runs in 50% (all commands) and 35% (estimation commands) of
the time required by Stata/SE. Both numbers are median measures.

Stata/MP supports up to 64 cores.

Stata/IC is slower than Stata/SE, but those differences emerge only when processing datasets
that are pushing the limits of Stata/IC. Stata/SE has a larger memory footprint and uses that extra
memory for larger look-aside tables to more efficiently process large datasets. The real benefits of
the larger tables become apparent only after exceeding the limits of Stata/IC. Stata/SE was designed
for processing large datasets.

Small Stata is, by comparison with all the above, slow, but given its limits, no one notices.
Small Stata was designed to have a minimal memory footprint, and to achieve that, different logic is
sometimes used. For instance, in Stata’s test command, it must compute the matrix calculation RZR/
(where Z = (X’X)~1). Stata/MP, Stata/SE, and Stata/IC make the calculation in a straightforward
way, which is to form T = RZ and then calculate TR/. This requires temporarily storing the matrix
T. Small Stata, on the other hand, goes into more complicated code to form the result directly—code
that requires temporary storage of only one scalar. This code, in effect, recalculates intermediate
results over and over again, and so it is slower.

The differences are all technical and internal. From the user’s point of view, Stata/MP, Stata/SE,
Stata/IC, and Small Stata work the same way.
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5.5 Feature comparison of Stata/MP, SE, and IC

The features of all flavors of Stata on all platforms are the same. The differences are in speed and
in limits as discussed above. To learn more, type help stata/mp, help stata/se, help stata/ic,
or help small stata.
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6.1 Memory-size considerations

Stata works with a copy of data that it loads into memory. Memory allocation is automatic.

Stata automatically sizes itself up and down as your session progresses. Stata obtains memory
from the operating system and draws no distinction between real and virtual memory. Virtual memory
is memory that resides on disk that operating systems supply when physical memory runs short.
Virtual memory is slow but adequate in cases when you have a dataset that is too large to load
into real memory. If you wish to limit the maximum amount of memory Stata can use, you can set
max_memory; see [D] memory. If you use the Linux operating system, we strongly suggest you set
max_memory; see Serious bug in Linux OS in [D] memory.

6.2 Compressing data

Stata stores data in memory. The compress command reduces the amount of memory required
to store the data without loss of precision or any other disadvantages; see [D] compress. Typing
compress every so often is a good idea.

compress works by examining the values you have stored and changing the data types of variables
when that can be done without loss of precision. For instance, you may have a variable stored as
float but that records only integer values between —127 and 100. compress would change the
storage type of that variable to byte and save 3 bytes per observation. If you had 100 variables like
that, the savings would be 300 bytes per observation, and if you had 3,000,000 observations, the total
savings would be nearly 900 megabytes.

6.3 Setting maxvar

If you get the error message “no room to add more variables”, r(901), do not jump to the conclusion
that you have exceeded Stata’s capacity.

maxvar specifies the maximum number of variables you can use. The default setting depends on
whether you are using Stata/MP, Stata/SE, Stata/IC, or Small Stata. To determine the current setting,
type query memory at the Stata prompt.

If you use Stata/MP or Stata/SE, you can reset this maximum number all the way up to 32,767.
Set maxvar to more than you need—at least 20 more than you need but not too much more than
you need. Figure that each 10,000 variables consumes roughly 0.5 megabytes of memory.
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You reset maxvar using the set maxvar command,
set maxvar # [, permanently]

where 2,048 < # < 32,767. You can reset maxvar repeatedly during a session. If you specify the
permanently option, you change maxvar not only for this session but also for future sessions. See
[D] memory.

6.4 Setting matsize

You may issue an estimation command and obtain the error message “matsize too small”, r(908).
Stata uses matrices in making many calculations. matsize specifies the maximum size of those
matrices in terms of (roughly speaking) the number of estimated coefficients. The default value of
matsize is 400. matsize can be set to any value between 10 and 11,000, inclusive. The command
is

set matsize # [, permanently]
where 10 < # < 11,000.

ncreasing matsize increases Stata’s memory consumption:
I t Stata’ t

matsize memory use
400 1.254M

800 4.950M
1,600 19.666M
3,200 78.394M
6,400 313.037M
11,000 924.080M

The table above understates the amount of memory Stata will use. The table was derived under
the assumption of one matrix and eleven vectors. If two matrices are required, the numbers above
would be nearly doubled.

If you use a 32-bit computer, you likely will be unable to set matsize to 11,000. A value of 11,000
would require nearly 1 gigabyte per matrix. The total memory consumption most 32-bit operating
systems will grant to Stata is 2 gigabytes, so if you had two matrices, there would be no memory
left for data or for Stata’s code!

You should not set matsize larger than is necessary. Doing so will at best waste memory and at
worst slow Stata down or prevent Stata from having enough memory for other tasks. If you receive
the error message “matsize too small”, increase matsize only as much as is necessary to eliminate
the error message.

6.5 The memory command

The memory command will show you the major components of Stata’s memory footprint.
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You may use

. use http://www.stata-press.com/data/r13/regsmpl
(NLS Women 14-26 in 1968)

. memory

Memory usage

used allocated
data 913,088 33,554,432
strLs 0 0
data & strLs 913,088 33,554,432
data & strLs 913,088 33,554,432
var. names, %fmts, ... 1,793 25,440
overhead 1,064,964 1,065,360
Stata matrices 0 0
ado-files 14,167 14,167
stored results 0 0
Mata matrices 0 0
Mata functions 0 0
set maxvar usage 1,185,183 1,185,183
other 1,309 1,309
grand total 3,178,200 35,845,891

See [D] memory.
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7.1 Description

When you see —more— at the bottom of the screen,

Press ... and Stata ...

letter [ or Enter displays the next line

letter g acts as if you pressed Break
Spacebar or any other key displays the next screen

Also, you can press the clear —more— condition button, the button labeled Go with a circle around it.

—more— is Stata’s way of telling you that it has something more to show you, but showing you
that something more will cause the information on the screen to scroll off.

7.2 set more off

If you type set more off, —more— conditions will never arise and Stata’s output will scroll by
at full speed.

If you type set more on, —more— conditions will be restored at the appropriate places.

Programmers: Do-file writers sometimes include set more off in their do-files because they do
not care to interactively watch the output. They want Stata to proceed at full speed because they plan
on making a log of the output that they will review later. Do-filers need not bother to set more on
at the conclusion of their do-file. Stata automatically restores the previous set more when the do-file
(or program) concludes.

7.3 The more programming command
Ado-file programmers need take no special action to have —more— conditions arise when the
screen is full. Stata handles that automatically.

If, however, you wish to force a —more— condition early, you can include the more command
in your program. The syntax of more is

more
more takes no arguments.

For more information, see [P] more.
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Making mistakes

When an error occurs, Stata produces an error message and a return code. For instance,

. list myvar
no variables defined
r(111);

We ask Stata to list the variable named myvar. Because we have no data in memory, Stata responds
with the message “no variables defined” and a line that reads “r(111)”.
The “no variables defined” is called the error message.

The 111 is called the return code. You can click on blue return codes to get a detailed explanation
of the error.

.1 Mistakes are forgiven

After “no variables defined” and r(111), all is forgiven; it is as if the error never occurred.

Typically, the message will be enough to guide you to a solution, but if it is not, the numeric
return codes are documented in [P] error.

8.1.2 Mistakes stop user-written programs and do-files

Whenever an error occurs in a user-written program or do-file, the program or do-file immediately
stops execution and the error message and return code are displayed.

For instance, consider the following do-file:

begin myfile.do
use http://www.stata-press.com/data/ri3/auto

decribe

list

end myfile.do

Note the second line—you meant to type describe but typed decribe. Here is what happens when
you execute this do-file by typing do myfile:

. do myfile

. use http://www.stata-press.com/data/r13/auto
(1978 Automobile Data)
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. decribe

unrecognized command: decribe
r(199);

end of do-file

r(199);

The first error message and return code were caused by the illegal decribe. This then caused the
do-file itself to be aborted; the valid 1ist command was never executed.

8.1.3 Advanced programming to tolerate errors

Errors are not only of the typographical kind; some are substantive. A command that is valid in
one dataset might not be valid in another. Moreover, in advanced programming, errors are sometimes
anticipated: use one dataset if it is there, but use another if you must.

Programmers can access the return code to determine whether an error occurred, which they can
then ignore, or, by examining the return code, code their programs to take the appropriate action.
This is discussed in [P] capture.

You can also prevent do-files from stopping when errors occur by using the do command’s nostop
option.

. do myfile, nostop

8.2 The return message for obtaining command timings

In addition to error messages and return codes, there is something called a return message, which
you normally do not see. Normally, if you typed summarize tempjan, you would see
. use http://www.stata-press.com/data/r13/citytemp
(City Temperature Data)
. summarize tempjan
Variable | Obs Mean Std. Dev. Min Max

tempjan | 954 35.74895 14.18813 2.2 72.6

If you were to type

. set rmsg on
r; t=0.00 10:21:22

sometime during your session, Stata would display return messages:

. summarize tempjan
Variable | Obs Mean Std. Dev. Min Max

tempjan | 954 35.74895 14.18813 2.2 72.6
r; t=0.01 10:21:26

The line that reads r; t=0.01 10:21:26 is called the return message.
The r; indicates that Stata successfully completed the command.

The t=0.01 shows the amount of time, in seconds, it took Stata to perform the command (timed
from the point you pressed Enter to the time Stata typed the message). This command took a hundredth
of a second. Stata also shows the time of day with a 24-hour clock. This command completed at
10:21 a.m.
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Stata can run commands stored in files (called do-files) and can log output. Some users find the
detailed return message helpful with do-files. They construct a long program and let it run overnight,
logging the output. They come back the next morning, look at the output, and discover a mistake in
some portion of the job. They can look at the return messages to determine how long it will take to
rerun that portion of the program.

You may set rmsg on whenever you wish.

When you want Stata to stop displaying the detailed return message, type set rmsg off.
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9.1 Making Stata stop what it is doing

When you want to make Stata stop what it is doing and return to the Stata dot prompt, you click on
Break:

Stata for Windows: click on the Break button (it is the button with the big red X), or
press Ctrl+Pause/Break
Stata for Mac: click on the Break button or
press Command+. (period)
Stata for Unix(GUI): click on the Break button or
press Ctrl+k
Stata for Unix(console): press Ctrl+c or
press q

Elsewhere in this manual, we describe this action as simply clicking on Break. Break tells Stata to
cancel what it is doing and return control to you as soon as possible.

If you click on Break in response to the input prompt or while you are typing a line, Stata ignores
it, because you are already in control.

If you click on Break while Stata is doing something—creating a new variable, sorting a dataset,
making a graph, etc.—Stata stops what it is doing, undoes it, and issues an input prompt. The state
of the system is the same as if you had never issued the command.

> Example 1

You are fitting a logit model, type the command, and, as Stata is working on the problem, realize
that you omitted an important variable:

. logit foreign mpg weight

Iteration O: log likelihood = -45.03321
Iteration 1: log likelihood = -29.898968
—Break—

r(1);

When you clicked on Break, Stata responded by typing —Break— and then typing r(1) ;. Clicking
on Break always results in a return code of 1—that is why return codes are called return codes and
not error codes. The 1 does not indicate an error, but it does indicate that the command did not
complete its task.

N
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9.2 Side effects of clicking on Break

In general, there are no side effects of clicking on Break. We said above that Stata undoes what it
is doing so that the state of the system is the same as if you had never issued the command. There
are two exceptions to that statement.

If you are reading data from disk by using import delimited, infile, or infix, whatever data
have already been read will be left behind in memory, the theory being that perhaps you stopped the
process so you could verify that you were reading the right data correctly before sitting through the
whole process. If not, you can always clear.

. infile v1-v9 using workdata
(eof not at end of obs)

(4 observations read)
—Break—

r(1);

The other exception is sort. You have a large dataset in memory, decide to sort it, and then
change your mind.

. sort price
—Break—
r(1);

If the dataset was previously sorted by, say, the variable prodid, it is no longer. When you click on
Break in the middle of a sort, Stata marks the data as unsorted.

9.3 Programming considerations

There are basically no programming considerations for handling Break because Stata handles it
all automatically. If you write a program or do-file, execute it, and then click on Break, Stata stops
execution just as it would with an internal command.

Advanced programmers may be concerned about cleaning up after themselves; perhaps they have
generated a temporary variable they intended to drop later or a temporary file they intended to erase
later. If a Stata user clicks on Break, how can you ensure that these temporary variables and files
will be erased?

If you obtain names for such temporary items from Stata’s tempname, tempvar, and tempfile
commands, Stata will automatically erase the temporary items; see [U] 18.7 Temporary objects.

There are instances, however, when a program must commit to executing a group of commands
without interruption, or the user’s data would be left in an intermediate or undefined state. In these
instances, Stata provides a

nobreak {

}

construct; see [P] break. Also see [M-5] setbreakintr() to read about Break-key processing in Mata.
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10.1 Description

The keyboard should operate much the way you would expect, with a few additions:
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e There are some unexpected keys you can press to obtain previous commands you have typed.
Also, you can click once on a command in the Review window to reload it, or click on it twice
to reload and execute; this feature is discussed in the Getting Started manuals.

e There are a host of command-editing features for Stata for Unix(console) users because their
user interface does not offer such features.

e Regardless of operating system or user interface, if there are F-keys on your keyboard, they
have special meaning and you can change the definitions of the keys.

10.2 F-keys

Windows users: F10 is reserved internally by Windows; you cannot program this key.

By default, Stata defines the F-keys to mean

F-key

Definition

F1
F2
F7
F8

help advice;
describe;
save

use

The semicolons at the end of some entries indicate an implied Enter.

Stata provides several methods for obtaining help. To learn about these methods, select Help >

Advice. Or you can just press FI.

describe is the Stata command to report the contents of data loaded into memory. It is explained
in [D] describe. Normally, you type describe and press Enter. You can also press F2.

save is the command to save the data in memory into a file, and use is the command to load
data; see [D] use and [D] save. The syntax of each is the same: save or use followed by a filename.
You can type the commands or you can press F7 or F8 followed by the filename.

You can change the definitions of the F-keys. For instance, the command to list data is 1ist; you
can read about it in [D] list. The syntax is list to list all the data, or 1ist followed by the names
of some variables to list just those variables (there are other possibilities).
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If you wanted F3 to mean 1ist, you could type

. global F3 "list "

In the above, F3 refers to the letter F followed by 3, not the F3 key. Note the capitalization and
spacing of the command.

You type global in lowercase, type F3, and then type "list ". The space at the end of 1list is
important. In the future, rather than typing list mpg weight, you want to be able to press the F3
key and then type only mpg weight. You put a space in the definition of F3 so that you would not
have to type a space in front of the first variable name after pressing F3.

Now say you wanted F5 to mean list all the data—1ist followed by Enter. You could define

. global F5 "list;"

Now you would have two ways of listing all the data: press F3, and then press Enter, or press F5.
The semicolon at the end of the definition of F5 will press Enter for you.

If you really want to change the definitions of F3 and F5, you will probably want to change the
definition every time you invoke Stata. One way would be to type the two global commands every
time you invoke Stata. Another way would be to type the two commands into a text file named
profile.do. Stata executes the commands in profile.do every time it is launched if profile.do
is placed in the appropriate directory:

Windows: see [GSW] B.3 Executing commands every time Stata is started
Mac: see [GSM] B.1 Executing commands every time Stata is started
Unix: see [GSU] B.1 Executing commands every time Stata is started

You can use the F-keys any way you desire: they contain a string of characters, and pressing the
F-key is equivalent to typing those characters.

Q Technical note

[Stata for Unix(console) users.] Sometimes Unix assigns a special meaning to the F-keys, and if
it does, those meanings supersede our meanings. Stata provides a second way to get to the F-keys.
Press Ctrl+F, release the keys, and then press a number from O through 9. Stata interprets Ctrl+F
plus 1 as equivalent to the FI key, Ctrl+F plus 2 as F2, and so on. Ctrl+F plus 0 means F10. These
keys will work only if they are properly mapped in your termcap or terminfo entry.

a

Q Technical note

On some international keyboards, the left single quote is used as an accent character. In this
case, we recommend mapping this character to one of your function keys. In fact, you might find it
convenient to map both the left single quote () and right single quote (’) characters so that they are
next to each other.

Within Stata, open the Do-file Editor. Type the following two lines in the Do-file Editor:

global F4 ¢
global F5 ’

Save the file as profile.do into your Stata directory. If you already have a profile.do file,
append the two lines to your existing profile.do file.
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Exit Stata and restart it. You should see the startup message
running C:\Program Files\Statal3\profile.do ...
or some variant of it depending on where your Stata is installed. Press F4 and F5 to verify that they
work.
If you did not see the startup message, you did not save the profile.do in your home folder.

You can, of course, map to any other function keys, but F1, F2, F7, and F8 are already used.
Q

10.3 Editing keys in Stata

Users have available to them the standard editing keys for their operating system. So, Stata should
just edit what you type in the natural way—the Stata Command window is a standard edit window.

Also, you can fetch commands from the Review window into the Command window. Click on a
command in the Review window, and it is loaded into the Command window, where you can edit it.
Alternatively, if you double-click on a line in the Review window, it is loaded and executed.

Another way to get lines from the Review window into the Command window is with the PgUp
and PgDn keys. Press PgUp and Stata loads the last command you typed into the Command window.
Press it again and Stata loads the line before that, and so on. PgDn goes in the opposite direction.

Another editing key that interests users is Esc. This key clears the Command window.

In summary,
Press Result

PgUp Steps back through commands and moves command
from Review window to Command window

PgDn Steps forward through commands and moves command
from Review window to Command window

Esc  Clears Command window

10.4 Editing keys in Stata for Unix(console)

Certain keys allow you to edit the line that you are typing. Because Stata supports a variety of
computers and keyboards, the location and the names of the editing keys are not the same for all
Stata users.

Every keyboard has the standard alphabet keys (QWERTY and so on), and every keyboard has a
Ctrl key. Some keyboards have extra keys located to the right, above, or left, with names like PgUp
and PgDn.

Throughout this manual we will refer to Stata’s editing keys using names that appear on nobody’s
keyboard. For instance, PrevLine is one of the Stata editing keys—it retrieves a previous line. Hunt
all you want, but you will not find it on your keyboard. So, where is PrevLine? We have tried to put
it where you would naturally expect it. On keyboards with a key labeled PgUp, PgUp is the PrevLine
key, but on everybody’s keyboard, no matter which version of Unix, brand of keyboard, or anything
else, Ctrl+R also means PrevLine.
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When we say press PrevLine, now you know what we mean: press PgUp or Ctrl+R. The editing

keys are the following:

Name for
editing key Editing key Function
Kill Esc on PCs and Ctrl+U Deletes the line and lets you start over.
Dbs Backspace on PCs and Backspace Backs up and deletes one character.
or Delete on other computers

Lft —, 4 on the numeric keypad Moves the cursor left one character

for PCs, and Ctrl+H without deleting any characters.

Rgt —, 6 on the numeric keypad Moves the cursor forward one character.

for PCs, and Ctrl+L

Up T, 8 on the numeric keypad Moves the cursor up one physical line on a

for PCs, and Ctrl+O line that takes more than one physical line.
Also see PrevLine.
Dn 1, 2 on the numeric keypad Moves the cursor down one physical line on a
for PCs, and Ctrl+N line that takes more than one physical line.
Also see NextLine.

PrevLine  PgUp and Ctrl+R Retrieves a previously typed line. You may
press PrevLine multiple times to step back
through previous commands.

NextLine  PgDn and Ctrl+B The inverse of PrevLine.

Seek Ctrl+Home on PCs and Ctrl+W Goes to the line number specified. Before
pressing Seek, type the line number. For
instance, typing 3 and then pressing Seek is
the same as pressing PrevLine three times.

Ins Ins and Ctrl+E Toggles insert mode. In insert mode, characters
typed are inserted at the position
of the cursor.

Del Del and Ctrl+D Deletes the character at the position of
the cursor.

Home Home and Ctrl+K Moves the cursor to the start of the line.

End End and Ctrl+P Moves the cursor to the end of the line.

Hack Ctrl+End on PCs, and Ctrl+X Hacks off the line at the cursor.

Tab —| on PCs, Tab, and Ctrl+I Expand variable name.

Btab k— on PCs, and Ctr+G The inverse of Tab.

> Example 1

It is difficult to demonstrate the use of editing keys on paper. You should try each of them.

Nevertheless, here is an example:

summarize price waht

You typed summarize price waht and then pressed the Lft key («— key or Ctrl+H) three times
to maneuver the cursor back to the a of waht. If you were to press Enter right now, Stata would see
the command summarize price waht, so where the cursor is does not matter when you press Enter.
If you wanted to execute the command summarize price, you could back up one more character
and then press the Hack key. We will assume, however, that you meant to type weight.

If you were now to press the letter e on the keyboard, an e would appear on the screen to replace
the a, and the cursor would move under the character h. We now have weht. You press Ins, putting
Stata into insert mode, and press i and g. The line now says summarize price weight, which is
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correct, so you press Enter. We did not have to press Ins before every character we wanted to insert.
The Ins key is a toggle: If we press it again, Stata turns off insert mode, and what we type replaces
what was there. When we press Enter, Stata forgets all about insert mode, so we do not have to
remember from one command to the next whether we are in insert mode.

d

Q Technical note

Stata performs its editing magic from the information about your terminal recorded in
/etc/termcap(5) or, under System V, /usr/lib/terminfo(4). If some feature does not appear to
work, the entry for your terminal in the termcap file or terminfo directory is probably incorrect.
Contact your system administrator.

a

10.5 Editing previous lines in Stata

In addition to what is said below, remember that the Review window also shows the contents of
the review buffer.

One way to retrieve lines is with the PrevLine and NextLine keys. Remember, PrevLine and
NextLine are the names we attach to these keys—there are no such keys on your keyboard. You have
to look back at the previous section to find out which keys correspond to PrevLine and NextLine
on your computer. To save you the effort this time, PrevLine probably corresponds to PgUp and
NextLine probably corresponds to PgDn.

Suppose you wanted to reissue the third line back. You could press PrevLine three times and then
press Enter. If you made a mistake and pressed PrevLine four times, you could press NextLine to
go forward in the buffer. You do not have to count lines because, each time you press PrevLine or
NextLine, the current line is displayed on your monitor. Simply press the key until you find the line
you want.

Another method for reviewing previous lines, #review, is convenient for Unix(console) users.

> Example 2

Typing #review by itself causes Stata to list the last five commands you typed. For instance,

#review

list make mpg weight if abs(res)>6
list make mpg weight if abs(res)>5
tabulate foreign if abs(res)>5
regress mpg weight weight2

test weight2=0

=N W o

We can see from the listing that the last command typed by the user was test weight2=0. Or, you
may just look at the Review window to see the history of commands you typed.

N
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> Example 3

Perhaps the command you are looking for is not among the last five commands you typed. You
can tell Stata to go back any number of lines. For instance, typing #review 15 tells Stata to show
you the last 15 lines you typed:

. #review 15

15 replace resmpg=mpg-pred

14 summarize resmpg, detail

13 drop predmpg

12 describe

11 sort foreign

10 by foreign: summarize mpg weight

9 * lines that start with a * are comments.
8 * they go into the review buffer too.
7 summarize resmpg, detail

6 list make mpg weight

5 list make mpg weight if abs(res)>6

4 list make mpg weight if abs(res)>5

3 tabulate foreign if abs(res)>5

2 regress mpg weight weight2

1 test weight2=0

If you wanted to resubmit the 10th previous line, you could type 10 and press Seek, or you could
press PrevLine 10 times. No matter which of the above methods you prefer for retrieving lines, you
may edit previous lines by using the editing keys.

4

10.6 Tab expansion of variable names

Another way to quickly enter a variable name is to take advantage of Stata’s variable name
completion feature. Simply type the first few letters of the variable name in the Command window
and press the Tab key. Stata will automatically type the rest of the variable name for you. If more
than one variable name matches the letters you have typed, Stata will complete as much as it can
and beep at you to let you know that you have typed a nonunique variable abbreviation.
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.1 Overview

With few exceptions, the basic Stata language syntax is

[by varlisl:] command [varlist} [=exp] [if exp] [in mnge] [weight} [, ()pti(ms]

where square brackets distinguish optional qualifiers and options from required ones. In this diagram,
varlist denotes a list of variable names, command denotes a Stata command, exp denotes an algebraic
expression, range denotes an observation range, weight denotes a weighting expression, and options
denotes a list of options.
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11.1.1 varlist

Most commands that take a subsequent varlist do not require that you explicitly type one. If no
varlist appears, these commands assume a varlist of _all, the Stata shorthand for indicating all the
variables in the dataset. In commands that alter or destroy data, Stata requires that the varlist be
specified explicitly. See [U] 11.4 varlists for a complete description.

Some commands take a varname, rather than a varlist. A varname refers to exactly one variable.
The tabulate command requires a varname; see [R] tabulate oneway.

> Example 1

The summarize command lists the mean, standard deviation, and range of the specified variables.
In [R] summarize, we see that the syntax diagram for summarize is

summarize [varlist] [lf] [in} [weight] [, options]

Farther down on the manual page is a table summarizing options, but let’s focus on the syntax
diagram itself first. Because everything except the word summarize is enclosed in square brackets, the
simplest form of the command is “summarize”. Typing summarize without arguments is equivalent
to typing summarize _all; all the variables in the dataset are summarized. Underlining denotes the
shortest allowed abbreviation, so we could have typed just su; see [U] 11.2 Abbreviation rules.

The table that defines options looks like this:

options Description
Main
detail display additional statistics
meanonly suppress the display; calculate only the mean; programmer’s option
format use variable’s display format
separator (#) draw separator line after every # variables; default is separator(5)

Thus we learn we could also type, for instance, summarize, detail or summarize, detail
format.

As another example, the drop command eliminates variables or observations from a dataset. When
dropping variables, its syntax is

drop varlist

drop has no option table because it has no options.

In fact, nothing is optional. Typing drop by itself would result in the error message “varlist or in
range required”. To drop all the variables in the dataset, we must type drop —all.

Even before looking at the syntax diagram, we could have predicted that varlist would be
required—drop is destructive, so Stata requires us to spell out our intent. The syntax diagram
informs us that varlist is required because varlist is not enclosed in square brackets. Because drop
is not underlined, it cannot be abbreviated.

N
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11.1.2 by varlist:

The by varlist: prefix causes Stata to repeat a command for each subset of the data for which the
values of the variables in varlist are equal. When prefixed with by varlist:, the result of the command
will be the same as if you had formed separate datasets for each group of observations, saved them,
and then gave the command on each dataset separately. The data must already be sorted by varlist,
although by has a sort option; see [U] 11.5 by varlist: construct for more information.

> Example 2
Typing summarize marriage_rate divorce_rate produces a table of the mean, standard
deviation, and range of marriage_rate and divorce_rate, using all the observations in the data:

. use http://www.stata-press.com/data/r13/censusi2
(1980 Census data by state)

. summarize marriage_rate divorce_rate

Variable | Obs Mean Std. Dev. Min Max
marriage_r~e 50 .0133221 .0188122 .0074654 .1428282
divorce_rate 50 .0056641 .0022473 .0029436 .0172918

Typing by region: summarize marriage_rate divorce_rate produces one table for each region
of the country:
. sort region

. by region: summarize marriage_rate divorce_rate

-> region = N Cntrl

Variable Obs Mean Std. Dev. Min Max
marriage_r-~e 12 .0099121 .0011326 .0087363 .0127394
divorce_rate 12 .0046974 .0011315 .0032817 .0072868

-> region = NE

Variable Obs Mean Std. Dev. Min Max
marriage_r~e 9 .0087811 .001191 .0075757 .0107055
divorce_rate 9 .004207 .0010264 .0029436 .0057071

-> region = South

Variable Obs Mean Std. Dev. Min Max
marriage_r~e 16 .0114654 .0025721 .0074654 .0172704
divorce_rate 16 .005633 .0013355 .0038917 .0080078

-> region = West
Variable Obs Mean Std. Dev. Min Max

marriage_r~e 13 .0218987 .0363775 .0087365 .1428282
divorce_rate 13 .0076037 .0031486  .0046004  .0172918
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The dataset must be sorted on the by variables:
. use http://www.stata-press.com/data/r13/censusi?2
(1980 Census data by state)

. by region: summarize marriage_rate divorce_rate
not sorted

r(5);

. sort region

. by region: summarize marriage_rate divorce_rate
(output appears)

We could also have asked that by sort the data:

. by region, sort: summarize marriage_rate divorce_rate
(output appears)

by varlist: can be used with most Stata commands; we can tell which ones by looking at their
syntax diagrams. For instance, we could obtain the correlations by region, between marriage_rate
and divorce_rate, by typing by region: correlate marriage_rate divorce_rate.

d

Q Technical note

The varlist in by varlist: may contain up to 32,767 variables with Stata/MP and Stata/SE or 2,047
variables with Stata/IC; these are the maximum allowed in the dataset. For instance, if we had data
on automobiles and wished to obtain means according to market category (market) broken down
by manufacturer (origin), we could type by market origin: summarize. That varlist contains
two variables: market and origin. If the data were not already sorted on market and origin, we
would first type sort market origin.

a

Q Technical note

The varlist in by varlist: may contain string variables, numeric variables, or both. In the example
above, region is a string variable, in particular, a str7. The example would have worked, however,
if region were a numeric variable with values 1, 2, 3, and 4, or even 12.2, 16.78, 32.417, and
152.13.

a

11.1.3 ifexp

The if exp qualifier restricts the scope of a command to those observations for which the value
of the expression is true (which is equivalent to the expression being nonzero; see [U] 13 Functions
and expressions).

> Example 3

Typing summarize marriage_rate divorce_rate if region=="West" produces a table for
the western region of the country:
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. summarize marriage_rate divorce_rate if region == "West"

Variable | Obs Mean Std. Dev. Min Max
marriage_r~e 13 .0218987 .0363775 .0087365 .1428282
divorce_rate 13 .0076037 .0031486 .0046004 .0172918

The double equal sign in region=="West" is not an error. Stata uses a double equal sign to denote
equality testing and one equal sign to denote assignment; see [U] 13 Functions and expressions.

A command may have at most one if qualifier. If you want the summary for the West re-
stricted to observations with values of marriage_rate in excess of 0.015, do not type summarize
marriage_rate divorce_rate if region=="West" if marriage_rate>.015. Instead type

. summarize marriage_rate divorce_rate if region == "West" & marriage_rate > .015
Variable | Obs Mean Std. Dev. Min Max

marriage_r-~e 1 .1428282 . .1428282 .1428282

divorce_rate 1 .0172918 . .0172918 .0172918

You may not use the word and in place of the symbol “&” to join conditions. To select observations
that meet one condition or another, use the “|” symbol. For instance, summarize marriage_rate
divorce_rate if region=="West" | marriage_rate>.015 summarizes all observations for
which region is West or marriage_rate is greater than 0.015.

N

> Example 4

if may be combined with by. Typing by region: summarize marriage_rate divorce_rate
if marriage_rate>.015 produces a set of tables, one for each region, reflecting summary statistics
on marriage_rate and divorce_rate among observations for which marriage_rate exceeds
0.015:

. by region: summarize marriage_rate divorce_rate if marriage_rate > .015

-> region = N Cntrl

Variable Obs Mean Std. Dev. Min Max
marriage_r~e 0
divorce_rate 0
-> region = NE

Variable Obs Mean Std. Dev. Min Max
marriage_r~e 0
divorce_rate 0
-> region = South

Variable Obs Mean Std. Dev. Min Max
marriage_r~e 2 .0163219 .0013414 .0153734 .0172704
divorce_rate 2 .0061813 .0025831 .0043548 .0080078
-> region = West

Variable Obs Mean Std. Dev. Min Max
marriage_r~e 1 .1428282 . .1428282 .1428282
divorce_rate 1 .0172918 . .0172918 .0172918
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The results indicate that there are no states in the Northeast and North Central regions for which
marriage_rate exceeds 0.015, whereas there are two such states in the South and one state in the
West.

d

11.1.4 in range

The in range qualifier restricts the scope of the command to a specific observation range. A range
specification takes the form #; [/#2}, where #, and #, are positive or negative integers. Negative
integers are understood to mean “from the end of the data”, with —1 referring to the last observation.
The implied first observation must be less than or equal to the implied last observation.

The first and last observations in the dataset may be denoted by f and 1 (lowercase letter),
respectively. F is allowed as a synonym for £, and L is allowed as a synonym for 1. A range specifies
absolute observation numbers within a dataset. As a result, the in qualifier may not be used when
the command is preceded by the by varlist: prefix; see [U] 11.5 by varlist: construct.

> Example 5

Typing summarize marriage_rate divorce_rate in 5/25 produces a table based on the
values of marriage_rate and divorce_rate in observations 5-25:

. summarize marriage_rate divorce_rate in 5/25

Variable | Obs Mean Std. Dev. Min Max
marriage_r-~e 21 .0096285 .0016892 .0074654 .01293
divorce_rate 21 .0046914 .0012262 .0029436 .0072868

This is, admittedly, a rather odd thing to want to do. It would not be odd, however, if we substituted
list for summarize. If we wanted to see the states with the 10 lowest values of marriage_rate,
we could type sort marriage_rate followed by 1ist marriage_rate in 1/10.

Typing summarize marriage_rate divorce_rate in f/1 is equivalent to typing summarize
marriage_rate divorce_rate—all observations are summarized.

4
> Example 6
Typing summarize marriage_rate divorce_rate in 5/25 if region == "South" produces
a table based on the values of the two variables in observations 5-25 for which the value of region
is South:
. summarize marriage_rate divorce_rate in 5/25 if region == "South"
Variable | Obs Mean Std. Dev. Min Max
marriage_r~e 4 .0105224 .0027555 .0074654 .01293
divorce_rate 4 .005581 .0012977 .0038917 .0068035

The ordering of the in and if qualifiers is not significant. The command could also have been
specified as summarize marriage_rate divorce_rate if region == "South" in 5/25.

N
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> Example 7

Negative in ranges can be useful with sort. For instance, we have data on automobiles and wish
to list the five with the highest mileage ratings:
. use http://www.stata-press.com/data/r13/auto
(1978 Automobile Data)
. sort mpg
. list make mpg in -5/1

make mpg

70. Toyota Corolla 31

1. Plym. Champ 34
72. Subaru 35
73. Datsun 210 35
74. VW Diesel 41
N
11.1.5 =exp

=exp specifies the value to be assigned to a variable and is most often used with generate and
replace. See [U] 13 Functions and expressions for details on expressions and [D] generate for
details on the generate and replace commands.

> Example 8
Expression Meaning
generate newvar=oldvar+2 creates a new variable named newvar
equal to oldvar+-2
replace oldvar=oldvar+2 changes the contents of the existing variable
oldvar
egen newvar=rank(oldvar) creates newvar containing the ranks of

oldvar (see [D] egen)

11.1.6 weight

weight indicates the weight to be attached to each observation. The syntax of weight is

[weightword=exp]

where you actually type the square brackets and where weightword is one of

weightword Meaning

weight default treatment of weights
fweight or frequency frequency weights
pweight sampling weights

aweight or cellsize analytic weights

iweight importance weights

The underlining indicates the minimum acceptable abbreviation. Thus weight may be abbreviated w
or we, etc.
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> Example 9

Before explaining what the different types of weights mean, let’s obtain the population-weighted
mean of a variable called median_age from data containing observations on all 50 states of the
United States. The dataset also contains a variable named pop, which is the total population of each
state.

. use http://www.stata-press.com/data/r13/censusi2
(1980 Census data by state)
. summarize median_age [weight=pop]
(analytic weights assumed)
Variable | Obs Weight Mean  Std. Dev. Min Max

median_age | 50 225907472 30.11047 1.66933 24.2 34.7

In addition to telling us that our dataset contains 50 observations, Stata informs us that the sum of
the weight is 225,907,472, which was the number of people living in the United States as of the
1980 census. The weighted mean is 30.11. We were also informed that Stata assumed that we wanted
“analytic” weights. 4

weight is each command’s idea of what the “natural” weights are and is one of fweight, pweight,
aweight, or iweight. When you specify the vague weight, the command informs you which kind
it assumes. Not every command supports every kind of weight. A note below the syntax diagram for
a command will tell you which weights the command supports.

Stata understands four kinds of weights:

1. fweights, or frequency weights, indicate duplicated observations. fweights are always integers.
If the fweight associated with an observation is 5, that means there are really 5 such observations,
each identical.

2. pweights, or sampling weights, denote the inverse of the probability that this observation
is included in the sample because of the sampling design. A pweight of 100, for instance,
indicates that this observation is representative of 100 subjects in the underlying population.
The scale of these weights does not matter in terms of estimated parameters and standard
errors, except when estimating totals and computing finite-population corrections with the svy
commands; see [SVY] survey.

3. aweights, or analytic weights, are inversely proportional to the variance of an observation;
that is, the variance of the jth observation is assumed to be o2/ w;, where w; are the weights.
Typically, the observations represent averages, and the weights are the number of elements
that gave rise to the average. For most Stata commands, the recorded scale of aweights is
irrelevant; Stata internally rescales them to sum to /N, the number of observations in your data,
when it uses them.

4. iweights, or importance weights, indicate the relative “importance” of the observation. They
have no formal statistical definition; this is a catch-all category. Any command that supports
iweights will define how they are treated. They are usually intended for use by programmers
who want to produce a certain computation.

See [U] 20.23 Weighted estimation for a thorough discussion of weights and their meaning.

Q Technical note
When you do not specify a weight, the result is equivalent to specifying [fweight=1].
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11.1.7 options

Many commands take command-specific options. These are described along with each command
in the Reference manuals. Options are indicated by typing a comma at the end of the command,
followed by the options you want to use.

> Example 10
Typing summarize marriage_rate produces a table of the mean, standard deviation, minimum,
and maximum of the variable marriage_rate:

. summarize marriage_rate
Variable | Obs Mean Std. Dev. Min Max

marriage_r~e | 50 .0133221 .0188122 .0074654 .1428282
The syntax diagram for summarize is
summarize [varlist] [lf] [m} [weight] [ , Options]

followed by the option table

options Description
Main
detail display additional statistics
meanonly suppress the display; calculate only the mean; programmer’s option
format use variable’s display format
separator (#) draw separator line after every # variables; default is separator(5)

Thus the options allowed by summarize are detail or meanonly, format, and separator().
The shortest allowed abbreviations for these options are d for detail, mean for meanonly, £ for
format, and sep() for separator(); see [U] 11.2 Abbreviation rules.

Typing summarize marriage_rate, detail produces a table that also includes selected per-
centiles, the four largest and four smallest values, the skewness, and the kurtosis.

. summarize marriage_rate, detail

marriage_rate

Percentiles Smallest

1% .0074654 .0074654

5% .0078956 .0075757
10% .0080043 .0078956 Obs 50
25% .0089399 .0079079 Sum of Wgt. 50
50% .0105669 Mean .0133221
Largest Std. Dev. .0188122

5% .0122899 .0146266
90% .0137832 .0153734 Variance .0003539
95% .0153734 .0172704 Skewness 6.718494
99% .1428282 .1428282 Kurtosis 46.77306

N

Some commands have options that are required. For instance, the ranksum command requires
the by (groupvar) option, which identifies the grouping variable. A groupvar is a specific kind of
varname. It identifies to which group each observation belongs.
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Q Technical note

Once you have typed the varlist for the command, you can place options anywhere in the command.
You can type summarize marriage_rate divorce_rate if region=="West", detail, or you
can type summarize marriage_rate divorce_rate, detail, if region=="West". You use a
second comma to indicate a return to the command line as opposed to the option list. Leaving out
the comma after the word detail would cause an error because Stata would attempt to interpret the
phrase if region=="West" as an option rather than as part of the command.

You may not type an option in the middle of a varlist. Typing summarize marriage_rate,
detail, divorce_rate will result in an error.

Options need not be specified contiguously. You may type summarize marriage_rate di-
vorce_rate, detail, if region=="South", noformat. Both detail and noformat are op-
tions.

a

Q Technical note

Most options are toggles—they indicate that something either is or is not to be done. Sometimes
it is difficult to remember which is the default. The following rule applies to all options: if option
is an option, then nooption is an option as well, and vice versa. Thus if we could not remember
whether detail or nodetail were the default for summarize but we knew that we did not want
the detail, we could type summarize, nodetail. Typing the nodetail option is unnecessary, but
Stata will not complain.

Some options take arguments. The Stata kdensity command has an n(#) option that indicates
the number of points at which the density estimate is to be evaluated. When an option takes an
argument, the argument is enclosed in parentheses.

Some options take more than one argument. In such cases, arguments should be separated from
one another by commas. For instance, you might see in a syntax diagram

saving (filename [ , replace ] )

Here replace is the (optional) second argument. Lists, such as lists of variables (varlists) and lists
of numbers (numlists), are considered to be one argument. If a syntax diagram reported

powers (numlist)

the list of numbers would be one argument, so the elements would not be separated by commas. You
would type, for instance, powers(1 2 3 4). In fact, Stata will tolerate commas here, so you could
type powers(1,2,3,4).

Some options take string arguments. regress has an eform() option that works this way—for
instance, eform("Exp Beta"). To play it safe, you should type the quotes surrounding the string,
although it is not required. If you do not type the quotes, any sequence of two or more consecutive
blanks will be interpreted as one blank. Thus eform(Exp beta) would be interpreted the same as
eform(Exp beta).

a
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11.1.8 numlist

A numlist is a list of numbers. Stata allows certain shorthands to indicate ranges:

Numlist Meaning

2 just one number

123 three numbers

321 three numbers in reversed order
.5611.5 three different numbers

13-2.17 5.12 four numbers in jumbled order

1/3 three numbers: 1, 2, 3

3/1 the same three numbers in reverse order
5/8 four numbers: 5, 6, 7, 8

-8/-5 four numbers: —8, —7, —6, —5
-5/-8 four numbers: —5, —6, —7, —8
-1/2 four numbers: —1, 0, 1, 2
12to4d four numbers: 1, 2, 3, 4

43to1l four numbers: 4, 3, 2, 1

10 15 to 30 five numbers: 10, 15, 20, 25, 30
12:4 same as 1 2 to 4

4 3:1 same as 4 3 to 1

10 15:30 same as 10 15 to 30

1(1)3 three numbers: 1, 2, 3

1(2)9 five numbers: 1, 3, 5, 7, 9

1(2)10 the same five numbers, 1, 3, 5, 7, 9
9(-2)1 five numbers: 9, 7, 5, 3, and 1
-1(.5)2.5 the numbers —1, —.5, 0, .5, 1, 1.5, 2, 2.5
1[113 same as 1(1)3

1[2]19 same as 1(2)9

1[2]10 same as 1(2)10

9[-2]1 same as 9(—2)1

-1[.5]2.5 same as —1(.5)2.5

12 3/58(2)12 eight numbers: 1, 2, 3, 4, 5, 8, 10, 12
1,2,3/5,8(2)12 the same eight numbers

123/568 10 to 12 the same eight numbers
1,2,3/5,8,10 to 12 the same eight numbers
123/5810:12 the same eight numbers

poisson’s constraints() option has syntax constraints (numlist). Thus you could type con-
straints(2 4 to 8), constraints(2(2)8), etc.

11.1.9 datelist

A datelist is a list of dates or times and is often used with graph options when the variable being
graphed has a date format. For a description of how dates and times are stored and manipulated
in Stata, see [U] 24 Working with dates and times. Calendar dates, also known as %td dates, are
recorded in Stata as the number of days since 01jan1960, so 0 means 01jan1960, 1 means 02jan1960,
and 16,541 means 15apr2005. Similarly, —1 means 31dec1959, —2 means 30dec1959, and —16,541
means 18sep1914. In such a case, a datelist is either a list of dates, as in

15apr1973 17apr1973 20apr1973 23apr1973

or it is a first and last date with an increment between, as in

17apr1973(3)23apr1973
or it is a combination:

15apr1973 17apr1973(3)23apr1973
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Dates specified with spaces, slashes, or commas must be bound in parentheses, as in
(15 apr 1973) (april 17, 1973) (3) (april 23, 1973)

Evenly spaced calendar dates are not especially useful, but with other time units, even spacing
can be useful, such as

1999q1 (1) 2005q1

when %tq dates are being used. 1999q1(1)2005q1 means every quarter between 1999q1 and 2005q]1.
1999q1(4)2005q1 would mean every first quarter.

To interpret a datelist, Stata first looks at the format of the related variable and then uses the
corresponding date-to-numeric translation function. For instance, if the variable has a %td format,
the td() function is used to translate the date; if the variable has a %tq format, the tq() function
is used; and so on. See Conveniently typing SIF values in [D] datetime.

11.1.10 Prefix commands

Stata has a handful of commands that are used to prefix other Stata commands. by varlist:,
discussed in section [U] 11.1.2 by varlist:, is in fact an example of a prefix command. In that section,
we demonstrated by using

by region: summarize marriage_rate divorce_rate
and later,

by region, sort: summarize marriage_rate divorce_rate
and although we did not, we could also have demonstrated

by region, sort: summarize marriage_rate divorce_rate, detail
Each of the above runs the summarize command separately on the data for each region.

by itself follows standard Stata syntax:
by varlist], options]: ...

In by region, sort: summarize marriage_rate divorce_rate, detail, region is by’s varlist
and sort is by’s option, just as marriage_rate and divorce_rate are summarize’s varlist and
detail is summarize’s option.
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by is not the only prefix command, and the full list of such commands is

Prefix command

Description

by run command on subsets of data

statsby same as by, but collect statistics from each run
rolling run command on moving subsets and collect statistics
bootstrap run command on bootstrap samples

jackknife run command on jackknife subsets of data

permute run command on random permutations

simulate run command on manufactured data

svy run command and adjust results for survey sampling

mi estimate

run command on multiply imputed data and adjust results for multiple
imputation (MI)

nestreg run command with accumulated blocks of regressors, and
report nested model comparison tests
stepwise run command with stepwise variable inclusion/exclusion
xi run command after expanding factor variables and interactions; for most

commands, using factor variables is preferred to using xi (see
[U] 11.4.3 Factor variables)

fp run command with fractional polynomials of one regressor

mfp run command with multiple fractional polynomial regressors
capture run command and capture its return code

noisily run command and show the output

quietly run command and suppress the output

version run command under specified version

The last group—capture, noisily, quietly, and version—have to do with programming Stata
and, for historical reasons, capture, noisily, and quietly allow you to omit the colon, so one
programmer might code

quietly regress ...
and another
quietly: regress ...

All the other prefix commands require the colon. In addition to the corresponding reference manual
entries, you may want to consult Baum (2009) for a richer discussion of prefix commands.

11.2 Abbreviation rules

Stata allows abbreviations. In this manual, we usually avoid abbreviating commands, variable
names, and options to ensure readability:

. summarize myvar, detail

Experienced Stata users, on the other hand, tend to abbreviate the same command as

. sum myv, d

As a general rule, command, option, and variable names may be abbreviated to the shortest string of
characters that uniquely identifies them.
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This rule is violated if the command or option does something that cannot easily be undone; the
command must then be spelled out in its entirety.

Also, a few common commands and options are allowed to have even shorter abbreviations than
the general rule would allow.

The general rule is applied, without exception, to variable names.

11.2.1 Command abbreviation

The shortest allowed abbreviation for a command or option can be determined by looking at the
command’s syntax diagram. This minimal abbreviation is shown by underlining:

regress
rename
replace
rotate
run

If there is no underlining, no abbreviation is allowed. For example, replace may not be abbreviated,
the underlying reason being that replace changes the data.

regress can be abbreviated reg, regr, regre, or regres, or it can be spelled out in its entirety.

Sometimes short abbreviations are also allowed. Commands that begin with the letter d include
decode, describe, destring, dir, discard, display, do, and drop, which suggests that
the shortest allowable abbreviation for describe is desc. However, because describe is such a
commonly used command, you may abbreviate it with the single letter d. You may also abbreviate
the 1ist command with the single letter 1.

The other exception to the general abbreviation rule is that commands that alter or destroy data
must be spelled out completely. Two commands that begin with the letter d, discard and drop, are
destructive in the sense that, once you give one of these commands, there is no way to undo the
result. Therefore, both must be spelled out.

The final exceptions to the general rule are commands implemented as ado-files. Such commands
may not be abbreviated. Ado-file commands are external, and their names correspond to the names
of disk files.

11.2.2 Option abbreviation

Option abbreviation follows the same logic as command abbreviation: you determine the mini-
mum acceptable abbreviation by examining the command’s syntax diagram. The syntax diagram for
summarize reads, in part,

summarize ..., detail format

The detail option may be abbreviated d, de, det, ..., detail. Similarly, option format may be
abbreviated f, fo, ..., format.

The clear and replace options occur with many commands. The clear option indicates that
even though completing this command will result in the loss of all data in memory, and even though
the data in memory have changed since the data were last saved on disk, you want to continue. clear
must be spelled out, as in use newdata, clear.
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The replace option indicates that it is okay to save over an existing dataset. If you type save
mydata and the file mydata.dta already exists, you will receive the message “file mydata.dta already
exists”, and Stata will refuse to overwrite it. To allow Stata to overwrite the dataset, you would type
save mydata, replace. replace may not be abbreviated.

Q Technical note

replace is a stronger modifier than clear and is one you should think about before using. With

a mistaken clear, you can lose hours of work, but with a mistaken replace, you can lose days of
work.

a

11.2.3 Variable-name abbreviation

e Variable names may be abbreviated to the shortest string of characters that uniquely identifies them
given the data currently loaded in memory.

If your dataset contained four variables, state, mrgrate, dvcrate, and dthrate, you could
refer to the variable dvcrate as dvcrat, dvcra, dvcr, dvc, or dv. You might type list dv to
list the data on dvcrate. You could not refer to the variable dvcrate as d, however, because
that abbreviation does not distinguish dvcrate from dthrate. If you were to type 1ist d, Stata
would respond with the message “ambiguous abbreviation”. (If you wanted to refer to all variables
that started with the letter d, you could type 1ist dx*; see [U] 11.4 varlists.)

e The character ~ may be used to mean that “zero or more characters go here”. For instance, r~8
might refer to the variable rep78, or rep1978, or repair1978, or just r8. (The ~ character is
similar to the * character in [U] 11.4 varlists, except that it adds the restriction “and only one
variable matches this specification”.)

Above, we said that you could abbreviate variables. You could type dvcr to refer to dvcrate,
but, if there were more than one variable that started with the letters dvcr, you would receive an
error. Typing dvcr is the same as typing dvcr-.

11.2.4 Abbreviations for programmers

Stata has several useful commands and functions to assist programmers with abbreviating and
unabbreviating command names and variable names.

Command/function Description

unab expand and unabbreviate standard variable lists

tsunab expand and unabbreviate variable lists that may contain time-series
operators

fvunab expand and unabbreviate variable lists that may contain time-series
operators or factor variables

unabcmd unabbreviate command name

novarabbrev turn off variable abbreviation

varabbrev turn on variable abbreviation

set varabbrev set whether variable abbreviations are supported

abbrev(s,n) string function that abbreviates s to n characters

abbrev(s,n) Mata variant of above that allows s and n to be matrices
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11.3 Naming conventions

A name is a sequence of one to 32 letters (A—Z and a—=z), digits (0—9), and underscores (—).

Programmers: Local macro names can have no more than 31 characters in the name; see
[U] 18.3.1 Local macros.

Stata reserves the following names:

—all float -n —skip
_b if _N str#
byte in —pi strL
_coef int _pred using
_cons long _rc with
double

You may not use these reserved names for your variables.

The first character of a name must be a letter or an underscore. We recommend, however, that
you not begin your variable names with an underscore. All of Stata’s built-in variables begin with an
underscore, and we reserve the right to incorporate new _variables freely.

Stata respects case; that is, myvar, Myvar, and MYVAR are three distinct names.

All objects in Stata—not just variables—follow this naming convention.

11.4 varlists

A varlist is a list of variable names. The variable names in a varlist refer either exclusively to new
(not yet created) variables or exclusively to existing variables. A newvarlist always refers exclusively
to new (not yet created) variables. Similarly, a varname refers to one variable, either existing or not
yet created. A newvar always refers to one new variable.

Sometimes a command will refer to a varname in another way, such as “groupvar”. This is still
a varname. The different name for it is used to give you an extra hint about the purpose of that
variable. For example, a groupvar is the name of a variable that defines groups within your data.

11.4.1 Lists of existing variables

In lists of existing variable names, variable names may be repeated.

> Example 11

If you type 1ist state mrgrate dvcrate state, the variable state will be listed twice, once
in the leftmost column and again in the rightmost column of the list.

d

Existing variable names may be abbreviated as described in [U] 11.2 Abbreviation rules. You
may also use “*” to indicate that “zero or more characters go here”. For instance, if you suffix * to a
partial variable name (for example, stax), you are referring to all variable names that start with that
letter combination. If you prefix * to a letter combination (for example, *rate), you are referring to
all variables that end in that letter combination. If you put * in the middle (for example, m*rate),
you are referring to all variables that begin and end with the specified letters. You may put more than

one * in an abbreviation.
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> Example 12

If the variables poplt5, pop5tol7, and pop18p are in our dataset, we may type pop* as a
shorthand way to refer to all three variables. For instance, 1ist state popx* lists the variables
state, popltb, pop5tol7, and pop18p.

If we had a dataset with variables inc1990, inc1991, ..., inc1999 along with variables
incfarm1990, ..., incfarm1999; pop1990, ..., pop1999; and ms1990, ..., ms1999, then *1995
would be a shorthand way of referring to inc1995, incfarm1995, pop1995, and ms1995. We could
type, for instance, 1ist *1995.

In that same dataset, typing list i*95 would be a shorthand way of listing inc1995 and
incfarm1995.

Typing list i*f*95 would be a shorthand way of listing to incfarm1995.
d

~ is an alternative to *, and really, it means the same thing. The difference is that ~ indicates that
if more than one variable matches the specified pattern, Stata will complain rather than substituting
all the variables that match the specification.

> Example 13

In the previous example, we could have typed 1ist i~f~95 to list incfarm1995. If, however, our
dataset also included variable infant1995, then 1list i*f*95 would list both variables and 1list
i~£f~95 would complain that i~f~95 is an ambiguous abbreviation.

4

You may use 7 to specify that one character goes here. Remember, * means zero or more characters
go here, so 7* can be used to mean one or more characters goes here, ?7* can be used to mean two
or more characters go here, and so on.

> Example 14
In a dataset containing variables repl, rep2, ..., rep78, rep? would refer to repl, rep2, ...,
rep9, and rep?? would refer to rep10, repll, ..., rep78.

N

You may place a dash (-) between two variable names to specify all the variables stored between
the two listed variables, inclusive. You can determine storage order by using describe; it lists
variables in the order in which they are stored.

> Example 15

If the dataset contains the variables state, mrgrate, dvcrate, and dthrate, in that order, typing
list state-dvcrate is equivalent to typing list state mrgrate dvcrate. In both cases, three
variables are listed.

N
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11.4.2 Lists of new variables
In lists of new variables, no variable names may be repeated or abbreviated.

You may specify a dash (=) between two variable names that have the same letter prefix and that
end in numbers. This form of the dash notation indicates a range of variable names in ascending
numerical order.

For example, typing input v1-v4 is equivalent to typing input v1 v2 v3 v4. Typing infile
state v1-v3 ssn using rawdata is equivalent to typing infile state vl v2 v3 ssn using
rawdata.

You may specify the storage type before the variable name to force a storage type other than
the default. The numeric storage types are byte, int, long, float (the default), and double. The
string storage types are str# where # is replaced with an integer between 1 and 2045, inclusive,
representing the maximum length of the string. See [U] 12 Data.

For instance, the list varl str8 var2 var3 specifies that varl and var3 be given the default
storage type and that var2 be stored as a str8—a string whose maximum length is eight characters.

The list varl int var2 var3 specifies that var2 be stored as an int. You may use parentheses
to bind a list of variable names. The list varl int(var2 var3) specifies that both var2 and var3
be stored as ints. Similarly, the list varl str20(var2 var3) specifies that both var2 and var3
be stored as str20s. The different storage types are listed in [U] 12.2.2 Numeric storage types and
[U] 12.4 Strings.

> Example 16

Typing infile str2 state str10 region v1-v5 using mydata reads the state and region
strings from the file mydata.raw and stores them as str2 and stri10, respectively, along with the
variables v1 through v5, which are stored as the default storage type float (unless we have specified
a different default with the set type command).

Typing infile stri10(state region) v1-v5 using mydata would achieve almost the same
result, except that the state and region values recorded in the data would both be assigned to str10
variables. (We could then use the compress command to shorten the strings. See [D] compress; it
is well worth reading.)

N

Q Technical note

You may append a colon and a value label name to numeric variables. (See [U] 12.6 Dataset,
variable, and value labels for a description of value labels.) For instance, varl var2:myfmt specifies
that the variable var2 be associated with the value label stored under the name myfmt. This has the
same effect as typing the list varl var2 and then subsequently giving the command label values
var2 myfmt.

The advantage of specifying the value label association with the colon notation is that value labels
can then be assigned by the current command; see [D] input and [D] infile (free format).
a
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> Example 17

Typing infile int(state:stfmt region:regfmt) vi-v5 using mydata, automatic reads
the state and region data from the file mydata.raw and stores them as ints, along with the variables
v1 through v5, which are stored as the default storage type.

In our previous example, both state and region were strings, so how can strings be stored in a
numeric variable? See [U] 12.6 Dataset, variable, and value labels for the complete answer. The
colon notation specifies the name of the value label, and the automatic option tells Stata to assign
unique numeric codes to all character strings. The numeric code for state, which Stata will make up
on the fly, will be stored in the state variable. The mapping from numeric codes to words will be
stored in the value label named stfmt. Similarly, regions will be assigned numeric codes, which are
stored in region, and the mapping will be stored in regfmt.

If we were to 1list the data, the state and region variables would look like strings. state,
for instance, would appear to contain things like AL, CA, and WA, but actually it would contain only
numbers like 1, 2, 3, and 4.

d

11.4.3 Factor variables

Factor variables are extensions of varlists of existing variables. When a command allows factor
variables, in addition to typing variable names from your data, you can type factor variables, which
might look like

i.varname

i.varname#i .varname
i.varname#i.varname#i.varname
i.varname##1i.varname

i.varname##i .varname##i.varname

Factor variables create indicator variables from categorical variables and are allowed with most
estimation and postestimation commands, along with a few other commands.

Consider a variable named group that takes on the values 1, 2, and 3. Stata command 1ist allows
factor variables, so we can see how factor variables are expanded by typing

. list group i.group in 1/5

1b. 2. 3.
group group group group

g WN e
WNN -
[eleNeNeoNe)
O = OO
= O O OO

There are no variables named 1b.group, 2.group, and 3.group in our data; there is only the
variable named group. When we type i.group, however, Stata acts as if the variables 1b.group,
2.group, and 3.group exist. 1b.group, 2.group, and 3.group are called virtual variables.
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Start at the right of the listing. 3.group is the virtual variable that equals 1 when group = 3,
and 0 otherwise. 2.group is the virtual variable that equals 1 when group = 2, and 0 otherwise.
1b.group is different. The b is a marker indicating base value. 1b.group is a virtual variable equal
to 0. If the i.group collection was included in a linear regression, virtual variable 1b.group would
drop out from the estimation because it does not vary, and thus the coefficients on 2.group and
3.group would measure the change from group = 1. Hence the term base value.

The categorical variable to which factor-variable operators are applied must contain nonnegative
integers.

Q Technical note

We said above that 3.group equals 1 when group = 3 and equals O otherwise. We should have
added that 3. group equals missing when group contains missing. To be precise, 3.group equals 1
when group = 3, equals system missing (.) when group > ., and equals 0 otherwise.

a

Q Technical note

We said above that when we typed i.group, Stata acts as if the variables 1b.group, 2.group,
and 3.group exist, and that might suggest that the act of typing i.group somehow created the
virtual variables. That is not true; the virtual variables always exist.

In fact, i.group is an abbreviation for 1b.group, 2.group, and 3.group. In any command that
allows factor variables, you can specify virtual variables. Thus the listing above could equally well
have been produced by typing

. list group 1b.group 2.group 3.group in 1/5

#.varname is defined as equal to 1 when varname = #, equal to system missing (.) when
varname > ., and equal to O otherwise. Thus 4.group is defined even when group takes on only
the values 1, 2, and 3. 4.group would be equal to O in all observations. Referring to 4.group would
not produce an error such as “virtual variable not found”.

a

11.4.3.1 Factor-variable operators

i.group is called a factor variable, although more correctly, we should say that group is a categorical
variable to which factor-variable operators have been applied. There are five factor-variable operators:

Operator Description

i. unary operator to specify indicators

c. unary operator to treat as continuous

0. unary operator to omit a variable or indicator
# binary operator to specify interactions

## binary operator to specify full-factorial interactions

When you type i.group, it forms the indicators for the unique values of group. We will usually
say this more briefly as i.group forms indicators for the levels of group, and sometimes we will
abbreviate the statement even more and say i.group forms indicators for group.
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The c. operator means continuous. We will get to that below.

The o. operator specifies that a continuous variable or an indicator for a level of a categorical
variable should be omitted. For example, o.age means that the continuous variable age should be
omitted, and o2.group means that the indicator for group = 2 should be omitted.

# and ##, pronounced cross and factorial cross, are operators for use with pairs of variables.
i.group#i.sex means to form indicators for each combination of the levels of group and sex.
group#sex means the same thing, which is to say that use of # implies the i. prefix.

groupic.age (or i.groupic.age) means the interaction of the levels of group with the continuous
variable age. This amounts to forming i.group and then multiplying each level by age. We
already know that i.group expands to the virtual variables 1b.group, 2.group, and 3.group,
so groupic.age results in the collection of variables equal to 1b.group*age, 2.group*age, and
3.group*age. 1b.group*age will just be zero because 1b.group is zero. 2.group*age will be
age when group = 2, and O otherwise. 3.group*age will be age when group = 3, and 0 otherwise.
In a linear regression of y on age and group#c.age, 1b.group*age will be omitted, 2. group*age
will measure the change in the age coefficient for group = 2 relative to the base group, and
3.group*age will measure the change for group = 3 relative to the base.

Here are some more examples of use of the operators:

Factor specification Result

i.group

i.group#i.sex

group#sex

group#sex#arm

group##sex

group##sex##arm
sex#c.age
sex##c.age

c.age

c.age#fc.age

c.age#c.age#c.age

indicators for levels of group

indicators for each combination of levels of group and sex,
a two-way interaction

same as i.group#i.sex

indicators for each combination of levels of group, sex, and arm,
a three-way interaction

same as i.group i.sex group#sex

same as i.group i.sex i.arm group#sex group#arm sex#arm
group#sex#arm

two variables—age for males and O elsewhere, and age for females
and O elsewhere; if age is also in the model, one of the two virtual
variables will be treated as a base

same as i.sex age sex#c.age
same as age
age squared

age cubed

Several factor-variable terms are often specified in the same varlist, such as

. regress y 1i.sex i.group sex#group age sex#c.age

or, equivalently,

. regress y sex##igroup sex##c.age
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11.4.3.2 Base levels

When we typed i.group, group = 1 became the base level. When we do not specify otherwise,
the smallest level becomes the base level.

You can specify the base level of a factor variable by using the ib. operator. The syntax is

Base operator® Description

ib#. use # as base, # = value of variable
ib (##) . use the #th ordered value as base
ib(first). use smallest value as base (default)
ib(last). use largest value as base

ib(freq) . use most frequent value as base
ibn. no base level

aThe i may be omitted. For instance, you can type ib2.group or b2.group.
bFor example, ib(#2) . means to use the second value as the base.

Thus, if you want to use group = 3 as the base, you can type ib3.group. You can type

. regress y 1i.sex ib3.group sex#ib3.group age sex#c.age

or you can type

. regress y 1i.sex ib3.group sex#group age sex#c.age

That is, you only have to set the base once. If you specify the base level more than once, it must be
the same base level. You will get an error if you attempt to change base levels in midsentence.

If you type ib3.group, the virtual variables become 1.group, 2.group, and b3.group.

Were you to type ib(freq) .group, the virtual variables might be bl.group, 2.group, and
3.group; 1.group, b2.group, and 3.group; or 1.group, 2.group, and b3.group, depending on
the most frequent group in the data.

11.4.3.3 Setting base levels permanently

You can permanently set the base level by using the fvset command; see [R] fvset. For example,

. fvset base 3 group

sets the base for group to be 3. The setting is recorded in the data, and if the dataset is resaved, the
base level will be remembered in future sessions.

If you want to set the base group back to the default, type

. fvset base default group
If you want to set the base levels for a group of variables to be the largest value, you can type
. fvset base last group sex arm

See [R] fvset for details.

Base levels can be temporarily overridden by using the ib. operator regardless of whether they
are set explicitly.
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11.4.3.4 Selecting levels

Typing i.group specifies virtual variables bl.group, 2.group, and 3.group. Regardless of
whether you type i.group, you can access those virtual variables. You can, for instance, use them
in expressions and if statements:

. list if 3.group
(output omitted )

. generate over_age = cond(3.group, age-21, 0)

Although throughout this section we have been typing #.group such as 3.group as if it is
somehow distinctly different from i.group, the complete, formal syntax is i3.group. You are
allowed to omit the i. The point is that i3.group is just a special case of i.group; i3.group
specifies an indicator for the third level of group, and i.group specifies the indicators for all the
levels of group. Anyway, the above commands could be typed as

. list if i3.group
(output omitted )

. generate over_age = cond(i3.group, age-21, 0)

Similarly, the virtual variables b1.group, 2. group, and 3. group more formally would be referred
to as ibl.group, i2.group, and i3.group. You are allowed to omit the leading i whenever what
appears after is a number or a b followed by a base specification.

You can select a range of levels—a range of virtual variables—by using the i (numlist) .varname.
This can be useful when specifying the model to be fit using estimation commands. You may not
omit the i when specifying a numlist.

Examples Description
i2.cat single indicator for cat = 2
2.cat same as i2.cat
i(2 34).cat three indicators, cat = 2, cat = 3, and cat = 4; same as
i2.cat i3.cat i4.cat
i(2/4) .cat same as i(2 3 4) .cat
2.cat#l.sex a single indicator that is 1 when cat = 2 and sex = 1 and is O otherwise
i2.cat#il.sex same as 2.cat#l.sex

Rather than selecting the levels that should be included, you can specify the levels that should
be omitted by using the o. operator. When you use io (numlist) .varname in a command, indicators
for the levels of varname other than those specified in numlist are included. When omitted levels are

specified with the o. operator, the i. operator is implied, and the remaining indicators for the levels
of varname will be included.

Examples Description

io2.cat indicators for levels of cat, omitting the indicator for cat =2

o2.cat same as io2.cat

io(2 3 4).cat indicators for levels of cat, omitting three indicators, cat = 2, cat = 3, and
cat =4

0(2 34).cat same as io(2 3 4) .cat

0(2/4) .cat same as io(2 3 4) .cat

02.cat#ol.sex indicators for each combination of the levels of cat and sex, omitting the

indicator for cat = 2 and sex =1




96 [U] 11 Language syntax

11.4.3.5 Applying operators to a group of variables

Factor-variable operators may be applied to groups of variables by using parentheses. You may
type, for instance,

i.(group sex arm)
to mean i.group i.sex i.arm.

In the examples that follow, variables group, sex, arm, and cat are categorical, and variables
age, wt, and bp are continuous:

Examples Expansion

i.(group sex arm) i.group i.sex i.arm

group# (sex arm cat) group#sex group#arm group#cat

group## (sex arm cat) i.group i.sex i.arm i.cat group#sex group#arm
group#cat

group#(c.age c.wt c.bp) group#c.age group#c.wt group#c.bp

groupt#c. (age wt bp) same as group#(c.age c.wt c.bp)

Parentheses can shorten what you type and make it more readable. For instance,
. regress y 1i.sex i.group sex#group age sex#c.age c.age#c.age sex#c.age#c.age
is easier to understand when written as

. regress y sex##(group c.age c.age#c.age)

11.4.3.6 Using factor variables with time-series operators

Factor-variable operators may be combined with the L. and F. time-series operators, so you
may specify lags and leads of factor variables in time-series applications. You could type iL.group
or Li.group; the order of the operators does not matter. You could type L.group#L.arm or
L.group#c.age.

Examples include

. regress y bl.sex##(i(2/4) .group cL.age cL.age#cL.age)
. regress y 2.arm#(sex#i(2/4)b3.group cL.age)

. regress y 2.arm##tcat## (sex##1i(2/4)b3.group cL.age#c.age) c.bp
> c.bp#c.bp c.bp#c.bp#c.bp sex##c.bp#c.age

11.4.3.7 Video examples

Introduction to factor variables in Stata, part 1: The basics
Introduction to factor variables in Stata, part 2: Interactions

Introduction to factor variables in Stata, part 3: More interactions


http://www.youtube.com/watch?v=Wa1Nd9epHmY
http://www.youtube.com/watch?v=f-tLLX8v11c
http://www.youtube.com/watch?v=9vR9n35aX5k
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11.4.4 Time-series varlists

Time-series varlists are a variation on varlists of existing variables. When a command allows a
time-series varlist, you may include time-series operators. For instance, L.gnp refers to the lagged
value of variable gnp. The time-series operators are

Operator Meaning

L. lag x1—1

L2. 2-period lag x;_o

F. lead x¢y1

F2. 2-period lead ;42

D. difference x; — x¢_1

D2. difference of difference xy — x4—1 — (T4—1 — Tr—2) = Tt — 2T4—1 + Tp—2
S. “seasonal” difference x; — ;1

S2. lag-2 (seasonal) difference x; — r¢_2

Time-series operators may be repeated and combined. L3.gnp refers to the third lag of variable
gnp. So do LLL.gnp, LL2.gnp, and L2L.gnp. LF.gnp is the same as gnp. DS12.gnp refers to the
one-period difference of the 12-period difference. LDS12.gnp refers to the same concept, lagged
once.

D1. = S1., but D2. # S2., D3. # S3., and so on. D2. refers to the difference of the difference.
S2. refers to the two-period difference. If you wanted the difference of the difference of the 12-period
difference of gnp, you would write D2S12. gnp.

Operators may be typed in uppercase or lowercase. Most users would type d2s12.gnp instead of
D2S12.gnp.

You may type operators however you wish; Stata internally converts operators to their canonical
form. If you typed 1d21s12d.gnp, Stata would present the operated variable as L2D3S12. gnp.

In addition to using operator#, Stata understands operator (numlist) to mean a set of operated
variables. For instance, typing L(1/3) .gnp in a varlist is the same as typing L.gnp L2.gnp L3.gnp.
The operators can also be applied to a list of variables by enclosing the variables in parentheses; for
example,

. use http://www.stata-press.com/data/r13/gxmpll
. list year L(1/3).(gnp cpi)

L. L2. L3. L. L2. L3.
year gnp gnp gnp cpi cpi cpi

1. 1989 . .
2. 1990  5837.9 . 124 .
3. 1991 6026.3  5837.9 . 130.7 124 .
4. 1992 6367.4 6026.3  5837.9 136.2 130.7 124
5. 1993 6689.3 6367.4 6026.3 140.3 136.2 130.7
6. 1994 7098.4 6689.3 6367.4 144.5 140.3 136.2
7. 1995  7433.4 7098.4 6689.3  148.2 144 .5 140.3
8. 1996 7851.9 7433.4 7098.4 152.4 148.2 144.5
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The parentheses notation may be used with any operator. Typing D(1/3) .gnp would return the
first through third differences.

The parentheses notation may be used in operator lists with multiple operators, such as
L(0/3)D2S12.gnp.

Operator lists may include up to one set of parentheses, which may enclose a numlist; see
[U] 11.1.8 numlist.

The time-series operators L. and F. may be combined with factor variables. If we want to lag
the indicator variables for the levels of the factor variable region, we would type iL.region. We
could also say that we are specifying the level indicator variables for the lag of the region variables.
They are equivalent statements.

The numlists and parentheses notation from both factor varlists and time-series oper-
ators may be combined. For example, iL(1/3).region specifies the first three lags of
the level indicators for region. If region has four levels, this is equivalent to typ-
ing ilLl.region i2L1.region i3L1l.region i4Ll.region ilL2.region i2L2.region
i3L2.region i4L2.region ilL3.region i2L3.region i3L3.region i4L3.region. Pushing
the notation further, i (1/2)L(1/3) . (region education) specifies the first three lags of the level
1 and level 2 indicator variables for both the region and education variables.

Q Technical note

The D. and S. time-series operators may not be combined with factor variables because such
combinations could have two meanings. iD.a could be the level indicators for the difference of the
variable a from its prior period, or it could be the level indicators differenced between the two periods.
These are generally not the same values, nor even the same number of indicators. Moreover, they are
rarely interesting.

a

Before you can use time-series operators in varlists, you must set the time variable by using the
tsset command:

. list l.gnp
time variable not set
r(111);

. tsset time
(output omitted )

. list 1l.gnp
(output omitted )

See [TS] tsset. The time variable must take on integer values. Also, the data must be sorted on the
time variable. tsset handles this, but later you might encounter

. list 1.mpg
not sorted
r(5);

Then type sort time or type tsset to reestablish the order.

The time-series operators respect the time variable. L2 . gnp refers to gnp;_o, regardless of missing
observations in the dataset. In the following dataset, the observation for 1992 is missing:
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. use http://www.stata-press.com/data/r13/gxmpl2
. list year gnp 12.gnp, separator(0)

L2.
year gnp gnp
1. 1989 5837.9
2. 1990 6026.3 .
3. 1991 6367 .4 5837.9
4. 1993 7098.4 6367.4 « note, filled in correctly
5. 1994 7433.4 .
6. 1995 7851.9 7098.4

Operated variables may be used in expressions:

. generate gnplag2 = 12.gnp
(3 missing values generated)

Stata also understands cross-sectional time-series data. If you have cross sections of time series,
you indicate this when you tsset the data:

. tsset country year

See [TS] tsset. In fact, you can type that, or you can type
. xtset country year
xtset is how you set panel data just as tsset is how you set time-series data and here the two

commands do the same thing. Some panel datasets are not cross-sectional time series, however, in
that the second variable is not time, so xtset also allows

. xtset country

See [XT] xtset.

11.5 by varlist: construct

by varlist: command

The by prefix causes command to be repeated for each unique set of values of the variables in the
varlist. varlist may contain numeric, string, or a mixture of numeric and string variables. (varlist may
not contain time-series operators.)

by is an optional prefix to perform a Stata command separately for each group of observations
where the values of the variables in the varlist are the same.

During each iteration, the values of the system variables _n and _N are set in relation to the first
observation in the by-group; see [U] 13.7 Explicit subscripting. The in range qualifier cannot be
used with by varlist: because ranges specify absolute rather than relative observation numbers.

Q Technical note

The inability to combine in and by is not really a constraint because if provides all the functionality
of in and a bit more. If you wanted to perform command for the first three observations in each of
the by-groups, you could type

. by varlist: command if _n<=3
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The results of command would be the same as if you had formed separate datasets for each group
of observations, saved them, used each separately, and issued command.

> Example 18

We provide some examples using by in [U] 11.1.2 by varlist: above. We demonstrate the effect
of by on _n, _N, and explicit subscripting in [U] 13.7 Explicit subscripting.

by requires that the data first be sorted. For instance, if we had data on the average January and
July temperatures in degrees Fahrenheit for 420 cities located in the Northeast and West and wanted
to obtain the averages, by region, across those cities, we might type

. use http://www.stata-press.com/data/r13/citytemp3, clear
(City Temperature Data)

. by region: summarize tempjan tempjuly
not sorted
r(5);

Stata refused to honor our request because the data are not sorted by region. We must either sort
the data by region first (see [D] sort) or specify by’s sort option (which has the same effect):

. by region, sort: summarize tempjan tempjuly

-> region = NE

Variable Obs Mean Std. Dev. Min Max
tempjan 164 27.88537 3.543096 16.6 31.8
tempjuly 164 73.35 2.361203 66.5 76.8

-> region = N Cntrl

Variable Obs Mean Std. Dev. Min Max
tempjan 284 21.69437 5.725392 2.2 32.6
tempjuly 284 73.46725 3.103187 64.5 81.4

-> region = South

Variable Obs Mean Std. Dev. Min Max
tempjan 250 46.1456 10.38646 28.9 68
tempjuly 250 80.9896 2.97537 71 87.4

-> region = West

Variable Obs Mean Std. Dev. Min Max
tempjan 256 46.22539 11.25412 13 72.6
tempjuly 256 72.10859 6.483131 58.1 93.6
N
> Example 19

Using the same data as in the example above, we estimate regressions, by region, of average January
temperature on average July temperature. Both temperatures are specified in degrees Fahrenheit.
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. by region: regress tempjan tempjuly

-> region = NE

Source SS df MS Number of obs = 164
F(C 1, 162) = 479.82
Model 1529.74026 1 1529.74026 Prob > F = 0.0000
Residual 516.484453 162 3.18817564 R-squared = 0.7476
Adj R-squared = 0.7460
Total 2046.22471 163 12.5535258 Root MSE = 1.7855
tempjan Coef. Std. Err. t P>t [95% Conf. Intervall
tempjuly 1.297424 .0592303 21.90 0.000 1.180461 1.414387
_cons -67.28066 4.346781 -15.48 0.000 -75.86431 -58.697
-> region = N Cntrl
Source SS df MS Number of obs = 284
FC 1, 282) = 115.89
Model 2701.97917 1 2701.97917 Prob > F = 0.0000
Residual 6574.79175 282 23.3148644 R-squared = 0.2913
Adj R-squared = 0.2887
Total 9276.77092 283 32.7801093 Root MSE = 4.8285
tempjan Coef.  Std. Err. t P>|t] [95% Conf. Intervall
tempjuly .9957259 .0924944 10.77  0.000 .8136589 1.177793
_cons -51.45888 6.801344 -7.57 0.000 -64.84673  -38.07103
-> region = South
Source SsS df MS Number of obs = 250
F(C 1, 248) = 95.17
Model 7449.51623 1 7449.51623 Prob > F = 0.0000
Residual 19412.2231 248 78.2750933 R-squared = 0.2773
Adj R-squared = 0.2744
Total 26861.7394 249 107.878471 Root MSE = 8.8473
tempjan Coef. Std. Err. t P>t [95% Conf. Intervall
tempjuly 1.83833 .1884392 9.76  0.000 1.467185 2.209475
_cons -102.74 15.27187 -6.73  0.000 -132.8191  -72.66089
-> region = West
Source SS df MS Number of obs = 256
FC 1, 254) = 2.84
Model 357.161728 1 357.161728 Prob > F = 0.0932
Residual 31939.9031 254  125.74765 R-squared = 0.0111
Adj R-squared = 0.0072
Total 32297.0648 255 126.655156 Root MSE = 11.214
tempjan Coef.  Std. Err. t P>|t] [95% Conf. Intervall
tempjuly .1825482 .1083166 1.69 0.093 -.0307648 .3958613
_cons 33.0621 7.84194 4.22 0.000 17.61859 48.5056
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The regressions show that a 1-degree increase in the average July temperature in the Northeast
corresponds to a 1.3-degree increase in the average January temperature. In the West, however, it
corresponds to a 0.18-degree increase, which is only marginally significant.

4

Q Technical note
by has a second syntax that is especially useful when you want to play it safe:

by varlist; (varlista) : command

This says that Stata is to verify that the data are sorted by varlist; varlisto and then, assuming that
is true, perform command by varlist,. For instance,

. by subject (time): gen finalval = val[_N]

By typing this, we want to create new variable finalval, which contains, in each observation, the
final observed value of val for each subject in the data. The final value will be the last value if,
within subject, the data are sorted by time. The above command verifies that the data are sorted by
subject and time and then, if they are, performs

. by subject: gen finalval = val[_N]

If the data are not sorted properly, an error message will instead be issued. Of course, we could have
just typed

. by subject: gen finalval = val[_N]
after verifying for ourselves that the data were sorted properly, as long as we were careful to look.
by’s second syntax can be used with by’s sort option, so we can also type

. by subject (time), sort: gen finalval = val[_N]

which is equivalent to

. sort subject time

. by subject: gen finalval = val[_N]
a

See Mitchell (2010, chap. 7) for numerous examples of processing groups using the by: construct.
Also see Cox (2002).
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11.6 Filenaming conventions

Some commands require that you specify a filename. Filenames are specified in the way natural

for your operating system:

Windows Unix Mac
mydata mydata mydata
mydata.dta mydata.dta mydata.dta

c:mydata.dta

"my data"

"my data.dta"
myproj\mydata

"my project\my data"
C:\analysis\data\mydata
"C:\my project\my data"
..\data\mydata

"..\my project\my data"

~friend/mydata.dta ~friend/mydata.dta

"my data"
"my data.dta"

"my data"

"my data.dta"
myproj/mydata

"my project/my data"

myproj/mydata

"my project/my data"
~/analysis/data/mydata
"~/my project/my data"

../data/mydata

"../my project/my data"

~/analysis/data/mydata
"~/my project/my data"

../data/mydata

"../my project/my data"

In most cases, where filename is a file that you are loading, filename may also be a URL. For
instance, we might specify use http://www.stata-press.com/data/r13/nlswork.

Usually (the exceptions being copy, dir, 1s, erase, rm, and type), Stata automatically provides
a file extension if you do not supply one. For instance, if you type use mydata, Stata assumes that
you mean use mydata.dta because .dta is the file extension Stata normally uses for data files.

Stata provides 22 default file extensions that are used by various commands:

.ado
.dct
.do
.dta
.dtasig
.gph
.grec
Lirf
.log
.mata
.mlib
.mmat
.mo
.raw
.smcl
.stbcal
.ster
.sthlp
.stpr
.stptrace
.stsem
.sum

automatically loaded do-files

text data dictionary

do-file

Stata-format dataset
datasignature file

graph

Graph Editor recording (text format)
impulse—response function datasets
log file in text format

Mata source code

Mata library

Mata matrix

Mata object file

text-format data

log file in SMCL format

business calendars

saved estimates

help file

project file

parameter-trace file; see [MI] mi ptrace
SEM builder file

checksum files to verify network transfers

You do not have to name your data files with the .dta extension—if you type an explicit file
extension, it will override the default. For instance, if your dataset was stored as myfile.dat, you
could type use myfile.dat. If your dataset was stored as simply myfile with no file extension,
you could type the period at the end of the filename to indicate that you are explicitly specifying the
null extension. You would type use myfile. to use this dataset.

All operating systems allow blanks in filenames, and so does Stata. However, if the filename
includes a blank, you must enclose the filename in double quotes. Typing

. save "my data"
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would create the file my data.dta. Typing

. save my data
would be an error.

Q Technical note

Stata also uses 12 other file extensions. These files are of interest only to advanced programmers
or are for Stata’s internal use. They are

.class class file for object-oriented programming; see [P] class
.dlg dialog resource file

.idlg dialog resource include file

.ihlp help include file

.key search’s keyword database file

.maint maintenance file (for Stata’s internal use only)

.mnu menu file (for Stata’s internal use only)

.pkg user-site package file

.plugin  compiled addition (DLL)
.scheme control file for a graph scheme
.style graph style file

.toc user-site description file

11.6.1 A special note for Mac users

Have you seen the notation myfolder/myfile before? This notation is called a path and describes
the location of a file or folder (also called a directory).

You do not have to use this notation if you do not like it. You could instead restrict yourself to using
files only in the current folder. If that turns out to be too restricting, Stata for Mac provides enough
menus and buttons that you can probably get by. You may, however, find the notation convenient. If
you do, here is the rest of the definition.

The character / is called a path delimiter and delimits folder names and filenames in a path. If
the path starts with no path delimiter, the path is relative to the current folder.

For example, the path myfolder/myfile refers to the file myfile in the folder myfolder, which
is contained in the current folder.

The characters .. refer to the folder containing the current folder. Thus ../myfile refers to
myfile in the folder containing the current folder, and ../nextdoor/myfile refers to myfile in
the folder nextdoor in the folder containing the current folder.

If a path starts with a path delimiter, the path is called an absolute path and describes a fixed
location of a file or folder name, regardless of what the current folder is. The leading / in an absolute
path refers to the root directory, which is the main hard drive from which the operating system is
booted. For example, the path /myfolder/myfile refers to the file myfile in the folder myfolder,
which is contained in the main hard drive.

The character ~ refers to the user’s home directory. Thus the path ~/myfolder/myfile refers to
myfile in the folder myfolder in the user’s home directory.
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11.6.2 A special note for Unix users

Stata understands ~ to mean your home directory. Stata understands this, even if you do not use
csh(1) as your shell.
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12.1 Data and datasets

Data form a rectangular table of numeric and string values in which each row is an observation on
all the variables and each column contains the observations on one variable. Variables are designated
by variable names. Observations are numbered sequentially from 1 to _N. The following example of
data contains the first five odd and first five even positive integers, along with a string variable:

odd even name

1. 1 2 Bill
2. 3 4  Mary
3. 5 6 Pat
4. 7 8 Roger
5. 9 10 Sean

107
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The observations are numbered 1 to 5, and the variables are named odd, even, and name. Observations
are referred to by number, and variables by name.

A dataset is data plus labelings, formats, notes, and characteristics.

All aspects of data and datasets are defined here. Long (2009) offers a long-time Stata user’s hard-
won advice on how to manage data in Stata to promote accurate, replicable research. Mitchell (2010)
provides many examples on data management in Stata.

12.2 Numbers

A number may contain a sign, an integer part, a decimal point, a fraction part, an e or E, and a
signed integer exponent. Numbers may not contain commas; for example, the number 1,024 must be
typed as 1024 (or 1024. or 1024.0). The following are examples of valid numbers:

5

-5

5.2

.5
5.2e+2
5.2e-2

Q Technical note

Stata also allows numbers to be represented in a hexadecimal/binary format, defined as
[+|]-]0.0][(zeros) | {X|x}-3££

or
[+|-]1. (hexdigit) [ (hexdigits) ]| {X|x}{+|-} (hexdigit) | (hexdigits)]

The lead digit is always O or 1; it is 0 only when the number being expressed is zero. A maximum of
13 digits to the right of the hexadecimal point are allowed. The power ranges from -3ff to +3ff. The
number is expressed in hexadecimal (base 16) digits; the number aX+b means a x 2. For instance,
1.0X+3 is 2% or 8. 1.8X+3 is 12 because 1.816 is 1 +8/16 = 1.5 in decimal and the number is thus
1.5x2° =15x8 = 12.

Stata can also display numbers using this format; see [U] 12.5.1 Numeric formats. For example,

.di 1.81x+2
6.015625

. di %21x 6.015625
+1.8100000000000X+002

This hexadecimal format is of special interest to numerical analysts.

12.2.1 Missing values

A number may also take on the special value missing, denoted by a period (.). You specify a
missing value anywhere that you may specify a number. Missing values differ from ordinary numbers
in one respect: any arithmetic operation on a missing value yields a missing value.
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3

In fact, there are 27 missing values in Stata: ‘.’, the one just discussed, as well as .a, .b, ...,
and .z, which are known as extended missing values. The missing value .’ is known as the default
or system missing value. In any case, some people use extended missing values to indicate why
a certain value is unknown—the question was not asked, the person refused to answer, etc. Other

people have no use for extended missing values and just use ‘.’

Stata’s default or system missing value will be returned when you perform an arithmetic operation
on missing values or when the arithmetic operation is not defined, such as division by zero, or the
logarithm of a nonpositive number.

. display 2/0

. list
a
1. .b
2.
3. .a
4. 3
5. 6

. generate x = a + 1
(3 missing values generated)

. list
a x
1. .b
2.
3. a .
4. 3 4
5. 6 7

Numeric missing values are represented by “large positive values”. The ordering is

all numbers < . < .a< .b< - < .2

Thus the expression

age > 60

is true if variable age is greater than 60 or is missing. Similarly,

gender! =0

is true if gender is not zero or is missing.

The way to exclude missing values is to ask whether the value is less than °.’

.”, and the way to
detect missing values is to ask whether the value is greater than or equal to ‘.’. For instance,

. list if age>60 & age<.

. generate agegt60 = 0 if age<=60

. replace agegt60 = 1 if age>60 & age<.
. generate agegt60 = (age>60) if age<.
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O Technical note
Before Stata 8, Stata only had one representation for missing values, the period (.).

To ensure that old programs and do-files continue to work properly, when version is set less

than 8, all missing values are treated as being the same. Thus . == .a == .b == .z, and so ‘exp==.’
and ‘exp!=.’ work just as they previously did.
a
> Example 1

We have data on the income of husbands and wives recorded in the variables hincome and
wincome, respectively. Typing the 1ist command, we see that your data contain

. use http://www.stata-press.com/data/r13/gxmpl3
. list

hincome wincome

1. 32000 0
2. 35000 34000
3. 47000 .b
4. .z 50000
5. .a

The values of wincome in the third and fifth observations are missing, as distinct from the value of
wincome in the first observation, which is known to be zero.

If we use the generate command to create a new variable, income, that is equal to the sum of
hincome and wincome, three missing values would be produced:
. generate income = hincome + wincome
(3 missing values generated)
. list

hincome wincome income

1. 32000 0 32000
2. 35000 34000 69000
3. 47000 .b

4. .z 50000

5. .a

generate produced a warning message that 3 missing values were created, and when we list the
data, we see that 47,000 plus missing yields missing.

4
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Q Technical note

Stata stores numeric missing values as the largest 27 numbers allowed by the particular storage
type; see [U] 12.2.2 Numeric storage types. There are two important implications. First, if you sort
on a variable that has missing values, the missing values will be placed last, and the sort order of
any missing values will follow the rule regarding the properties of missing values stated above.

. sort wincome

. list wincome

wincome

0
34000
50000

O WN e

The second implication concerns relational operators and missing values. Do not forget that a
missing value will be larger than any numeric value.

. list if wincome > 40000

hincome wincome income

.z 50000
.a .
5. 47000 .b

S ow

[}

Observations 4 and 5 are listed because and ‘.b’ are both missing and thus are greater than
40,000. Relational operators are discussed in detail in [U] 13.2.3 Relational operators.
a

> Example 2

In producing statistical output, Stata ignores observations with missing values. Continuing with the
example above, if we request summary statistics on hincome and wincome by using the summarize
command, we obtain

. summarize hincome wincome

Variable | Obs Mean Std. Dev. Min Max
hincome 3 38000 7937 .254 32000 47000
wincome 3 28000 25534.29 0 50000

Some commands discard the entire observation (known as casewise deletion) if one of the variables
in the observation is missing. If we use the correlate command to obtain the correlation between
hincome and wincome, for instance, we obtain

. correlate hincome wincome

(obs=2)
| hincome wincome
hincome 1.0000
wincome 1.0000 1.0000

The correlation coefficient is calculated over two observations.
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12.2.2 Numeric storage types

Numbers can be stored in one of five variable types: byte, int, long, float (the default), or
double. bytes are, naturally, stored in 1 byte. ints are stored in 2 bytes, longs and floats in 4
bytes, and doubles in 8 bytes. The table below shows the minimum and maximum values for each
storage type.

Closest to 0

Storage type Minimum Maximum  without being O Bytes
byte —127 100 +1 1
int —32,767 32,740 +1 2
long —2,147,483,647 2,147,483,620 +1 4

float —1.70141173319 x 1038 1.70141173319 x 10%® +10738 4
double —8.9884656743 x 1037 18.9884656743 x 103°7 +107323 8

Do not confuse the term integer, which is a characteristic of a number, with int, which is a storage
type. For instance, the number 5 is an integer, no matter how it is stored; thus, if you read that an
argument must be an integer, that does not mean that it must be stored as an int.

12.3 Dates and times

Stata has nine date, time, and date-and-time numeric encodings known collectively as %t variables
or values. They are

%tC calendar date and time, adjusted for leap seconds
htc calendar date and time, ignoring leap seconds
%td calendar date

tw week

%tm calendar month

%tq financial quarter

%th financial half-year
Wty calendar year
%tb business calendars

All except %ty and %tb are based on 0 = beginning of January 1960. %tc and %tC record the number
of milliseconds since then. %td records the number of days. The others record the numbers of weeks,
months, quarters, or half-years. %ty simply records the year, and %tb records a user-defined business
calendar format.

For a full discussion of working with dates and times, see [U] 24 Working with dates and times.
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12.4 Strings

This section describes the treatment of strings by Stata. The section is divided into the following
subsections:

[U] 12.4.1 Overview

[U] 12.4.2 Strings containing identifying data
[U] 12.4.3 Strings containing categorical data
[U] 12.4.4 Strings containing numeric data

[U] 12.4.5 String literals

[U] 12.4.6 str1-str2045 and str

[U] 12.4.7 strLL

[U] 12.4.8 strL variables and duplicated values
[U] 12.4.9 strL variables and binary strings
[U] 12.4.10 strL variables and files

[U] 12.4.11 String display formats

[U] 12.4.12 How to see the full contents of a strL or a str# variable
[U] 12.4.13 Notes for programmers

12.4.1 Overview

A string is a sequence of characters:

Samuel Smith
California
U.K.
Usually—but not always—strings are enclosed in double quotes:

"Samuel Smith"
"California"
IIU. K . n
Strings typed in quotes are called string literals.
Strings can be stored in Stata datasets in string variables.

. use http://www.stata-press.com/data/r13/auto, clear
(1978 Automobile Data)

. describe make

storage display value
variable name type format label variable label
make stri8  %-18s Make and Model
The string-variable storage types are stri, str2, ..., str2045, and strL.

Variable make is a str18 variable. It can contain strings of up to 18 characters long. The strings
are not all 18-characters long:

. list make in 1/2

make

e

AMC Concord
2. AMC Pacer
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str18 means that the variable cannot hold a string longer than 18 characters, and even that is an
unimportant detail, because Stata automatically promotes str# variables to be longer when required:

. replace make = "Mercedes Benz Gullwing" in 1
make was stril8 now str22
(1 real change made)

Stata provides a suite of string functions, such as strlen(), substr():

. generate len = strlen(make)
. generate str firstb5 = substr(make, 1,5)
. list make len firstb in 1/2

make len firstb
1. Mercedes Benz Gullwing 22 Merce
2. AMC Pacer 9 AMC P

Many Stata commands can use string variables:

. generate str brand = word(make, 1)
. tabulate brand

brand Freq. Percent Cum.
AMC 2 2.70 2.70
Audi 2 2.70 5.41
BMW 1 1.35 6.76
Buick 7 9.46 16.22
Cad. 3 4.05 20.27
Chev. 6 8.11 28.38
Datsun 4 5.41 33.78
Dodge 4 5.41 39.19
Fiat 1 1.35 40.54
Ford 2 2.70 43.24
Honda 2 2.70 45.95
Linc. 3 4.05 50.00
Mazda 1 1.35 51.35
Merc. 6 8.11 59.46
Mercedes 1 1.35 60.81
0lds 7 9.46 70.27
Peugeot 1 1.35 71.62
Plym. 5 6.76 78.38
Pont. 6 8.11 86.49
Renault 1 1.35 87.84
Subaru 1 1.35 89.19
Toyota 3 4.05 93.24
W 4 5.41 98.65
Volvo 1 1.35 100.00
Total 74 100.00

12.4.2 Strings containing identifying data

String variables often contain identifying information, such as the patient’s name or the name
of the city or state. Such strings are typically listed but are not used directly in statistical analysis,
although the data might be sorted on the string or datasets might be merged on the basis of one or
more string variables.
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12.4.3 Strings containing categorical data

Strings sometimes contain information to be used directly in analysis, such as the patient’s sex,
which might be coded “male” or “female”. Stata shows a decided preference for such information to be
numerically encoded and stored in numeric variables. Stata’s statistical routines treat string variables
as if every observation records a numeric missing value. Stata provides two commands for converting
string variables into numeric codes and back again: encode and decode; see [U] 23.2 Categorical
string variables and [U] 11.4.3 Factor variables.

12.4.4 Strings containing numeric data

If a string variable contains the character representation of a number, say, myvar contains “1”,
“1.2”, and “—5.2”, you can convert the string into a numeric value by using the real() function or
the destring command. For example,

. generate newvar = real(myvar)

If you want to convert a numeric variable to its string representation, you can use the string()
function or the tostring command. For example,

. generate as_str = string(numvar)

See [D] functions and [D] destring.

12.4.5 String literals

A string literal is a sequence of printable characters enclosed in quotes. The quotes are not
considered part of the string; they merely serve to delimit the beginning and end of the string. The
following are examples of string literals:

"Hello, world"
"String"
"string"

" string"
"string "

nn

Hx/y+3H

"1.2"

All the strings above are distinct. Capitalization matters. Leading and trailing spaces matter. Also
note that "1.2" is a string and not a number because it is enclosed in quotes.

There is never a circumstance in which a string cannot be delimited with quotes, but there are
instances where strings do not have to be delimited by quotes, such as when inputting data. In those
cases, nondelimited strings are stripped of their leading and trailing blanks. Delimited strings are
always accepted as is.

The list above could also be written as

‘"Hello, world"’
‘"String"’
l"stringu)
string"’
‘"String "oy

cnnoy

("X/y+3")
("1.2"7

n
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‘" and "’ are called compound double quotes.

Use of compound double quotes is how you solve the problem of typing strings that themselves
contain double quotes:

‘"Bob said, "Wow!" and promptly fainted."’

Strings in compound quotes can themselves contain compound quotes:

and "°"°

n

‘"The compound quotes characters are

12.4.6 str1-str2045 and str
str is something generate understands. We will get to that.
strl-str2045 are known as Stata’s fixed-length string storage types.

They are called that because, in your dataset, if a variable is stored as a str#, then each observation
requires # bytes to store the contents of the variable. You obviously do not want # to be longer than
necessary. Stata’s compress command will shorten str# strings that are unnecessarily long:

. use http://www.stata-press.com/data/ri3/auto, clear
(1978 Automobile Data)

. compress
mpg was int now byte
rep78 was int now byte
trunk was int now byte
turn was int now byte
make was strl8 now stril7
(370 bytes saved)

In [U] 12.4.1 Overview, you saw us use str with generate:

. generate str brand = word(make, 1)

str is something generate understands and tells generate to create a str# variable of the
minimum required length. Although you cannot tell from the output, generate created variable
brand as a str7.

Stata commands automatically promote str# storage types when necessary:

. replace make = "Mercedes Benz Gullwing" in 1
make was strl7 now str22
(1 real change made)

In fact, if the string to be stored is longer than 2,045 characters, generate and replace will even
promote to strL. strLs are the subject of the next section.

12.4.7 strL
strL variables can be 0 to 2-billion characters long.
The “L” stands for long, and strL is often pronounced sturl.
strL variables are not required to be longer than 2,045 characters.

str# variables can store strings of up to 2,045 characters, so strL and str# overlap. This overlap
is comparable to the overlap of the numeric types int and float. Any number that can be stored as
an int can be stored as a float, and similarly, any string that can be stored as a str# can be stored
as a strL. The reverse is not true. In addition, strL variables can hold binary strings, whereas str#
variables can only hold ASCII strings. Thus the analogy between str#/strL and int/float is exact.
There will be occasions when you will want to use strL variables in preference to str# variables,
just as there are occasions when you will want to use float variables in preference to int variables.
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strL variables work just like str# variables. Below we repeat what we did in [U] 12.4.1 Overview
using a strL variable:
. use http://www.stata-press.com/data/r13/auto, clear
(1978 Automobile Data)
. generate strL mymake = make
. describe mymake

storage display value
variable name type format label variable label
mymake strL %9s

. list mymake in 1/2

mymake

e

AMC Concord
2. AMC Pacer

We can replace strL values just as we can replace str# values:
. replace mymake = "Mercedes Benz Gullwing" in 1
(1 real change made)
We can use string functions with strL variables just as we can with str# variables:

. generate len = strlen(mymake)
. generate strL firstb = substr(mymake, 1, 5)
. list mymake len firstb5 in 1/2

mymake len firstb

1. Mercedes Benz Gullwing 22 Merce
2. AMC Pacer 9 AMC P

We can even make tabulations:

. generate strL brand = word(mymake, 1)
. tabulate brand

brand Freq. Percent Cum.
AMC 2 2.70 2.70
Audi 2 2.70 5.41
BMW 1 1.35 6.76
(output omitted )

Volvo 1 1.35 100.00

Total 74 100.00

The only limitations are the following:

1. You cannot use strL variables as the matching (key) variables in a match merge of two
datasets.

2. They cannot be used with £illin.

strL variables are stored differently from str# variables. str# variables require # bytes per
observation. strL variables require the actual number of bytes per string per observation, which
means strLs require even less memory than str# when the value being stored is less than #
characters long. Most strLs, however, have an 80-byte overhead per value stored (the exception is
strLs containing empty strings), in which case the overhead is 8 bytes.
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Whether strL or str# requires less memory for storing the same string values depends on the
string values themselves. compress can figure that out:

. compress
mpg was int now byte
rep78 was int now byte
trunk was int now byte
turn was int now byte
len was float now byte
make was strl8 now stril7
mymake was strL now str22
first5 was strL now strb
brand was strL now str8
(8,244 bytes saved)

compress decided to demote all of our strL variables to str# because that would save memory.

compress, however, never promotes a str# variable to a strL even if that would save memory.
It does not because, as we mentioned, there are a few things you can do with str# variables that
you cannot do with strL variables.

You can use recast to promote str# to strL:

. * variable make is currently stril7
. recast strL make

. describe make

storage display value
variable name type format label variable label
make strL %-9s Make and Model

. compress make
make was strL now stril7
(3,831 bytes saved)

12.4.8 strL variables and duplicated values
You would never know it, but when strL variables have the same values across observations,
Stata stores only one copy of each value. That is called coalescing and it saves memory.

Stata mostly coalesces strL variables automatically as they are created, but sometimes duplicate
values escape its attention. When you type compress, however, Stata looks for coalescing opportunities.
You might see

. compress X
x is strL now coalesced
(11,301,687 bytes saved)

We recommend that you type compress occasionally when strL variables are present.

12.4.9 strL variables and binary strings

strLs can hold binary strings. A binary string is, technically speaking, any string that contains
binary 0. Here is a silly example:
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. use http://www.stata-press.com/data/r13/auto, clear
(1978 Automobile Data)

. replace make = "a" + char(0) + "b" in 1
make was strl8 now strL
(1 real change made)

. list make in 1

make

1. | a\ob

list displays binary zeros as \O0.

If we did this same experiment with a str# variable and include the nopromote option to prevent
promotion, we would see something different:
. use http://www.stata-press.com/data/r13/auto, clear
(1978 Automobile Data)

. replace make = "a" + char(0) + "b" in 1, nopromote
(1 real change made)

. list make in 1

make

For str# strings, binary O indicates the end of the string, and thus the variable really does contain
“a” in the first observation.

str# variables cannot contain binary O; strL variables can.

compress knows this. If we typed compress in the first example, we would discover that compress
would not demote make to be a str#. It would not because one of the values could not be stored
in a str# variable. This is no different from compress not demoting a float variable to an int
because one of the values is 1.5.

12.4.10 strL variables and files

One of the neat things you can do with strLs is use them to hold the contents of files. We have
data on 10 patients. Some of the data have been coded from doctor notes, and those notes are stored
in notes_2217.xyz, notes_2221.xyz, notes_2222.xyz, and so on. We could do the following:

. generate strL notes = fileread("notes_2217.xyz") in 1

. replace notes = fileread("notes_2221.xyz") in 2

. replace notes = fileread("notes_2222.xyz") in 3

It would be even easier for us to type

. generate str fname = "notes_" + string(patid) + ".xyz"

. generate strL notes = fileread(fname)

The original files can be re-created from the copies stored in Stata. To re-create all the files, we
could type

. generate len = filewrite(fname, notes)
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If we want to know whether the phrase “Diabetes Mellitus Type 17 appears in the notes and
whether doctors recorded the disease as T1DM, we can type

. generate t2dm = (strpos("notes", "T1DM")) != 0

Of course, that depends on the notes_*.xyz files being either ASCII or ASCII-like enough so that
the T1DM would show up as “TIDM”.

Note that strpos() and all of Stata 13’s string functions work with long strings and with binary
strings.

12.4.11 String display formats

The format for strings is %[-}#s, such as %18s and %-18s. # may be up to 2,045. # indicates
the width of the field. %#s specifies that the string be displayed right-aligned in the field, and %-#s
specifies that the string is displayed left-aligned.

Stata sets good default formats for str# variables. The default format is %#s, so if a variable is
stri8, its default format is %18s.

Stata sets poor default formats for strL variables. Stata uses %9s in all cases. Because strL
variables can be so long, there is no good choice for the format; the question is merely how much
of the string you want to see.

When the format is too short for the length of the string, whether the string is str# or strL,
Stata usually displays # — 2 characters of the string and adds two dots at the end. We say “usually”
because a few commands are able to do something better than that.

12.4.12 How to see the full contents of a strL or a str# variable

By default, the 1ist command shows only the first part of long strings, followed by two dots.
How much 1ist shows is determined by the width of your Results window.

list will show the first 2,045 characters of long strings, whether stored as strLs or str#s, if
you add the notrim option:
. list, notrim
(output omitted )

. list mystr, notrim
(output omitted )

. list mystr in 5, notrim
(output omitted )

Another way to display long strings is to use the display command. With display, you can see
the entire contents. To display the fifth observation of the variable mystr, you type
. display _asis mystr[5]
(output omitted )

That one command can produce a lot of output if the string is long, even hundreds of thousands
of pages! Remember that you can press Break to stop the listing.
If you wanted to see the first 5,000 characters of the string, type
. display _asis substr(mystr[5], 1, 5000)

If you really wanted a full listing of a long string, you will want to set more off first:

. set more off

. display _asis mystr[5]
(output omitted )
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Very rarely, a string variable might contain SMCL output. SMCL is Stata’s text markup language.
A variable might contain SMCL if you used fileread() to read a Stata log file into it. In that case,
you can see the text correctly formatted by typing

. display as txt mystr[1]
(output omitted )

To learn more about other features of display, see [R] display.

12.4.13 Notes for programmers

The maximum length of macros is shorter than that of strLs. This means
1. you can use macros in string expressions without fear that results will be truncated.

2. you can enclose expanded macros in quotes— ‘" ‘macname’"’—to form string literals
without fear of truncation.

3. macros cannot hold binary strings. If you are working with binary strings, use string scalars,
which are also implemented as strLs. See [P] scalar.

4. you should not assume that the result of a string expression will fit into a macro. If you
are sure it will, go ahead and store the result into a macro. If you are not sure, use a string
scalar, which can hold a strL.

5. you should not assume that the contents of a strL variable will fit into a macro. Use string
scalars.

6. in programming, use string scalars just as you would use numeric scalars.

program ...
version 13
ééﬁpname mystr
éé;lar ‘mystr’ = ...
ééﬁerate co.o= L. ‘mystr. ..
end

mystr in the above code is a macro containing a temporary name. Thus ‘mystr’ is a
reference, not an expansion, of the contents of the string scalar.

12.5 Formats: Controlling how data are displayed

Formats describe how a number or string is to be presented. For instance, how is the number
325.24 to be presented? As 325.2, or 325.24, or 325.240, or 3.2524e+02, or 3.25e+02, or some
other way? The display format tells Stata exactly how to present such data. You do not have to
specify display formats because Stata always makes reasonable assumptions about how to display a
variable, but you always have the option.
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12.5.1 Numeric formats

A Stata numeric format is formed by

first type % to indicate the start of the format
then optionally type - if you want the result left-aligned
then optionally type O if you want to retain leading zeros (1)
then type a number w stating the width of the result
then type .
then type a number d stating the number of digits to follow the decimal point
then type
either e for scientific notation, e.g., 1.00e+03
or f for fixed format, e.g., 1000.0
or g for general format; Stata chooses based on the number being displayed
then optionally type c to indicate comma format (not allowed with e)

(1) Specifying 0 to mean “include leading zeros” will be honored only with the £ format.

For example,

%9.0g  general format, 9 columns wide
sqrt(2) = 1.414214
1,000 = 1000
10,000,000 = 1.00e+07
%9.0gc general format, 9 columns wide, with commas
sqri(2) = 1.414214
1,000 = 1,000
10,000,000 = 1.00e+07
%9 .2f fixed format, 9 columns wide, 2 decimal places
sqrt(2) = 1.41
1,000 = 1000.00
10,000,000 = 10000000.00
%9.2fc fixed format, 9 columns wide, 2 decimal places, with commas
sqrt(2) = 1.41
1,000 = 1,000.00
10,000,000 = 10,000, 000.00
%9.2e  exponential format, 9 columns wide
sqrt(2) = 1.41e+00
1,000 = 1.00e+03
10,000,000 = 1.00e+07

Stata has three numeric format types: e, £, and g. The formats are denoted by a leading percent
sign (%) followed by the string w.d, where w and d stand for two integers. The first integer, w,
specifies the width of the format. The second integer d specifies the number of digits that are to
follow the decimal point. d must be less than w. Finally, a character denotes the format type (e, £,
or g), and to that may optionally be appended a c indicating that commas are to be included in the
result (c is not allowed with e.)

By default, every numeric variable is given a %w.Og format, where w is large enough to display
the largest number of the variable’s type. The %w.0Og format is a set of formatting rules that present
the values in as readable a fashion as possible without sacrificing precision. The g format changes
the number of decimal places displayed whenever it improves the readability of the current value.



[U] 12 Data 123

The default formats for each of the numeric variable types are

byte %8.0g
int %8.0g
long %12.0g
float %9.0g
double %10.0g

You can change the format of a variable by using the format varname % fint command.

In addition to %w.0Og, allowed is %w.Ogc to display numbers with commas. “One thousand” is
displayed as 1000 in %9.0g format and as 1,000 in %9.0gc format.

In addition to using %w.Og and %w.Ogc, you can use %w.dg and %w.dgc, d > 0. For example,
%9 .4g and %9.4gc. The 4 means to display approximately four significant digits. For instance, the
number 3.14159265 in %9 . 4g format is displayed as 3.142, 31.4159265 as 31.42, 314.159265 as 314.2,
and 3141.59265 as 3142. The format is not exactly a significant-digit format because 31415.9265 is
displayed as 31416, not as 3.142e+04.

Under the f format, values are always displayed with the same number of decimal places, even
if this results in a loss in the displayed precision. Thus the £ format is similar to the C f format.
Stata’s f format is also similar to the Fortran F format, but, unlike the Fortran F format, it switches
to g whenever a number is too large to be displayed in the specified £ format.

In addition to %w.df, the format %w.dfc can display numbers with commas.

The e format is similar to the C e and the Fortran E format. Every value is displayed as a leading
digit (with a minus sign, if necessary), followed by a decimal point, the specified number of digits,
the letter e, a plus sign or a minus sign, and the power of 10 (modified by the preceding sign) that
multiplies the displayed value. When the e format is specified, the width must exceed the number of
digits that follow the decimal point by at least seven to accommodate the leading sign and digit, the
decimal point, the e, and the signed power of 10.

> Example 3

Below we have a 5-observation dataset with three variables: e_fmt, f_fmt, and g_fmt. All three
variables have the same values stored in them; only the display format varies. describe shows the
display format to the right of the variable type:

. use http://www.stata-press.com/data/r13/format, clear
. describe

Contains data from http://www.stata-press.com/data/r13/format.dta

obs: 5
vars: 3 12 Mar 2013 15:18
size: 60
storage display value
variable name  type format label variable label
e_fmt float  %9.2e
f_fmt float  7%10.2f
g_fmt float  %9.0g
Sorted by:

The formats for each of these variables were set by typing

. format e_fmt %9.2e
. format f_fmt %10.2f
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It was not necessary to set the format for the g_fmt variable because Stata automatically assigned it
the %9.0g format. Nevertheless, we could have typed format g_fmt %9.0g if we wished. Listing
the data results in

. list
e_fmt f_fmt g_fmt
1. 2.80e+00 2.80 2.801785
2. 3.96e+06 3962322.50 3962323
3. 4.85e+00 4.85 4.852834
4. -5.60e-06 -0.00 -5.60e-06
5. 6.26e+00 6.26 6.264982

Q Technical note

The discussion above is incomplete. There is one other format available that will be of interest to
numerical analysts. The %21x format displays base 10 numbers in a hexadecimal (base 16) format.
The number is expressed in hexadecimal (base 16) digits; the number aX+b means a X 2°. For
example,

. display %21x 1234.75
+1.34b0000000000X+00a

Thus the base 10 number 1,234.75 has a base 16 representation of 1.34bX+0a, meaning

<1+3-161 +4-16724+11- 163> x 210

Remember, the hexadecimal-decimal equivalents are

hexadecimal decimal
0 0
1 1
2 2
3 3
4 4
5 5
6 6
7 7
8 8
9 9
a 10
b 11
C 12
d 13
e 14
f 15

See [U] 12.2 Numbers.
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12.5.2 European numeric formats

The three numeric formats e, £, and g will use °,’ to indicate the decimal symbol if you specify
their width and depth as w,d rather than w.d. For instance, the format %9, 0g will display what Stata
would usually display as 1.5 as 1,5.

If you use the European specification with fc or gc, the “comma” will be presented as a period.
For instance, %9,0gc would display what Stata would usually display as 1,000.5 as 1.000,5.

If this way of presenting numbers appeals to you, consider using Stata’s set dp comma command.
set dp comma tells Stata to interpret nearly all %w.d{g|f|e} formats as %w,d{g|f|e} formats. Most
of Stata is written using a period to represent the decimal symbol, and that means that, even if you
set the appropriate %w,d{g|f|e} format for your data, it will affect only displays of the data. For
instance, if you type summarize to obtain summary statistics or regress to obtain regression results,
the decimal will still be shown as a period.

set dp comma changes that and affects all of Stata. With set dp comma, it does not matter whether
your data are formatted %w.d{g|f|e} or %w,d{g|f|e}. All results will be displayed using a comma
as the decimal character:
. use http://www.stata-press.com/data/r13/auto
(1978 Automobile Data)
. set dp comma

. summarize mpg weight foreign

Variable Obs Mean Std. Dev. Min Max
mpg 74 21,2973 5,785503 12 41
weight 74 3019,459 777,1936 1760 4840
foreign 74 ,2972973 ,4601885 0 1
. regress mpg weight foreign
Source SS df MS Number of obs = 74
F( 2, 71) = 69,75
Model 1619,2877 2 809,643849 Prob > F = 0,0000
Residual 824,171761 71 11,608053 R-squared = 0,6627
Adj R-squared = 0,6532
Total 2443,45946 73 33,4720474 Root MSE = 3,4071
mpg Coef.  Std. Err. t P>|t] [95% Conf. Intervall
weight -,0065879 ,0006371  -10,34 0,000 -,0078583 -,0053175
foreign -1,650029 1,075994 -1,563 0,130 -3,7955 ,4954422
_cons 41,6797  2,165547 19,256 0,000 37,36172 45,99768

You can switch the decimal character back to a period by typing set dp period.

Q Technical note

set dp comma makes drastic changes inside Stata, and we mention this because some older, user-
written programs may not be able to deal with those changes. If you are using an older user-written
program, you might set dp comma and then find that the program does not work and instead presents
some sort of syntax error.

If, using any program, you do get an unanticipated error, try setting dp back to period. See
[D] format for more information.
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Also understand that set dp comma affects how Stata outputs numbers, not how it inputs them.
You must still use the period to indicate the decimal point on all input. Even with set dp comma,
you type

. replace x=1.5 if x==

12.5.3 Date and time formats

Date and time formats are really a numeric format because Stata stores dates as the number of
milliseconds, days, weeks, months, quarters, half-years, or years from 01jan1960; see [U] 24 Working
with dates and times.

The syntax of the %t format is

first type % to indicate the start of the format
then optionally type - if you want the result left-aligned
then type t

then type character to indicate the units

then optionally type other characters to indicate how the date/time is to be displayed

The letter you type to specify the units is

milliseconds from 01jan1960, adjusted for leap seconds
milliseconds from 01jan1960, ignoring leap seconds
days from 01jan1960

weeks from 1960-w1

calendar months from jan1960

quarters from 1960-ql

half years from 1960-hl

5o B 8 aoQ

There are many codes you can type after that to specify exactly how the date/time is to be displayed, but
usually, you do not. Most users use the default %tc for date/times and %td for dates. See [D] datetime
display formats for details.

12.5.4 String formats

The syntax for a string format is

first type % to indicate the start of the format
then optionally type - if you want the result left-aligned
then type a number indicating the width of the result
then type s

For instance, %10s represents a string format of width 10.

For strw, the default format is %ws or %9s, whichever is wider. For example, a str10 variable
receives a %10s format. Strings are displayed right-justified in the field, unless the minus sign is
coded; %-10s would display the string left-aligned.
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> Example 4

Our automobile data contain a string variable called make.

. use http://www.stata-press.com/data/r13/auto
(1978 Automobile Data)

. describe make

storage display value
variable name  type format label variable label
make stri8  %-18s Make and Model

. list make in 63/67

make

63. Mazda GLC

64. Peugeot 604
65. Renault Le Car
66. Subaru

67. Toyota Celica

These values are left-aligned because make has a display format of %-18s. If we want to right-align
the values, we could change the format:

. format %18s make
. list make in 63/67

make
63. Mazda GLC
64. Peugeot 604
65. Renault Le Car
66. Subaru
67. Toyota Celica

12.6 Dataset, variable, and value labels

Labels are strings used to label elements in Stata, such as labels for datasets, variables, and values.

12.6.1 Dataset labels

Associated with every dataset is an 80-character dataset label, which is initially set to blanks. You
can use the label data "fext" command to define the dataset label.

> Example 5

We have just entered 1980 state data on marriage rates, divorce rates, and median ages. The
describe command will describe the data in memory:
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. describe

Contains data

obs: 50

vars: 4

size: 1,200

storage display value

variable name  type format label variable label
state str8 %9s
median_age float  %9.0g
marriage_rate long %12.0g

divorce_rate long %12.0g

Sorted by:
Note: dataset has changed since last saved

describe shows that there are 50 observations on four variables named state, median_age,
marriage_rate, and divorce_rate. state is stored as a str8; median_age is stored as a
float; and marriage_rate and divorce_rate are both stored as longs. Each variable’s display
format (see [U] 12.5 Formats: Controlling how data are displayed) is shown. Finally, the data are
not in any particular sort order, and the dataset has changed since it was last saved on disk.

We can label the data by typing label data "1980 state data". We type this and then type
describe again:
. label data "1980 state data"
. describe

Contains data

obs: 50 1980 state data
vars: 4
size: 1,200
storage display value
variable name  type format label variable label
state str8 %9s
median_age float  %9.0g

marriage_rate long %12.0g
divorce_rate long %12.0g

Sorted by:
Note: dataset has changed since last saved

The dataset label is displayed by the describe and use commands.

12.6.2 Variable labels

In addition to the name, every variable has associated with it an 80-character variable label. The
variable labels are initially set to blanks. You use the label variable varname "text" command to
define a new variable label.
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> Example 6
We have entered data on four variables: state, median_age, marriage_rate, and di-
vorce_rate. describe portrays the data we entered:

. describe

Contains data from states.dta

obs: 50 1980 state data
vars: 4
size: 1,200
storage display value
variable name  type format label variable label
state str8 %9s
median_age float  %9.0g

marriage_rate long %12.0g
divorce_rate long %12.0g

Sorted by:
Note: dataset has changed since last saved

We can associate labels with the variables by typing

. label variable median_age "Median Age"
. label variable marriage_rate "Marriages per 100,000"

. label variable divorce_rate "Divorces per 100,000"

From then on, the result of describe will be

. describe

Contains data

obs: 50 1980 state data
vars: 4

size: 1,200

storage display value

variable name  type format label variable label

state str8 %9s
median_age float  %9.0g Median Age
marriage_rate long %12.0g Marriages per 100,000
divorce_rate long %12.0g Divorces per 100,000
Sorted by:

Note: dataset has changed since last saved

4

Whenever Stata produces output, it will use the variable labels rather than the variable names to
label the results if there is room.

12.6.3 Value labels

Value labels define a correspondence or mapping between numeric data and the words used to
describe what those numeric values represent. Mappings are named and defined by the 1abel define
Iblname # “string" # "string"... command. The maximum length for the lblname is 32 characters.
# must be an integer or an extended missing value (.a, .b, ..., .z). The maximum length of string
is 32,000 characters. Named mappings are associated with variables by the label values varname
Iblname command.
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> Example 7

The definition makes value labels sound more complicated than they are in practice. We create a
dataset on individuals in which we record a person’s sex, coding O for males and 1 for females. If

our dataset also contained an employee number and salary, it might resemble the following:

. use http://www.stata-press.com/data/r13/gxmpl4
(2007 Employee data)

. describe

Contains data from http://www.stata-press.com/data/r13/gxmpl4.dta

obs: 7 2007 Employee data
vars: 3 11 Feb 2013 15:31
size: 84

storage display value
variable name type format label variable label
empno float  %9.0g Employee number
sex float  %9.0g Sex
salary float  %8.0fc Annual salary, exclusive of bonus
Sorted by:
. list
empno sex salary

1. 57213 0  34.000

2. 47229 1 37.000

3. 57323 0 34.000

4. 57401 0 34.500

5. 57802 1 37.000

6. 57805 1 34.000

7 57824 0 32.500

We could create a mapping called sexlabel defining 0 as “Male” and 1 as “Female”, and then

associate that mapping with the variable sex by typing

. label define sexlabel 0 "Male" 1 "Female"

. label values sex sexlabel

From then on, our data would appear as

. describe

Contains data from http://www.stata-press.com/data/r13/gxmpl4.dta

obs: 7 2007 Employee data

vars: 3 11 Feb 2013 15:31

size: 84

storage display value

variable name  type format label variable label
empno float  %9.0g Employee number
sex float  %9.0g sexlabel Sex
salary float  8.0fc Annual salary, exclusive of bonus

Sorted by:
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. list

empno sex salary
1. 57213 Male 34.000
2. 47229  Female 37.000
3. 57323 Male 34.000
4. 57401 Male 34.500
5. 57802 Female 37.000
6. 57805 Female 34.000
7 57824 Male 32.500

Notice not only that the value label is used to produce words when we 1ist the data but also that the
association of the variable sex with the value label sexlabel is shown by the describe command.

4

Q Technical note

Value labels and variables may share the same name. For instance, rather than calling the value
label sexlabel in the example above, we could just as well have named it sex. We would then type
label values sex sex to associate the value label named sex with the variable named sex.

a

> Example 8

Stata’s encode and decode commands provide a convenient way to go from string variables to
numerically coded variables and back again. Let’s pretend that, in the example above, rather than
coding O for males and 1 for females, we created a string variable recording either "male" or
"female".

. use http://www.stata-press.com/data/r13/gxmpl5
(2007 Employee data)
. describe

Contains data from http://www.stata-press.com/data/r13/gxmpl5.dta

obs: 7 2007 Employee data

vars: 3 11 Feb 2013 15:37

size: 98

storage display value

variable name  type format label variable label
empno float  %9.0g Employee number
sex stré %9s Sex
salary float  %8.0fc Annual salary, exclusive of bonus

Sorted by:
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. list

empno sex salary
1. 57213 male 34.000
2. 47229  female  37.000
3. 57323 male  34.000
4. 57401 male  34.500
5. 57802 female 37.000
6. 57805  female 34.000
7. 57824 male  32.500

We now want to create a numerically encoded variable—we will call it gender—from the string
variable. We want to do this, say, because we typed anova salary sex to perform a one-way ANOVA
of salary on sex, and we were told that there were “no observations”. We then remembered that all
Stata’s statistical commands treat string variables as if they contain nothing but missing values. The
statistical commands work only with numerically coded data.

. encode sex, generate(gender)
. describe

Contains data from http://www.stata-press.com/data/r13/gxmpl5.dta

obs: 7 2007 Employee data

vars: 4 11 Feb 2013 15:37

size: 126

storage display value

variable name type format label variable label
empno float  %9.0g Employee number
sex stré %9s Sex
salary float  8.0fc Annual salary, exclusive of bonus
gender long %8.0g gender Sex
Sorted by:

Note: dataset has changed since last saved

encode adds a new long variable called gender to the data and defines a new value label called
gender. The value label gender maps 1 to the string male and 2 to female, so if we were to 1list
the data, we could not tell the difference between the gender and sex variables. However, they are
different. Stata’s statistical commands know how to deal with gender but do not understand the sex
variable. See [D] encode.

a

Q Technical note

Perhaps rather than employee data, our data are on persons undergoing sex-change operations.
There would therefore be two sex variables in our data, sex before the operation and sex after the
operation. Assume that the variables are named presex and postsex. We can associate the same
value label to each variable by typing

. label define sexlabel 0 "Male" 1 "Female"
. label values presex sexlabel

. label values postsex sexlabel
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Q Technical note

Stata’s input commands (input and infile) can switch from the words in a value label back to
the numeric codes. Remember that encode and decode can translate a string to a numeric mapping
and vice versa, sO we can map strings to numeric codes either at the time of input or later.

For example,

. label define sexlabel 0 "Male" 1 "Female"
. input empno sex:sexlabel salary, label

empno sex salary
57213 Male 34000
47229 Female 37000
57323 0 34000
57401 Male 34500
57802 Female 37000
57805 Female 34000
57824 Male 32500
end

00 N O WN -

The label define command defines the value label sexlabel. input empno sex:sexlabel
salary, label tells Stata to input three variables from the keyboard (empno, sex, and salary),
attach the value label sexlabel to the sex variable, and look up any words that are typed in the
value label to try to convert them to numbers. To prove that it works, we 1list the data that we
recently entered:

. list

empno sex salary
1. 57213 Male 34000
2. 47229  Female 37000
3. 57323 Male 34000
4. 57401 Male 34500
5. 57802 Female 37000
6. 57805 Female 34000
7 57824 Male 32500

Compare the information we typed for observation 3 with the result listed by Stata. We typed
57323 0 34000. Thus the value of sex in the third observation is 0. When Stata listed the observation,
it indicated the value is Male because we told Stata in our label define command that zero is
equivalent to Male.

Let’s now add one more observation to our data:

. input, label

empno sex salary
8. 67223 FEmale 33000
’FEmale’ cannot be read as a number
8. 67223 Female 33000
9. end

At first we typed 67223 FEmale 33000, and Stata responded with “”FEmale’ cannot be read as a
number”. Remember that Stata always respects case, so FEmale is not the same as Female. Stata
prompted us to type the line again, and we did so, this time correctly.

a
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Q Technical note

Coupled with the automatic option, Stata not only can go from words to numbers but also can
create the mapping. Let’s input the data again, but this time, rather than typing the data, let’s read
the data from a file. Assume that we have a text file named employee.raw stored on our disk that
contains

57213 Male 34000
47229 Female 37000
57323 Male 34000
57401 Male 34500
57802 Female 37000
57805 Female 34000
57824 Male 32500

The infile command can read these data and create the mapping automatically:

. label list sexlabel
value label sexlabel not found
r(111);

. infile empno sex:sexlabel salary using employee, automatic
(7 observations read)

Our first command, label list sexlabel, is only to prove that we had not previously defined the
value label sexlabel. Stata infiled the data without complaint. We now have

. list

empno sex salary
1. 57213 Male 34000
2. 47229  Female 37000
3. 57323 Male 34000
4. 57401 Male 34500
5. 57802 Female 37000
6. 57805  Female 34000
7. 57824 Male 32500

Of course, sex is just another numeric variable; it does not actually take on the values Male and
Female—it takes on numeric codes that have been automatically mapped to Male and Female. We
can find out what that mapping is by using the label list command:

. label list sexlabel
sexlabel:

1 Male
2 Female

We discover that Stata attached the codes 1 to Male and 2 to Female. Anytime we want to see what
our data really look like, ignoring the value labels, we can use the nolabel option:
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. list, nolabel

empno  sex salary
1. | 57213 1 34000
2. | 47229 2 37000
3. | 57323 1 34000
4. | 57401 1 34500
5. | 57802 2 37000
6. | 57805 2 34000
7 57824 1 32500

12.6.4 Labels in other languages

A dataset can contain labels—data, variable, and value—in up to 100 languages. To discover the
languages available for the dataset in memory, type label language. You will see this

. label language

Language for variable and value labels

In this dataset, value and variable labels have been defined in only one
language: default

To create new language: . label language <name>, new
To rename current language: . label language <name>, rename

or something like this:

. label language

Language for variable and value labels

Available languages:

de
en
Sp
Currently set is: . label language sp
To select different language: . label language <name>
To create new language: . label language <name>, new

To rename current language: . label language <name>, rename
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. describe

Contains data

Right now, the example dataset is set with sp (Spanish) labels:

obs: 74 Automéviles, 1978

vars: 12 3 Oct 2012 13:53

size: 3,478

storage display value

variable name type format label variable label
make stri8  %-18s Marca y modelo
price int %8.0gc Precio
mpg int %8.0g Consumo de combustible
rep78 int %8.0g Historia de reparaciones
headroom float  %6.1f Cabeza adelante
trunk int %8.0g Volumen del maletero
weight int %8.0gc Peso

length int %8.0g Longitud
turn int %8.0g Radio de giro
displacement int %8.0g Cilindrada
gear_ratio float %6 .2f Relacidén de cambio
foreign byte %8.0g Extranjero
Sorted by: foreign

To create labels in more than one language, you set the new language and then define the labels in
the standard way; see [D] label language.

12.7 Notes attached to data

A dataset may contain notes, which are nothing more than little bits of text that you define and
review with the notes command. Typing note, a colon, and the text defines a note:

. note: Send copy to Bob once verified.

You can later display whatever notes you have previously defined by typing notes:

. notes

_dta:
1. Send copy to Bob once verified.

Notes are saved with the data, so once you save your dataset, you can replay this note in the future,
too.
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You can add more notes:

. note: Mary wants a copy, too.
. notes

_dta:
1. Send copy to Bob once verified.
2. Mary wants a copy, too.

The notes you have added so far are attached to the data generically, which is why Stata prefixes

them with _dta when it lists them. You can attach notes to variables:

. note state: verify values for Nevada.
. note state: what about the two missing values?
. notes

_dta:
1. Send copy to Bob once verified.
2. Mary wants a copy, too.

state:
1. verify values for Nevada.
2. what about the two missing values?

When you describe your data, you can see whether notes are attached to the dataset or to any

of the variables:

. describe

Contains data from states.dta

obs: 50 1980 state data

vars: 4

size: 1,200 (_dta has notes)

storage display value

variable name type format label variable label

state str8 %9s *
median_age float  %9.0g Median Age
marriage_rate long %12.0g Marriages per 100,000
divorce_rate long %12.0g Divorces per 100,000

* indicated variables have notes

Sorted by:
Note: dataset has changed since last saved

See [D] notes for a complete description of this feature.

12.8 Characteristics

Characteristics are an arcane feature of Stata but are of great use to Stata programmers. In fact,

the notes command described above was implemented using characteristics.

The dataset itself and each variable within the dataset have associated with them a set of
characteristics. Characteristics are named and referred to as varname [charname] , where varname is
the name of a variable or _dta. The characteristics contain text and are stored with the data in the

Stata-format .dta dataset, so they are recalled whenever the data are loaded.

How are characteristics used? The [XT] xt commands need to know the name of the panel variable,
and some of these commands also need to know the name of the time variable. xtset is used to
specify the panel variable and optionally the time variable. Users need xtset their data only once.
Stata then remembers this information, even from a different Stata session. Stata does this with
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characteristics: _dta[iis] contains the name of the panel variable and _dta[tis] contains the
name of the time variable. When an xt command is issued, the command checks these characteristics
to obtain the panel and time variables’ names. If this information is not found, then the data have
not previously been xtset and an error message is issued. This use of characteristics is hidden from
the user—no mention is made of how the commands remember the identity of the panel variable and
the time variable.

As a Stata user, you need understand only how to set and clear a characteristic for the few commands
that explicitly reveal their use of characteristics. You set a variable varname’s characteristic charname
to x by typing

. char varnamel[charname] x

You set the data’s characteristic charname to be x by typing

. char _dtalcharname] x

You clear a characteristic by typing

. char varname[charname]

where varname is either a variable name or _dta. You can clear a characteristic, even if it has never
been set.

The most important feature of characteristics is that Stata remembers them from one session to
the next; they are saved with the data.

Q Technical note

Programmers will want to know more. A technical description is found in [P] char, but for an
overview, you may refer to varname’s charname characteristic by embedding its name in single quotes
and typing ‘varname [charname] ’; see [U] 18.3.13 Referring to characteristics.

You can fetch the names of all characteristics associated with varname by typing

. local macname : char varnamel ]

The maximum length of the contents of a characteristic is 13,400 characters for Small Stata and
67,784 characters for Stata/IC, Stata/SE, and Stata/MP. The association of names with characteristics
is by convention. If you, as a programmer, wish to create new characteristics for use in your ado-files,
do so, but include at least one capital letter in the characteristic name. The current convention reserves

all lowercase names for “official” Stata. a

12.9 Data Editor and Variables Manager

We have spent most of this chapter writing about data management performed from Stata’s command
line. However, Stata provides two powerful features in its interface to help you examine and manage
your data: the Data Editor and the Variables Manager.

The Data Editor is a spreadsheet-style data editor that allows you to enter new data, edit existing
data, safely browse your data in a read-only mode, and perform almost any data management task
you desire in a reproducible manner using a graphical interface. To open the Data Editor, select
Data > Data Editor > Data Editor (Edit) or Data > Data Editor > Data Editor (Browse). See
[GS] 6 Using the Data Editor (GSM, GSU, or GSW) for a tutorial discussion of the Data Editor. See
[D] edit for technical details.



[U] 12 Data 139

The Variables Manager is a tool that lists and allows you to manage all the properties of the
variables in your data. Variable properties include the name, label, storage type, format, value label,
and notes. The Variables Manager allows you to sort and filter your variables, something that you
will find to be very useful if you work with datasets having many variables. The Variables Manager
also can be used to create varlists for the Command window. To open the Variables Manager, select
Data > Variables Manager. See [GS] 7 Using the Variables Manager (GSM, GSU, or GSW) for a
tutorial discussion of the Variables Manager.

Both the Data Editor and Variables Manager submit commands to Stata to perform any changes
that you request. This lets you see a log of what changes were made, and it also allows you to work
interactively while still building a list of commands you can execute later to reproduce your analysis.

12.10 References

Cox, N. J. 2006. Stata tip 33: Sweet sixteen: Hexadecimal formats and precision problems. Stata Journal 6: 282-283.
—. 2010a. Stata tip 84: Summing missings. Stata Journal 10: 157-159.

——. 2010b. Stata tip 85: Looping over nonintegers. Stata Journal 10: 160-163.

Long, J. S. 2009. The Workflow of Data Analysis Using Stata. College Station, TX: Stata Press.

Longest, K. C. 2012. Using Stata for Quantitative Analysis. Thousand Oaks, CA: Sage.

Mitchell, M. N. 2010. Data Management Using Stata: A Practical Handbook. College Station, TX: Stata Press.
Rising, W. R. 2010. Stata tip 86: The missing() function. Stata Journal 10: 303-304.


http://www.stata-journal.com/sjpdf.html?articlenum=dm0022
http://www.stata-journal.com/sjpdf.html?articlenum=dm0047
http://www.stata-journal.com/sjpdf.html?articlenum=pr0051
http://www.stata-press.com/books/wdaus.html
http://www.stata.com/bookstore/using-stata-for-quantitative-analysis/
http://www.stata-press.com/books/dmus.html
http://www.stata-journal.com/sjpdf.html?articlenum=dm0049




1 3 Functions and expressions

Contents
I3.1 0 OVEIVIEW ettt ettt e e e e e e e e e e e e 141
13.2 0 OPCIAtOTS . vttt et ettt e e e e e e e e e e e e 142
13.2.1  Arithmetic Operators . .............o.uiuniiniiniinninnanann... 142
13.2.2  String Operators . ... ... ...ttt e 142
13.2.3  Relational Operators ... ... ....c.vun oot et 143
13.2.4  Logical OPErators ... ... .......iuninneuntie it 144
13.2.5  Order of evaluation, all operators ...............c.ciuiuiiinennenan.. 145
13.3  FUNCHONS .ttt ettt e e e e e e e e e e e e e e e e e 145
13.4  System variables (—variables) .............. it 146
13.5 Accessing coefficients and standard errors ................. ... 147
13.5.1  Single-equation models ....... ... .. i e 147
13.5.2  Multiple-equation models ........... ... ... .. i 147
13.5.3  Factor variables and time-series Operators . ..................ooeuen... 148
13.6  Accessing results from Stata commands ............... .. i 150
13.7  EXplicit subSCripting ... ... ...ttt 151
13.7.1  Generating lags and leads ............ ... i, 151
13.7.2  Subscripting Within groups ... .......c.ouiuiinen et 152
13.8 Indicator values for levels of factor variables ............... ... ... .. ... ...... 155
13.9  Time-Series OPETALOrS . .. vttt ettt e et e e et e e e ettt 155
13.9.1 Generating lags, leads, and differences ............... .. . .. .. ... ... 155
13.9.2  Time-series operators and factor variables ........................... 156
13.9.3  Operators Within groups . ... ... ....uiiien ettt 156
13.9.4  Video example .. ... e 157
13.10 Label values .. ... ... e 157
13.11 Precision and problems therein ............... ..o iuiiniieninnaannan.. 158
13,12 RefEIeNCES . ..ottt e e e 159

If you have not read [U] 11 Language syntax, please do so before reading this entry.

13.1 Overview

Examples of expressions include

2+2

miles/gallons
myv+2/oth

(myv+2) /oth
1n(income)

age<25 & income>50000
age<25 | income>50000
age==25

name=="M Brown"
fname + " " + lname
substr (name,1,10)
val[_n-1]

L.gnp

141
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Expressions like those above are allowed anywhere exp appears in a syntax diagram. One example
is [D] generate:

generate newvar = exp [zf} [in}

The first exp specifies the contents of the new variable, and the optional second expression restricts
the subsample over which it is to be defined. Another is [R] summarize:

summarize [Varlist} [zf] [in]
The optional expression restricts the sample over which summary statistics are calculated.

Algebraic and string expressions are specified in a natural way using the standard rules of hierarchy.
You may use parentheses freely to force a different order of evaluation.
> Example 1

myv+2/oth is interpreted as myv+(2/oth). If you wanted to change the order of the evaluation,

you could type (myv+2)/oth.
d

13.2 Operators

Stata has four different classes of operators: arithmetic, string, relational, and logical. Each type
is discussed below.

13.2.1 Arithmetic operators

The arithmetic operators in Stata are + (addition), - (subtraction), * (multiplication), / (division),
~ (raise to a power), and the prefix - (negation). Any arithmetic operation on a missing value or an
impossible arithmetic operation (such as division by zero) yields a missing value.

> Example 2
The expression - (z+y~ (x-y))/(r*y) denotes the formula
T +y*Y
x-y

and evaluates to missing if x or ¥y is missing or zero.

13.2.2 String operators

The + and * signs are also used as string operators.

+ is used for the concatenation of two strings. Stata determines by context whether + means
addition or concatenation. If + appears between two numeric values, Stata adds them. If + appears
between two strings, Stata concatenates them.
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> Example 3

The expression "this"+"that" results in the string "thisthat", whereas the expression 2+3
results in the number 5. Stata issues the error message “type mismatch” if the arguments on either
side of the + sign are not of the same type. Thus the expression 2+"this" is an error, as is 2+"3".

The expressions on either side of the + can be arbitrarily complex:
substr(string(20+2),1,1) + upper(substr("rf",1+1,1))

The result of the above expression is the string "2F". See [D] functions for a description of the
substr (), string(), and upper () functions.

4

* is used to duplicate a string 0 or more times. Stata determines by context whether * means
multiplication or string duplication. If * appears between two numeric values, Stata multiplies them.
If * appears between a string and a numeric value, Stata duplicates the string as many times as the
numeric value indicates.

> Example 4

The expression "this"*3 results in the string "thisthisthis", whereas the expression 2*3
results in the number 6. Stata issues the error message “type mismatch” if the arguments on either
side of the * sign are both strings. Thus the expression "this"*"that" is an error.

As with string concatenation above, the arguments can be arbitrarily complex.

13.2.3 Relational operators

The relational operators are > (greater than), < (less than), >= (greater than or equal), <= (less than
or equal), == (equal), and != (not equal). Observe that the relational operator for equality is a pair
of equal signs. This convention distinguishes relational equality from the =exp assignment phrase.

Q Technical note

You may use ~ anywhere ! would be appropriate to represent the logical operator “not”. Thus the
not-equal operator may also be written as ~=.
a

Relational expressions are either true or false. Relational operators may be used on either numeric
or string subexpressions; thus, the expression 3>2 is true, as is "zebra">"cat". In the latter case, the
relation merely indicates that "zebra" comes after the word "cat" in the dictionary. All uppercase
letters precede all lowercase letters in Stata’s book, so "cat">"Zebra" is also true.

Missing values may appear in relational expressions. If x were a numeric variable, the expression
x>=. is true if x is missing and false otherwise. A missing value is greater than any nonmissing
value; see [U] 12.2.1 Missing values.

> Example 5

You have data on age and income and wish to list the subset of the data for persons aged 25
years or less. You could type

. list if age<=25
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If you wanted to list the subset of data of persons aged exactly 25, you would type
. list if age==25

Note the double equal sign. It would be an error to type 1ist if age=25.
d

Although it is convenient to think of relational expressions as evaluating to true or false, they
actually evaluate to numbers. A result of true is defined as 1 and false is defined as 0.

> Example 6

The definition of true and false makes it easy to create indicator, or dummy, variables. For instance,
generate incgtlOk=income>10000
creates a variable that takes on the value 0 when income is less than or equal to $10,000, and 1 when

income is greater than $10,000. Because missing values are greater than all nonmissing values, the
new variable incgt10k will also take on the value 1 when income is missing. It would be safer to

type
generate incgtlOk=income>10000 if income<.
Now, observations in which income is missing will also contain missing in incgt1Ok. See

[U] 25 Working with categorical data and factor variables for more examples.

d

Q Technical note

Although you will rarely wish to do so, because arithmetic and relational operators both evaluate
to numbers, there is no reason you cannot mix the two types of operators in one expression. For
instance, (2==2)+1 evaluates to 2, because 2==2 evaluates to 1, and 1 + 1 is 2.

Relational operators are evaluated after all arithmetic operations. Thus the expression (3>2)+1 is
equal to 2, whereas 3>2+1 is equal to 0. Evaluating relational operators last guarantees the logical
(as opposed to the numeric) interpretation. It should make sense that 3>2+1 is false.

a

13.2.4 Logical operators

The logical operators are & (and), | (or), and ! (not). The logical operators interpret any nonzero
value (including missing) as true and zero as false.

> Example 7

If you have data on age and income and wish to 1ist data for persons making more than $50,000
along with persons under the age of 25 making more than $30,000, you could type

list if income>50000 | income>30000 & age<25

The & takes precedence over the |. If you were unsure, however, you could have typed

list if income>50000 | (income>30000 & age<25)
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In either case, the statement will also 1list all observations for which income is missing, because
missing is greater than 50,000.
d

Q Technical note

Like relational operators, logical operators return 1 for true and O for false. For example, the
expression 5 & . evaluates to 1. Logical operations, except for !, are performed after all arithmetic
and relational operations; the expression 3>2 & 5>4 is interpreted as (3>2) & (5>4) and evaluates
to 1.

a

13.2.5 Order of evaluation, all operators

The order of evaluation (from first to last) of all operators is ! (or ~), =, - (negation), /, *, -
(subtraction), +, !'= (or ~=), >, <, <=, >=, == &, and |.

13.3 Functions

Stata provides mathematical functions, probability and density functions, matrix functions, string
functions, functions for dealing with dates and time series, and a set of special functions for
programmers. You can find all these documented in [D] functions. Stata’s matrix programming
language, Mata, provides more functions and those are documented in the Mata Reference Manual
or in the help documentation (type help mata functions).

Functions are merely a set of rules; you supply the function with arguments, and the function
evaluates the arguments according to the rules that define the function. Because functions are essentially
subroutines that evaluate arguments and cause no action on their own, functions must be used in
conjunction with a Stata command. Functions are indicated by the function name, an open parenthesis,
an expression or expressions separated by commas, and a close parenthesis.

For example,

. display sqrt(4)
2

or

. display sqrt(2+2)
2

demonstrates the simplest use of a function. Here we have used the mathematical function, sqrt (),
which takes one number (or expression) as its argument and returns its square root. The function was
used with the Stata command display. If we had simply typed

. sqrt(4)
Stata would have returned the error message

unrecognized command: sqrt
r(199);
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Functions can operate on variables, as well. For example, suppose that you wanted to generate a
random variable that has observations drawn from a lognormal distribution. You could type

. set obs 5
obs was 0, now 5
. generate y = runiform()

. replace y = invnormal(y)
(5 real changes made)

. replace y = exp(y)
(5 real changes made)

. list

y

.686471
2.380994
.2814537
1.215575
.2920268

g WN e

You could have saved yourself some typing by typing just

. generate y = exp(rnormal())

Functions accept expressions as arguments.

All functions are defined over a specified domain and return values within a specified range.
Whenever an argument is outside a function’s domain, the function will return a missing value or
issue an error message, whichever is most appropriate. For example, if you supplied the log()
function with an argument of zero, the 1og(0) would return a missing value because zero is outside
the natural logarithm function’s domain. If you supplied the 1og() function with a string argument,
Stata would issue a “type mismatch” error because log() is a numerical function and is undefined
for strings. If you supply an argument that evaluates to a value that is outside the function’s range,
the function will return a missing value. Whenever a function accepts a string as an argument, the
string must be enclosed in double quotes, unless you provide the name of a variable that has a string
storage type.

13.4 System variables (_variables)

Expressions may also contain _variables (pronounced “underscore variables”), which are built-in
system variables that are created and updated by Stata. They are called _variables because their names

s

all begin with the underscore character, ‘_’.
The _variables are

Legnol _b [varname] (synonym: [egno] _coef [varname]) contains the value (to machine precision)
of the coefficient on varname from the most recently fit model (such as ANOVA, regression, Cox,
logit, probit, and multinomial logit). See [U] 13.5 Accessing coefficients and standard errors
below for a complete description.

_comns is always equal to the number 1 when used directly and refers to the intercept term when
used indirectly, as in _b[_cons].

_n contains the number of the current observation.
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_N contains the total number of observations in the dataset or the number of observations in the
current by () group.

—rc contains the value of the return code from the most recent capture command.

Legnol _se [varname] contains the value (to machine precision) of the standard error of the coefficient
on varname from the most recently fit model (such as ANOVA, regression, Cox, logit, probit, and
multinomial logit). See [U] 13.5 Accessing coefficients and standard errors below for a complete
description.

13.5 Accessing coefficients and standard errors

After fitting a model, you can access the coefficients and standard errors and use them in subsequent
expressions. Also see [R] predict (and [U] 20 Estimation and postestimation commands) for an
easier way to obtain predictions, residuals, and the like.

13.5.1 Single-equation models

First, let’s consider estimation methods that yield one estimated equation with a one-to-one
correspondence between coefficients and variables such as logit, ologit, oprobit, probit,
regress, and tobit. _b[varname] (synonym _coef [varname]) contains the coefficient on varname
and _se[varname] contains its standard error, and both are recorded to machine precision. Thus
_b[age] refers to the calculated coefficient on the age variable after typing, say, regress response
age sex, and _se[age] refers to the standard error on the coefficient. _b[_cons] refers to the
constant and _se[_cons] to its standard error. Thus you might type

. regress response age sex
. generate asif = _b[_cons] + _blagel*age

13.5.2 Multiple-equation models

The syntax for referring to coefficients and standard errors in multiple-equation models is the same
as in the simple-model case, except that _b[] and _se[] are preceded by an equation number in
square brackets. There are, however, many alternatives in how you may type requests. The way that
you are supposed to type requests is

Legnol _b [varname]
Legno] _se [varname]

but you may substitute _coef[] for _b[]. In fact, you may omit the _b[] altogether, and most
Stata users do:

Legnol [varname]
You may also omit the second pair of square brackets:
Legnol varname
You may retain the _b[] or _se[] and insert a colon between eqno and varname:

_blegno:varnamel
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There are two ways to specify the equation number egno: either as an absolute equation number or
as an “indirect” equation number. In the absolute form, the number is preceded by a ‘#’ sign. Thus
[#11displ refers to the coefficient on displ in the first equation (and [#1] _se[displ] refers to
its standard error). You can even use this form for simple models, such as regress, if you prefer.
regress estimates one equation, so [#1]displ refers to the coefficient on displ, just as _b[displ]
does. Similarly, [#1] _se[displ] and _se[displ] are equivalent. The logic works both ways—in
the multiple-equation context, _b[displ] refers to the coefficient on displ in the first equation
and _se[displ] refers to its standard error. _b[varname] (_se [varnamel) is just another way of
saying [#1]varname ([#1] _se [varnamel).

Equations may also be referred to indirectly. [res]displ refers to the coefficient on displ in the
equation named res. Equations are often named after the corresponding dependent variable name if
there is such a concept in the fitted model, so [res]displ might refer to the coefficient on displ
in the equation for variable res.

For multinomial logit (mlogit), multinomial probit (mprobit), and similar commands, equations
are named after the levels of the single dependent categorical variable. In these models, there is one
dependent variable, and there is an equation corresponding to each of the outcomes (values taken
on) recorded in that variable, except for the one that is taken to be the base outcome. [res]displ
would be interpreted as the coefficient on displ in the equation corresponding to the outcome res.
If outcome res is the base outcome, Stata treats [res]displ as zero (and Stata does the same for
[res] _se[displl]).

Continuing with the multinomial outcome case: the outcome variable must be numeric. The syntax
[res]displ would be understood only if there were a value label associated with the numeric
outcome variable and res were one of the labels. If your data are not labeled, then you can use the
usual multiple-equation syntax [##]varname and [##] _se [varname] to refer to the coefficient and
standard error for variable varname in the #th equation.

For mlogit, if your data are not labeled, you can also use the syntax [#]varname and
[#] _se [varname] (without the ‘#’) to refer to the coefficient and standard error for varname
in the equation for outcome #.

13.5.3 Factor variables and time-series operators

We refer to time-series—operated variables exactly as we refer to normal variables. We type the name
of the variable, which for time-series—operated variables includes the operators; see [U] 11.4.4 Time-
series varlists. You might type

. regress open L.close LD.volume
. display _b[L.close]
. display _b[LD.volume]

We cannot refer to factor variables such as i.group in expressions. Assuming that i.group has
three levels, i.group represents three virtual indicator variables—1b. group, 2.group, and 3. group.
We can refer to the indicator variables in expressions by typing, for example, _b[i2.group] or just
_b[2.group]. That is to say, we include the operators and the levels of the factor variables when
typing the indicator-variable name. Consider a regression using factor variables:
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. use http://www.stata-press.com/data/r13/fvex, clear
(Artificial factor variables’ data)

. regress y i.sex i.group sex#group age sex#c.age

Source SS df MS Number of obs = 3000
F(C 7, 2992) = 80.84
Model 221310.507 7 31615.7868 Prob > F = 0.0000
Residual 1170122.5 2992 391.083723 R-squared = 0.1591
Adj R-squared = 0.1571
Total 1391433.01 2999 463.965657 Root MSE = 19.776
y Coef. Std. Err. t P>t [95% Conf. Intervall
sex
female 32.29378  3.782064 8.54 0.000 24.87807 39.70949
group
2 9.477077  1.624075 5.84 0.000 6.292659 12.66149
3 18.31292  1.776337 10.31  0.000 14.82995 21.79588
sex#group
female 2 -6.621804 2.021384 -3.28 0.001 -10.58525  -2.658361
female 3 -10.48293 3.209 -3.27 0.001 -16.775 -4.190858
age -.212332 .0538345 -3.94 0.000 -.3178884  -.1067756
sex#c.age
female -.226838 .0745707 -3.04 0.002 -.37305631  -.0806229
_cons 60.48167  2.842955 21.27  0.000 54.90732 66.05601

If we want to use the coefficient for level 2 of group in an expression, we type _b[2.group]; for
level 3, we type _b[3.group]. To refer to the coefficient of an interaction of two levels of two factor
variables, we specify the interaction operator and the level of each variable. For example, to use the
coefficient for sex = 1 (female) and group = 2, we type _b[1.sex#2.group]. (We determined
that 1 was the level corresponding to female by typing label 1ist.) When one of the variables in
an interaction is continuous, we can either make that explicit, _b[1.sex#c.age], or we can leave
off the c., _b[1.sex#age].

Referring to interactions is more challenging than referring to normal variables. It is also more
challenging to refer to coefficients from estimators that use multiple equations. If you find it difficult
to know what to type for a coefficient, replay your estimation results using the coeflegend option.
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. regress, coeflegend

Source SS df MS Number of obs = 3000
F(C 7, 2992) = 80.84
Model 221310.507 7 31615.7868 Prob > F = 0.0000
Residual 1170122.5 2992 391.083723 R-squared = 0.1591
Adj R-squared = 0.1571
Total 1391433.01 2999 463.965657 Root MSE = 19.776
y Coef. Legend
sex
female 32.29378 _bl1l.sex]
group
2 9.477077 _b[2.group]
3 18.31292 _b[3.group]
sex#group
female 2 -6.621804 _b[1.sex#2.group]
female 3 -10.48293 _b[1.sex#3.group]
age -.212332 _b[age]
sex#c.age
female -.226838 _bl[1.sex#c.agel
_cons 60.48167 _b[_cons]

The Legend column shows you exactly what to type to refer to any coefficient in the estimation.

If your estimation results have both equations and factor variables, nothing changes from what we
said in [U] 13.5.2 Multiple-equation models above. What you type for varname is just a little more
complicated.

13.6 Accessing results from Stata commands

Most Stata commands—not just estimation commands—store results so that you can access them
in subsequent expressions. You do that by referring to e (name), r(name), s(name), or c(name).

. summarize age
. generate agedev = age-r(mean)
. regress mpg weight

. display "The number of observations used is " e(N)

Most commands are categorized as r-class, meaning that they store results in r(). The returned
results—such as r (mean) —are available immediately following the command, and if you are going
to refer to them, you need to refer to them soon because the next command will probably replace
what is in r ().

e-class commands are Stata’s estimation commands—commands that fit models. Results in e ()
remain available until the next model is fit.

s-class commands are parsing commands—commands used by programmers to interpret commands
you type. Few commands store anything in s().

There are no c-class commands. c() contains values that are always available, such as
c(current_date) (today’s date), c (pwd) (the current directory), c (N) (the number of observations),
and so on. There are many c() values and they are documented in [P] creturn.
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Every command of Stata is designated r-class, e-class, or s-class, or, if the command stores nothing,
n-class. r stands for return as in returned results, e stands for estimation as in estimation results, s
stands for string, and, admittedly, this last acronym is weak, n stands for null.

You can find out what is stored where by looking in the Stored results section for the particular
command in the Reference manual. If you know the class of a command—and it is easy enough to
guess—you can also see what is stored by typing return list, ereturn list, or sreturn list:

See [R] stored results and [U] 18.8 Accessing results calculated by other programs.

13.7 Explicit subscripting

Individual observations on variables can be referred to by subscripting the variables. Explicit
subscripts are specified by following a variable name with square brackets that contain an expression.
The result of the subscript expression is truncated to an integer, and the value of the variable for the
indicated observation is returned. If the value of the subscript expression is less than 1 or greater
than _N, a missing value is returned.

13.7.1 Generating lags and leads
When you type something like

. generate y = x

Stata interprets it as if you typed
. generate y = x[_n]
which means that the first observation of y is to be assigned the value from the first observation of

x, the second observation of y is to be assigned the value from the second observation on x, and so
on. If you instead typed

. generate y = x[1]

you would set each observation of y equal to the first observation on x. If you typed

. generate y = x[2]

you would set each observation of y equal to the second observation on x. If you typed

. generate y = x[0]
Stata would merely copy a missing value into every observation of y because observation 0 does not
exist. The same would happen if you typed

. generate y = x[100]

and you had fewer than 100 observations in your data.

When you type the square brackets, you are specifying explicit subscripts. Explicit subscripting
combined with the _variable _n can be used to create lagged values on a variable. The lagged value
of a variable x can be obtained by typing

. generate xlag = x[_n-1]

If you are really interested in lags and leads, you probably have time-series data and would be better
served by using the time-series operators, such as L.x. Time-series operators can be used with varlists
and expressions and they are safer because they account for gaps in the data; see [U] 11.4.4 Time-series
varlists and [U] 13.9 Time-series operators. Even so, it is important that you understand how the
above works.
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The built-in underscore variable _n is understood by Stata to mean the observation number of the
current observation. That is why

. generate y = x[_n]
results in observation 1 of x being copied to observation 1 of y and similarly for the rest of the
observations. Consider

. generate xlag = x[_n-1]
_n-1 evaluates to the observation number of the previous observation. For the first observation,

_n-1 = 0 and therefore xlag[1] is set to missing. For the second observation, _—n-1 = 1 and
xlag[2] is set to the value of x[1], and so on.

Similarly, the lead of x can be created by
. generate xlead = x[_n+1]

Here the last observation on the new variable xlead will be missing because _n+1 will be greater
than _N (_N is the total number of observations in the dataset).

13.7.2 Subscripting within groups

When a command is preceded by the by varlist: prefix, subscript expressions and the underscore
variables —_n and _N are evaluated relative to the subset of the data currently being processed. For
example, consider the following (admittedly not very interesting) data:

. use http://www.stata-press.com/data/r13/gxmpl6
. list

bvar oldvar

O W N R
NN = ==
g wWwN
i

To see how _n, _N, and explicit subscripting work, let’s create three new variables demonstrating
each and then 1ist their values:

. generate small_n = _n

. generate big.n = _N

. generate newvar = oldvar[1]
. list

bvar oldvar small_n big_n newvar

O WN -
NN P ==
g wN -
B R R
(S =V O T o
a0,
i
T

small_n (which is equal to _n) goes from 1 to 5, and big_n (which is equal to _N) is 5. This should
not be surprising; there are 5 observations in the data, and _n is supposed to count observations,
whereas _N is the total number. newvar, which we defined as oldvar[1], is 1.1. Indeed, we see
that the first observation on oldvar is 1.1.
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Now, let’s repeat those same three steps, only this time preceding each step with the prefix by
bvar:. First, we will drop the old values of small_n, big_n, and newvar so that we start fresh:

. drop small_n big_n newvar

. by bvar, sort: generate small_n=_n
. by bvar: generate big_n =_N

. by bvar: generate newvar=oldvar[1]

. list

bvar oldvar small_n big_n newvar

g WN e
NN = ==
GO WN =
i
N = WN =
NN WWW
N e
PR R R

The results are different. Remember that we claimed that _n and _N are evaluated relative to the
subset of data in the by-group. Thus small_n (_n) goes from 1 to 3 for bvar = 1 and from 1 to 2
for bvar = 2. big_n (_N) is 3 for the first group and 2 for the second. Finally, newvar (oldvar[1])
is 1.1 and 4.1.

> Example 8

You now know enough to do some amazing things.

Suppose that you have data on individual states and you have another variable in your data called
region that divides the states into the four census regions. You have a variable x in your data, and
you want to make a new variable called avgx to include in your regressions. This new variable is to
take on the average value of x for the region in which the state is located. Thus, for California, you
will have the observation on x and the observation on the average value in the region, avgx. Here is
how:

. by region, sort: generate avgx=sum(x)/_n

. by region: replace avgx=avgx[_N]

First, by region, we generate avgx equal to the running sum of x divided by the number of
observations so far. The , sort ensures that the data are in region order. We have, in effect, created
the running average of x within region. It is the last observation of this running average, the overall
average within the region, that interests us. So, by region, we replace every avgx observation
in a region with the last observation within the region, avgx [_N].

Here is what we will see when we type these commands:
. use http://www.stata-press.com/data/r13/gxmpl7, clear

. by region, sort: generate avgx=sum(x)/_n

. by region: replace avgx=avgx[_N]
(46 real changes made)

In our example, there are no missing observations on x. If there had been, we would have obtained
the wrong answer. When we created the running average, we typed

. by region, sort: generate avgx=sum(x)/_n
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The problem is not with the sum() function. When sum() encounters a missing, it adds zero to
the sum. The problem is with _n. Let’s assume that the second observation in the first region has
recorded a missing for x. When Stata processes the third observation in that region, it will calculate
the sum of two elements (remember that one is missing) and then divide the sum by 3 when it should
be divided by 2. There is an easy solution:

. by region: generate avgx=sum(x)/sum(x<.)

Rather than divide by _n, we divide by the total number of nonmissing observations seen on x so
far, namely, the sum(x<.).

If our goal were simply to obtain the mean, we could have more easily accomplished it by typing
egen avgx=mean(x), by(region); see [D] egen. egen, however, is written in Stata, and the above
is how egen’s mean() function works. The general principles are worth understanding.

4

> Example 9

You have some patient data recording vital signs at various times during an experiment. The
variables include patient, an ID number or name of the patient; time, a variable recording the date
or time or epoch of the vital-sign reading; and vital, a vital sign. You probably have more than
one vital sign, but one is enough to illustrate the concept. Each observation in your data represents
a patient-time combination.

Let’s assume that you have 1,000 patients and, for every observation on the same patient, you
want to create a new variable called orig that records the patient’s initial value of this vital sign.
. use http://www.stata-press.com/data/r13/gxmpl8, clear
. sort patient time

. by patient: generate orig=vitall[1]

Observe that vital[1] refers not to the first reading on the first patient but to the first reading on
the current patient, because we are performing the generate command by patient.

N

> Example 10

Let’s do one more example with these patient data. Suppose that we want to create a new dataset
from our patient data that record not only the patient’s identification, the time of the reading of the
first vital sign, and the first vital sign reading itself, but also the time of the reading of the last vital
sign and its value. We want 1 observation per patient. Here’s how:

. sort patient time

. by patient: generate lasttime=time[_N]

. by patient: generate lastvital=vital[_N]
. by patient: drop if _n!=1

d

See Mitchell (2010, chap. 7) for numerous examples of subscripting and subscripting within groups
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13.8 Indicator values for levels of factor variables

Stata’s factor-variable features let us access virtual indicator variables for categorical variables and
their interactions; see [U] 11.4.3 Factor variables and [U] 25 Working with categorical data and
factor variables. We can use those virtual indicator variables in expressions just as though the virtual
variables existed in our data. If you have not read about factor-variable varlists in [U] 11.4.3 Factor
variables, do so now.

If group is a categorical variable taking on the value 1, 2, or 3, consider the expression

. generate groupl = 1.group

We have taken the virtual indicator variable that is 1 when group = 1 and 0 when group # 1
and made it into a real variable—group1. That is strictly true only if group is never missing. If
group can be missing, we need to add that 1.group is missing when group is missing.

These virtual variables extend to interactions. If we also have a variable, sex, that is 0 for males
and 1 for females, then

. generate sexOgrp2 = 0.sex#2.group

creates the variable sexOgrp2, which is 1 when sex = 0 and group = 2, . (missing) when sex or
group is missing, and O otherwise.

Virtual indicator variables can be used in any expression, including if expressions.

Q Technical note

We have been using the shorthand notation for virtual indicators that drops the i prefix. We
have written 2.group rather than i2.group. There are three cases where we cannot drop the i
prefix—when our variable name is e, d, or x. These three letters can be used to construct numbers
such as 1e-3, which can also be typed 1.e-3. If we have a variable named e, are we to interpret
1.e-3 as the number 0.001 or as the virtual indicator variable 1.e with the number 3 subtracted?
Because of longstanding precedent, it is interpreted as the number 0.001. If we want 1.e interpreted
as a virtual indicator, we must include the i prefix—il.e.

a

13.9 Time-series operators

Time-series operators allow you to refer to the lag of gnp by typing L.gnp, the second lag by
typing L2.gnp, etc. There are also operators for lead (F), difference D, and seasonal difference S.

Time-series operators can be used with varlists and with expressions. See [U] 11.4.4 Time-series
varlists if you have not read it already. This section has to do with using time-series operators in
expressions such as with generate. You do not have to create new variables; you can use the
time-series operated variables directly.

13.9.1 Generating lags, leads, and differences

In a time-series context, referring to L2.gnp is better than referring to gnp [_n-2] because there
might be missing observations. Pretend that observation 4 contains data for ¢ = 25 and observation
5 data for ¢ = 27. L2.gnp will still produce correct answers; L2.gnp for observation 5 will be the
value from observation 4 because the time-series operators look at ¢ to find the relevant observation.
The more mechanical gnp [_n-2] just goes 2 observations back, which, here, would not produce the
desired result.
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This same idea holds for differences. In our example, D.gnp will produce a missing value in
observation 5 (t = 27) because there is no data recorded for ¢ = 26, and therefore there is no first
difference for ¢t = 27.

Time-series operators can be used with varlists or with expressions, so you can type

. regress val L.gnp r

or
. generate gnplagged = L.gnp
. regress val gnplagged

Before you can type either one, however, you must use the tsset command to tell Stata the identity
of the time variable; see [TS] tsset. Once you have tsset the data, anyplace you see an exp in a
syntax diagram, you may type time series—operated variables, so you can type

. summarize r if F.gnp < gnp
or

. generate grew = 1 if gnp > L.gnp & L.gnp < .
. replace grew = 0 if grew >= . & L.gnp < .

or

. generate grew = (gnp > L.gnp) if L.gnp < .

13.9.2 Time-series operators and factor variables

As with varlists, factor variables may be combined with the L. (lag) and F. (lead) time-series
operators in expressions. We can generate a variable containing the lag of the level 2 indicator of

group (group = 2) by typing
. generate lag2group = 2L.group
The operators can be combined anywhere expressions are allowed. We can select observations for
which the lag of the second level of group is 1 by typing if i2L.group.

They can be combined in interactions. We can generate the lag of the interaction of sex = 1 with
group = 3 by typing
. generate laglsexX3grp = 1L.sex#2L.group

See [U] 11.4.3 Factor variables and [U] 11.4.4 Time-series varlists for more on factor variables
and time-series operators.

13.9.3 Operators within groups

Stata also understands panel or cross-sectional time-series data. For instance, if you type
. tsset country time
you are declaring that you have time-series data. The time variable is time, and you have time-series
data for separate countries.

Once you have tsset both cross-sectional and time identifiers, you proceed just as you would if
you had a simple time series.

. generate grew = (gnp > L.gnp) if L.gnp < .

would produce correct results. The L. operator will not confuse the observation at the end of one
panel with the beginning of the next.
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13.9.4 Video example

Time series, part 3: Time-series operators

13.10 Label values

If you have not read [U] 12.6 Dataset, variable, and value labels, please do so. You may use
labels in an expression in place of the numeric values with which they are associated. To use a label
in this way, type the label in double quotes followed by a colon and the name of the value label.

> Example 11

If the value label yesno associates the label yes with 1 and no with O, then "yes" :yesno (said
aloud as the value of yes under yesno) is evaluated as 1. If the double-quoted label is not defined
in the indicated value label, or if the value label itself is not found, a missing value is returned. Thus

the expression "maybe" :yesno is evaluated as missing.

. use http://www.stata-press.com/data/r13/gxmpl9, clear

. list
name answer
1. Mikulin no
2. Gaines no
3. Hilbe yes
4. DeLeon no
5. Cain no
6. Wann yes
7. Schroeder no
8. Cox no
9. Bishop no
10. Hardin yes
11. Lancaster yes
12. Poole no
. list if answer=="yes":yesno
name answer
3. Hilbe yes
6. Wann yes
10. Hardin yes
11. Lancaster yes

In the above example, the variable answer is not a string variable; it is a numeric variable that has
the associated value label yesno. Because yesno associates yes with 1 and no with 0, we could
have typed list if answer==1 instead of what we did type. We could not have typed list if
answer=="yes" because answer is not a string variable. If we had, we would have received the
error message “type mismatch”.

4


http://www.youtube.com/watch?v=ik8r4WvrPkc
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13.11 Precision and problems therein

Examine the following short Stata session:

. drop _all
. input x y

W N =
W N =
Q= =
W N =

en

. count if x==
1

. count if y==1.1

0
. list
X y
1. 1 1.1
2. 2 1.2
3. 3 1.3

We created a dataset containing two variables, x and y. The first observation has x equal to 1 and
y equal to 1.1. When we asked Stata to count the number of times that the variable x took on the
value 1, we were told that it occurred once. Yet when we asked Stata to count the number of times
y took on the value 1.1, we were told zero—meaning that it never occurred. What has gone wrong?
When we list the data, we see that the first observation has y equal to 1.1.

Despite appearances, Stata has not made a mistake. Stata stores numbers internally in binary form,
and the number 1.1 has no exact binary representation—that is, there is no finite string of binary
digits that is equal to 1.1.

Q Technical note

The number 1.1 in binary form is 1.0001100110011 ..., where the period represents the binary
point. The problem binary computers have with storing numbers like 1/10 is much like the problem
we base-10 users have in precisely writing 1/11, which is 0.0909090909 . ...

For detailed information about precision on binary computers and how Stata stores binary floating-
point numbers, see Gould (2011a).
a

The number that appears as 1.1 in the listing above is actually 1.1000000238419, which is off
by roughly 2 parts in 10%. Unless we tell Stata otherwise, it stores all numbers as floats, which
are also known as single-precision or 4-byte reals. On the other hand, Stata performs all internal
calculations in double, which is also known as double-precision or 8-byte reals. This is what leads
to the difficulty.

In the above example, we compared the number 1.1, stored as a float, with the number 1.1 stored
as a double. The double-precision representation of 1.1 is more accurate than the single-precision
representation, but it is also different. Those two numbers are not equal.

There are several ways around this problem. The problem with 1.1 apparently not equaling 1.1
would never arise if the storage precision and the precision of the internal calculations were the same.
Thus you could store all your data as doubles. This takes more computer memory, however, and it
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is unlikely that your data are really that accurate and the extra digits would meaningfully affect any
calculated result, even if the data were that accurate.

Q Technical note

This is unlikely to affect any calculated result because Stata performs all internal calculations
in double precision. This is all rather ironic, because the problem would also not arise if we had
designed Stata to use single precision for its internal calculations. Stata would be less accurate, but
the problem would have been completely disguised from the user, making this entry unnecessary.

a

Another solution is to use the float () function. float (x) rounds x to its float representation.
If we had typed count if y==float(1.1) in the above example, we would have been informed
that there is one such value.
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14.1 Overview

Stata has two matrix programming languages, one that might be called Stata’s older matrix language
and another that is called Mata. Stata’s Mata is the new one, and there is an uneasy relationship
between the two.

Below we discuss Stata’s older language and leave the newer one to another manual—the Mata
Reference Manual ([M])—or you can learn about the newer one by typing help mata.

We admit that the newer language is better in almost every way than the older language, but the
older one still has a use because it is the one that Stata truly and deeply understands. Even when
Mata wants to talk to Stata, matrixwise, it is the older language that Mata must use, so you must
learn to use the older language as well as the new.

This is not nearly as difficult, or messy, as you might imagine because Stata’s older language is
remarkably easy to use, and really, there is not much to learn. Just remember that for heavy-duty
programming, it will be worth your time to learn Mata, too.

14.1.1 Definition of a matrix

Stata’s definition of a matrix includes a few details that go beyond the mathematics. To Stata, a
matrix is a named entity containing an 7 X ¢ (0 < r < matsize, 0 < ¢ < matsize) rectangular
array of double-precision numbers (including missing values) that is bordered by a row and a column
of names.

161
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. matrix list A
A[3,2]

cl c2
rt 1 2
r2 3 4
r3 5 6
Here we have a 3 X 2 matrix named A containing elements 1, 2, 3, 4, 5, and 6. Row 1, column 2
(written A, 2 in math and A[1,2] in Stata) contains 2. The columns are named c1 and c2 and the
rows, rl, r2, and r3. These are the default names Stata comes up with when it cannot do better. The
names do not play a role in the mathematics, but they are of great help when it comes to labeling
the output.

The names are operated on just as the numbers are. For instance,

. matrix B=A’*A

. matrix list B

symmetric B[2,2]
cl c2

cl 35
c2 44 56

We defined B = A’A. The row and column names of B are the same. Multiplication is defined for
any a X b and b X ¢ matrices, the result being a x c. Thus the row and column names of the result
are the row names of the first matrix and the column names of the second matrix. We formed A’A,
using the transpose of A for the first matrix—which also interchanged the names—and so obtained
the names shown.

14.1.2 matsize

Matrices are limited to being no larger than matsize X matsize. The default value of matsize
is 400 for Stata/MP, Stata/SE, and Stata/IC, but you can reset this with the set matsize command;
see [R] matsize.

The maximum value of matsize is 800 for Stata/IC, so matrices are not suitable for holding many
data. This restriction does not prove a limitation because terms that appear in statistical formulas
are of the form (X’WZ) and Stata provides a command, matrix accum, for efficiently forming
such matrices; see [U] 14.6 Creating matrices by accumulating data below. The maximum value
of matsize is 11,000 for Stata/MP and Stata/SE, so performing matrix operations directly on many
data is more feasible. The matsize limit does not apply to Mata matrices; see the Mata Reference
Manual.

14.2 Row and column names

Matrix rows and columns always have names. Stata is smart about setting these names when
the matrix is created, and the matrix commands and operators manipulate these names throughout
calculations, so the names typically are set correctly at the conclusion of matrix calculations.

For instance, consider the matrix calculation b = (X'X)~!X'y performed on real data:

. use http://www.stata-press.com/data/r13/auto
(1978 Automobile Data)

. matrix accum XprimeX = weight foreign
(obs=74)

. matrix vecaccum yprimeX = mpg weight foreign
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. matrix b = invsym(XprimeX)*yprimeX’
. matrix list b
b[3,1]
mpg
weight -.00658789
foreign -1.6500291
_cons  41.679702

These names were produced without our ever having given a special command to place the names
on the result. When we formed matrix XprimeX, Stata produced the result

. matrix list XprimeX

symmetric XprimeX[3,3]

weight foreign _cons
weight 7.188e+08
foreign 50950 22
_cons 223440 22 74

matrix accum forms X’X matrices from data and sets the row and column names to the variable
names used. The names are correct in the sense that, for instance, the (1,1) element is the sum across
the observations of squares of weight and the (2,1) element is the sum of the product of weight
and foreign.

Similarly, matrix vecaccum forms y’X matrices, and it sets the row and column names to the
variable names used, so matrix vecaccum yprimeX = mpg weight foreign resulted in

. matrix list yprimeX

yprimeX[1,3]
weight foreign _cons
mpg 4493720 545 1576

The final step, matrix b = invsym(XprimeX)*yprimeX’, manipulated the names, and, if you think
carefully, you can derive the rules for yourself. invsym() (inversion) is much like transposition, so
row and column names must be swapped. Here, however, the matrix was symmetric, so that amounted
to leaving the names as they were. Multiplication amounts to taking the column names of the first
matrix and the row names of the second. The final result is

. matrix list b

b[3,1]

mpg

weight -.00658789
foreign -1.6500291
_cons  41.679702

and the interpretation is mpg = —0.00659 weight — 1.65 foreign + 41.68 + e.

Researchers realized long ago that using matrix notation simplifies the description of complex
calculations. What they may not have realized is that, corresponding to each mathematical definition
of a matrix operator, there is a definition of the operator’s effect on the names that can be used to
carry the names forward through long and complex matrix calculations.

14.2.1 The purpose of row and column names

Mostly, matrices in Stata are used in programming estimators, and Stata uses row and column
names to produce pretty output. Say that we wrote code—interactively or in a program—that produced
the following coefficient vector b and covariance matrix V:
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. matrix list b

b[1,3]
weight displacement _cons
yi -.00656711 .00528078 40.084522

. matrix list V

symmetric V[3,3]

weight displacement _cons
weight 1.360e-06
displacement -.0000103 .00009741
_cons -.00207455 .01188356 4.0808455

We could now produce standard estimation output by coding two more lines:

. ereturn post b V

. ereturn display

Coef. Std. Err. z P>zl [95% Conf. Intervall]

weight -.0065671 .0011662 -5.63 0.000 -.0088529 -.0042813
displacement .0052808 .0098696 0.54 0.593 -.0140632 .0246248
_cons 40.08452 2.02011 19.84 0.000 36.12518 44.04387

Stata’s ereturn command knew to produce this output because of the row and column names on
the coefficient vector and variance matrix. Moreover, we usually do nothing special in our code that
produces b and V to set the row and column names because, given how matrix names work, they
work themselves out.

Also, sometimes row and column names help us detect programming errors. Assume that we wrote
code to produce matrices b and V but made a mistake. Sometimes our mistake will result in the wrong
row and column names. Rather than the b vector we previously showed you, we might produce

. matrix list b

b[1,3]
weight c2 _cons
yl -.00656711 42.23  40.084522

If we posted our estimation results now, Stata would refuse because it can tell by the names that
there is a problem:

. ereturn post b V

name conflict
r(507);

Understand, however, that Stata follows the standard rules of matrix algebra; the names are just along
for the ride. Matrices are summed by position, meaning that a directive to form C = A + B results
in C1; = Aq1 + Bi1, regardless of the names, and it is not an error to sum matrices with different
names:
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. matrix list a

symmetric a[3,3]

cl

mpg 14419
weight 1221120 1.21

_cons 545

. matrix list b

symmetric b[3,3]

cl
displacement 3211055
mpg 227102

_cons 12153
. matrix c = a + b
. matrix list c
symmetric c[3,3]
cl
displacement 3225474

mpg 1448222
_cons 12698

c2

9e+08
50950

c2

22249
1041

c2

1.219e+08
51991

c3

22

c3

52

c3

74

Matrix row and column names are used to label output; they do not affect how matrix algebra is

performed.

14.2.2 Two-part names

Row and column names have two parts separated by a colon: equation_name: opvarname.

In the examples shown so far, the equation_name has been blank and the opvarnames have been
simple variable names without factor-variable or time-series operators. A blank equation_name is
typical. Run any single-equation model (such as regress, probit, or logistic), and if you fetch
the resulting matrices, you will find that they have row and column names that use only opvarnames.

Those who work with time-series data will find matrices with row and column names of the
form opvarname. For time-series variables, opvarname is the variable name prefixed by a time-series
operator such as L., D., or L2D.; see [U] 11.4.4 Time-series varlists. For example,
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. matrix list examplel

symmetric examplel[3,3]

L.
rate rate _cons
rate 3.0952534
L.rate .0096504 .00007742

_cons -2.8413483 -.01821928 4.8578916

We obtained this matrix by running a linear regression on rate and L.rate and then fetching the
covariance matrix. Think of the row and column name L.rate no differently from how you think of
rate or, in the previous examples, r1, r2, cl, c2, weight, and foreign.

Those who work with factor variables will also find row and column names of the opvarname
form. For factor variables, opvarname is any factor-variable construct that references a single virtual
indicator variable. For example, 3. group refers to the virtual variable that is 1 when group = 3 and
is O otherwise, 1.sex#3.group refers to the virtual variable that is 1 when sex = 1 and group = 3
and is O otherwise, and 1.sex#c.age refers to the virtual variable that takes on the values of age
when sex = 1 and is O otherwise. For example,

. matrix list example2

symmetric example2[5,5]

Ob. 1. Ob.sex# 1.sex#
sex sex c.age c.age _cons
Ob.sex 0
1.sex 0 7.7785864
Ob.sex#
c.age 0 .08350827 .00231307
1.sex#c.age 0 -.09705697 -1.977e-16 .00223195
_cons 0 -3.2868185 -.08350827 7.688e-15 3.2868185

1.sex#c.age is a row name and column name just like rate or L.rate in the prior example.
For details on factor variables and valid factor-variable constructs see [U] 11.4.3 Factor variables,
[U] 25 Working with categorical data and factor variables, [U] 13.8 Indicator values for levels of
factor variables, and [U] 20.11 Accessing estimated coefficients.

Factor-variable operators may be combined with the time-series operators L. and F., leading to
opvarnames such as 1L.sex (the first lag of the level 1 indicator of sex) and 3L2.group (the second
lag of the level 3 indicator of group).

Equation names are used to label partitioned matrices and, in estimation, occur in the context of
multiple equations. Here is a matrix with equation_names and simple (unoperated) opvarnames.

. matrix list example3

symmetric example2[5,5]

mpg: mpg: mpg: mpg: mpg:
foreign displ _cons foreign _cons
mpg:foreign 1.6483972
mpg:displ .004747 .00003876

mpg:_cons -1.4266352 -.00905773 2.4341021
weight:foreign -51.208454 -4.665e-19 15.224135  24997.727
weight:_cons 15.224135 2.077e-17 -15.224135 -7431.7565  7431.7565
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Here is an example with equation_names and operated variable names:

. matrix list example4

symmetric example3[5,5]

val:rate
val:L.rate
val:_cons
weight:foreign
weight:_cons

val:

rate
2.2947268
.00385216
-1.4533912
-163.86684
49.384526

val: val:
L.
rate _cons
.0000309
-.0072726 2.2583357
7.796e-17 49.384526
-1.566e-16 -49.384526

weight: weight:
foreign _cons
25351.696
-7640.237 7640.237

val:L.rate is a column name, just as, in the previous section, c2 and foreign were column names.

Say that this last matrix is the variance matrix produced by a program we wrote and that our
program also produced a coefficient vector, b:

. matrix list b

b[1,5]
val: val: val: weight: weight:
L.
rate rate _cons foreign _cons
yl  4.5366753 -.00316923 20.68421 -1008.7968  3324.7059
Here is the result of posting and displaying the results:
. ereturn post b exampled
. ereturn display
Coef.  Std. Err. z P>|z| [95% Conf. Intervall
val
rate
— 4.536675  1.514836 2.995 0.003 1.567652 7.505698
L1 -.0031692  .0055591 -0.570 0.569 -.0140648 .0077264
_cons 20.68421  1.502776 13.764  0.000 17.73882 23.6296
weight
foreign -1008.797  159.2222 -6.336 0.000 -1320.866 -696.7271
_cons 3324.706  87.40845 38.036  0.000 3153.388 3496.023

We have been using matrix list to see the row and column names on our matrices because
matrix list works on all matrices. There is a better way to see the names when we are working
with estimation results because estimation results have the same names on the rows and columns
of the variance matrix, and those same names are also the column names for the coefficient vector.
That better way is the coeflegend display option available on almost every estimation command.

For example,
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. sureg (y = sex##group) (distance = d.age il2.sex)

(output omitted )
. sureg, coeflegend

Seemingly unrelated regression

Equation Obs Parms RMSE "R-sq" chi2 P
y 2998 5 20.03657 0.1343 464.08 0.0000
distance 2998 2 181.3797 0.0005 0.92 0.6314
Coef. Legend
y
sex
female 21.59726 _bly:1.sex]
group
2 11.42832 _Dbly:2.group]
3 21.6461 _bly:3.group]
sex#group
female 2 -4.892653 _bly:1.sex#2.group]
female 3 -6.220653 _bly:1.sex#3.group]
_cons 50.5957 _Dbly:_cons]
distance
age
D1. .2230927 _b[distance:D.agel
L2.sex
female 1.300898 _bl[distance:1L2.sex]
_cons 57.96172 _b[distance:_cons]

We could have used matrix list e(V) or matrix list e(b) to see the names, but the
limited space available to matrix list to write the names would have made the names more
difficult to read. With coeflegend, the names are neatly arrayed in their own Legend column. One
difference between matrix list and the coeflegend option is that coeflegend brackets the names
with _b[]. That is because coeflegend’s primary use is to show us how to type coefficients in
expressions and postestimation commands; see [U] 13.5 Accessing coefficients and standard errors

and [U] 20.11 Accessing estimated coefficients. There the _b[] is required.

14.2.3 Setting row and column names

You reset row and column names by using the matrix rownames and matrix colnames commands.

Before resetting the names, use matrix list to verify that the names are not set correctly; often,
they already are. When you enter a matrix by hand, however, the row names are unimaginatively set

to rl, r2, ..., and the column names to ci1, c2, ....

. matrix a = (1,2,3\4,5,6)
. matrix list a
al2,3]
cl c2 «c3
ri 1 2 3
r2 4 5 6
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Regardless of the current row and column names, matrix rownames and matrix colnames reset
them:

. matrix colnames a = foreign alpha _cons

. matrix rownames a = one two

. matrix list a

al2,3]

foreign alpha _cons
one 1 2 3
two 4 5 6

You may set the operator as part of the opvarname,

. matrix colnames a = foreign l.rate _cons

. matrix list a

al2,3]
L.
foreign rate _cons
one 1 2 3
two 4 5 6

The names you specify may be any virtual factor-variable indicators, and those names may include
the base (b.) and omitted (o.) operators,
. matrix colnames b = Ob.sex 20.arm 1.sex#c.age 1.sex#3.group#2.arm

. matrix list b

b[2,4]
1.sex#
Ob. 20. 1.sex# 3.group#
sex arm c.age 2.arm
one 1 2 3 3
two 5 6 7 8

See [U] 11.4.3 Factor variables for more about factor-variable operators.

You may set equation names:

. matrix colnames a = this:foreign this:1l.rate that:_cons

. matrix list a

a[2,3]
this: this: that:
L.
foreign rate _cons
one 1 2 3
two 4 5 6

See [P] matrix rownames for more information.

14.2.4 Obtaining row and column names

matrix list displays the matrix with its row and column names. In a programming context, you
can fetch the row and column names into a macro using

local ... : rowfullnames matname
local ... : colfullnames matname
local ... : rownames matname
local ... : colnames matname
local ... : roweq matname

local ... : coleq matname
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rowfullnames and colfullnames return the full names (equation_name:opvarnames) listed one
after the other.

rownames and colnames omit the equations and return opvarnames, listed one after the other.
roweq and coleq return the equation names, listed one after the other.

See [P] macro and [P] matrix define for more information.

14.3 Vectors and scalars

Stata does not have vectors as such—they are considered special cases of matrices and are handled
by the matrix command.

Stata does have scalars, although they are not strictly necessary because they, too, could be handled
as special cases. See [P] scalar for a description of scalars.

14.4 Inputting matrices by hand

You input matrices using

matrix input matname = (...)
or

matrix matname = (...)

In either case, you enter the matrices by row. You separate one element from the next by using
commas (,) and one row from the next by using backslashes (\). If you omit the word input, you
are using the expression parser to input the matrix:

. matrix a = (1,2\3,4)

. matrix list a

a[2,2]

cl c2
rl 1 2
r2 3 4

This has the advantage that you can use expressions for any of the elements:

. matrix b = (1, 2+3/2 \ cos(_pi), _pi)

. matrix list b

b[2,2]

cl c2
rl 1 3.5
r2 -1 3.1415927

The disadvantage is that the matrix must be small, say, no more than 50 elements (regardless of the
value of matsize).

matrix input has no such restriction, but you may not use subexpressions for the elements:

. matrix input ¢ = (1,2\3,4)

. matrix input d = (1, 2+3/2 \ cos(_pi), _pi)
invalid syntax
r(198);
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Either way, after inputting the matrix, you will probably want to set the row and column names; see
[U] 14.2.3 Setting row and column names above.

For small matrices, you may prefer entering them in a dialog box. Launch the dialog box from the
menu Data > Matrices, ado language > Input matrix by hand, or by typing db matrix_input.
The dialog box is particularly convenient for small symmetric matrices.

14.5 Accessing matrices created by Stata commands

Some Stata commands—including all estimation commands—Ileave behind matrices that you can
subsequently use. After executing an estimation command, type ereturn 1ist to see what is available:

. use http://www.stata-press.com/data/r13/auto
(1978 Automobile Data)

. probit foreign mpg weight

(output omitted )

. ereturn list

scalars:
e(rank) 3
e() 74
e(ic) = 5
e(k) 3
e(k_eq) = 1
e(k_dv) 1
e(converged) = 1
e(rc) 0
e(11) = -26.84418900579868
e(k_eq_model) 1
e(11_0) = -45.03320955699139
e(df_m) = 2
e(chi2) 36.37804110238542
e(p) = 1.26069126402e-08
e(N_cdf) 0
e(N_cds) = 0
e(r2_p) .4039023807124773

macros:
e(cmdline)

"probit foreign mpg weight"

e(cmd) "probit"
e(estat_cmd) : "probit_estat"
e(predict) : "probit_p"
e(title) "Probit regression"
e(chi2type) "LR"
e(opt) "moptimize"
e(vce) "oim"
e(user) "mopt__probit_d2()"
e(ml_method) "d2"
e(technique) "nr"
e(which) "max"
e(depvar) "foreign"
e(properties) "b V"
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matrices:
e(b)
e (V)
e(mns)
e(rules)
e(ilog)
e(gradient)

[l o R GV I
[l B o T B
WN P> WWww

functions:
e(sample)

Most estimation commands leave behind e(b) (the coefficient vector) and e(V) (the variance—
covariance matrix of the estimator):

. matrix list e(b)

e(b) [1,3]
foreign: foreign: foreign:
mpg weight _cons
yl -.10395033 -.00233554 8.275464

You can refer to e(b) and e(V) in any matrix expression:

. matrix myb = e(b)
. matrix list myb

myb[1,3]
foreign: foreign: foreign:
mpg weight _cons
yl -.10395033 -.00233554 8.275464

. matrix c = e(b)*invsym(e(V))*e(b)’
. matrix list c

symmetric c[1,1]
yi
y1l 22.440542

14.6 Creating matrices by accumulating data

In programming estimators, matrices of the form X'X, X'Z, X’'WX, and X’WZ often occur,
where X and Z are data matrices. matrix accum, matrix glsaccum, matrix vecaccum, and
matrix opaccum produce such matrices; see [P] matrix accum.

We recommend that you not load the data into a matrix and use the expression parser directly to
form such matrices, although see [P] matrix mkmat if that is your interest. If that is your interest,
be sure to read the technical note at the end of [P] matrix mkmat. There is much to recommend
learning how to use the matrix accum commands.

14.7 Matrix operators

You can create new matrices or replace existing matrices by typing
matrix matname = matrix_expression
For instance,

. matrix A = invsym(R*V*R’)
. matrix IAR = I(rowsof(A)) - A*R
. matrix beta = b*IAR’ + rxA’

. matrix C = -C’

. matrix D = (A, B \ B’, A)
. matrix E = (A+B)*C’

. matrix S = (S+S’)/2
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The following operators are provided:

Operator

Symbol

Unary operators
negation
transposition

Binary operators

(lowest precedence)
row join
column join
addition
subtraction
multiplication
division by scalar
Kronecker product

(highest precedence)

HFN* I+ -

Parentheses may be used to change the order of evaluation.

Note in particular that , and \ are operators; (1,2) creates a 1 X 2 matrix (vector), and (A,B)
creates a rowsof (A) X colsof (A)+colsof (B) matrix, where rowsof (A) = rowsof (B). (1\2)
creates a 2 X 1 matrix (vector), and (A\B) creates a rowsof (A)+rowsof (B) X colsof (A) matrix,
where colsof (A) = colsof (B). Thus expressions of the form

matrix R = (A,B)*Vinv#*(A,B)’

are allowed.

14.8 Matrix functions

In addition to the functions listed below, see [P] matrix svd for singular value decomposition,
[P] matrix symeigen for eigenvalues and eigenvectors of symmetric matrices, and see [P] matrix
eigenvalues for eigenvalues of nonsymmetric matrices. For a full description of the matrix functions,

see [D] functions.

Matrix functions returning matrices:

cholesky (M) I(n)

corr(M) inv(M)

diag(v) invsym (M)

get (systemname) J(r,c,z)
hadamard(M ,N) matuniform(r,c)

Matrix functions returning scalars:

colnumb (M ,s) el(M,i,7)
colsof (M) issymmetric (M)
det (M) matmissing (M)

diagOcnt (M) mreldif (X,Y)

nullmat (matname)
sweep (M ,7)

vec (M)
vecdiag(M)

rownumb (M ,s)
rowsof (M)
trace (M)
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14.9 Subscripting

L.

In matrix and scalar expressions, you may refer to matnamel[r,c], where r and c are scalar
expressions, to obtain one element of matname as a scalar.

Examples:
matrix A=A / A[1,1]
generate newvar = oldvar / A[2,2]

. In matrix expressions, you may refer to matname[s, ,s.], where s, and s. are string expressions,

to obtain a submatrix with one element. The element returned is based on searching the row and
column names.

Examples:
matrix B = V["price","price"]
generate sdif = dif / sqrt(V["price","price"])

. In matrix expressions, you may mix these two syntaxes and refer to matnamelr,s.] or to

matname s, ,c].

Example:
matrix b =Db * R[1,"price"]

. In matrix expressions, you may use matname[ry..7r2,c1 . .co] to refer to submatrices; 71, 12, c1,

and ¢ may be scalar expressions. If ry evaluates to missing, it is taken as referring to the last
row of matname; if co evaluates to missing, it is taken as referring to the last column of matname.
Thus matnamelry...,c1...] is allowed.

Examples:
matrix S = Z[1..4, 1..4]
matrix R =Z[5..., 5...]

. In matrix expressions, you may refer to matname[s,1..572,5.1..5c2] to refer to submatrices

where S,1, Sr2, Sc1, and Sco, are string expressions. The matrix returned is based on looking up
the row and column names.

If the string evaluates to an equation name only, all the rows or columns for the equation are
returned.

Examples:

matrix S = Z["price".."weight", "price".."weight"]

matrix L = D["mpg:price".."mpg:weight", "mpg:price".."mpg:weight"]
matrix T1 = C["mpg:", "mpg:"]

matrix T2 = C["mpg:", "price:"]

. In matrix expressions, any of the above syntaxes may be combined.

Examples:
matrix T1 = C["mpg:", "price:weight".."price:displ"]
matrix T2 = C["mpg:", "price:weight"...]

matrix T3 = C["mpg:price", 2..5]
matrix T4 = C["mpg:price", 2]
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7. When defining an element of a matrix, use
matrix matnameli,j] = expression

where ¢ and j are scalar expressions. The matrix matname must already exist.

Example:
matrix A = J(2,2,0)
matrix A[1,2] = sqrt(2)

8. To replace a submatrix within a matrix, use the same syntax. If the expression on the right evaluates
to a scalar or 1 X 1 matrix, the element is replaced. If it evaluates to a matrix, the submatrix with
top-left element at (4, j) is replaced. The matrix matname must already exist.

Example:
matrix A = J(4,4,0)
matrix A[2,2] = C’*C

14.10 Using matrices in scalar expressions

Scalar expressions are documented as exp in the Stata manuals:

generate newvar = exp if exp ...
replace newvar = exp if exp ...
regress ... if exp ...

if exp {... }

while exp {... }

Most importantly, scalar expressions occur in generate and replace, in the if exp modifier allowed
on the end of many commands, and in the if and while commands for program control.

You will rarely need to refer to a matrix in any of these situations except when using the if and
while commands.

In any case, you may refer to matrices in any of these situations, but the expression cannot require
evaluation of matrix expressions returning matrices. Thus you could refer to trace(A) but not to
trace (A+B).

It can be difficult to predict when an evaluation of an expression requires evaluating a matrix;
even experienced users can be surprised. If you get the error message “matrix operators that return
matrices not allowed in this context”, r(509), you have encountered such a situation.

The solution is to split the line in two. For instance, you would change
if trace(A+B)==0 {

}

to
matrix AplusB = A+B
if trace(AplusB)==0 {
}

or even to

matrix Trace = trace(A+B)
if Trace[1,1]==0 {

}
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14.11 Reference
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15.1

Overview

Stata can record your session into a file called a log file but does not start a log automatically; you
must tell Stata to record your session. By default, the resulting log file contains what you type and what
Stata produces in response, recorded in a format called Stata Markup and Control Language (SMCL);
see [P] smcl. The file can be printed or converted to plain text for incorporation into documents you
create with your word processor.

To start a log:
Your session is now being recorded
in file filename .smcl.

To temporarily stop logging:
Temporarily stop:
Resume:
To stop logging and close the file:
You can now print filename.smcl or type:
to create filename.log that you can
load into your word processor.
You can also create a PDF of filename . smcl
on Windows or Mac:

. log using filename

. log off
. log on

. log close
. translate filename.sncl filename.log

. translate filename.smcl filename.pdf

Alternative ways to start logging:
append to an existing log:
replace an existing log:

. log using filename, append
. log using filename, replace

Using the GUI:
To start a log:
To temporarily stop logging:
To resume:
To stop logging and close the file:
To print previous or current log:

click on the Log button

click on the Log button, and choose Suspend
click on the Log button, and choose Resume
click on the Log button, and choose Close
select File > View..., choose file,

right-click on the Viewer, and select Print

Also, cmdlog will produce logs containing solely what you typed—logs that, although not containing

your results, are sufficient to re-create the session.

To start a command-only log:

To stop logging and close the file:

To re-create your session:

. cmdlog using filename

. cmdlog close

. do filename.txt
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15.1.1 Starting and closing logs

With great foresight, you begin working in Stata and type log using session (or click on the
Log button) before starting your work:

. log using session

name: <unnamed>
log: C:\example\session.smcl
log type: smcl
opened on: 17 Mar 2013, 12:35:08

. use http://www.stata-press.com/data/r13/censusb
(1980 Census data by state)

. tabulate region [freq=popl

Census
region Freq. Percent Cum.
NE | 49,135,283 21.75 21.75
N Cntrl | 58,865,670 26.06 47.81
South | 74,734,029 33.08 80.89
West | 43,172,490 19.11 100.00
Total (225,907,472 100.00
. summarize median_age
Variable | Obs Mean Std. Dev. Min Max
median_age | 50 29.54 1.693445 24.2 34.7

. log close
name: <unnamed>
log: C:\example\session.smcl
log type: smcl
closed on: 17 Mar 2013, 12:35:38

There is now a file named session.smcl on your disk. If you were to look at it in a text editor or
word processor, you would see something like this:

{smcl}
{com}{sf}{ul off}{txt}{.-}
name: {res}<unnamed>
{txt}log: {res}C:\example\session.smcl
{txt}log type: A{resl}smcl
{txt}opened on: {res}17 Mar 2013, 12:35:08

{com}. use http://www.stata-press.com/data/r13/censusb
{txt} (1980 Census data by state)

{com}. tabulate region [freq=pop]

{txt}Census {c |}
region {c |} Freq. Percent Cum.
{hline 12}{c +}{hline 35}

NE {c |}{res} 49,135,283 21.75 21.75
{txt} N Cntrl {c |}{res} 58,865,670 26.06 47.81
(output omitted )

What you are seeing is SMCL, which Stata understands. Here is the result of typing the file using
Stata’s type command:
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. type session.smcl

name: <unnamed>
log: C:\example\session.smcl
log type: smcl
opened on: 17 Mar 2013, 12:35:08

. use http://www.stata-press.com/data/r13/censusb
(1980 Census data by state)

. tabulate region [freq=pop]

Census
region Freq. Percent Cum.
NE | 49,135,283 21.75 21.75
N Cntrl 58,865,670 26.06 47.81
South | 74,734,029 33.08 80.89
West 43,172,490 19.11 100.00
Total |225,907,472 100.00
. summarize median_age
Variable | Obs Mean Std. Dev. Min Max
median_age | 50 29.54 1.693445 24.2 34.7
. log close
name: <unnamed>
log: C:\example\session.smcl
log type: smcl
closed on: 17 Mar 2013, 12:35:38

What you will see is a perfect copy of what you previously saw. If you use Stata to print the file,
you will get a perfect printed copy, too.

SMCL files can be translated to plain text, which is a format more useful for inclusion into a
word processing document. If you type translate filename.smcl filename.log, Stata will translate
filename . smcl to text and store the result in filename .log;:

. translate session.smcl session.log

The resulting file session.log looks like this:

name: <unnamed>
log: C:\example\session.smcl
log type: smcl
opened on: 17 Mar 2013, 12:35:08

. use http://www.stata-press.com/data/r13/censusb

(1980 Census data by state)
. tabulate region [freq=popl

Census |
region | Freq. Percent Cum.
NE | 49,135,283 21.75 21.75
N Cntrl | 58,865,670 26.06 47.81
South | 74,734,029 33.08 80.89

(output omitted )

When you use translate to create filename.log from filename.smcl, filename.log must not

already exist:
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. translate session.smcl session.log
file session.log already exists
r(602);

If the file does already exist and you wish to overwrite the existing copy, you can specify the replace
option:

. translate session.smcl session.log, replace

See [R] translate for more information.

On Windows and Mac, you can also convert your SMCL file to a PDF to share it more easily with
others:

. translate session.smcl session.pdf
See [R] translate for more information.

If you prefer, you can skip the SMCL and create text logs directly, either by specifying that you
want the log in text format,

. log using session, text

or by specifying that the file to be created be a .1log file:

. log using session.log

15.1.2 Appending to an existing log

Stata never lets you accidentally write over an existing log file. If you have an existing log file
and you want to continue logging, you have three choices:

e create a new log file
e append the new log onto the existing log file by typing log using logname, append
e replace the existing log file by typing log using logname, replace

For example, if you have an existing log file named session.smcl, you might type

. log using session, append

to append the new log to the end of the existing log file, session.smcl.

15.1.3 Suspending and resuming logging

Once you have started logging your session, you can turn logging on and off. When you turn
logging off, Stata temporarily stops recording your session but leaves the log file open. When you
turn logging back on, Stata continues to record your session, appending the additional record to the
end of the file.

Say that the first time something interesting happens, you type log using results (or click on
Log and open results.smcl). You then retype the command that produced the interesting result (or
double-click on the command in the Review window, or use the PgUp key to retrieve the command;
see [U] 10 Keyboard use). You now have a copy of the interesting result saved in the log file.

You are now reasonably sure that nothing interesting will occur, at least for a while. Rather than
type log close, however, you type log off, or you click on Log and choose Suspend. From now
on, nothing goes into the file. The next time something interesting happens, you type log on (or
click on Log and choose Resume) and reissue the (interesting) command. After that, you type log
off. You keep working like this—toggling the log on and off.
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15.2 Placing comments in logs

Stata treats lines starting with a “*” as comments and ignores them. Thus, if you are working

@y

interactively and wish to make a comment, you can type “*” followed by your comment:

. * check that all the spells are completed

Stata ignores your comment, but if you have a log going the comment now appears in the file.

Q Technical note

log can be combined with #review (see [U] 10 Keyboard use) to bail you out when you have
not adequately planned ahead. Say that you have been working in front of your computer, and you
now realize that you have done what you wanted to do. Unfortunately, you are not sure exactly what
it is you have done. Did you make a mistake? Could you reproduce the result? Unfortunately, you
have not been logging your output. Typing #review will allow you to look over what commands
you have issued, and, combined with log, will allow you to make a record. You can also see the
commands that you have issued in the Review window. You can save those commands to a file by
selecting the commands to save, right-clicking on the Review window, and selecting Save Selected....

Type log using filename. Type #review 100. Stata will list the last 100 commands you gave,
or however many it has stored. Because log is making a record, that list will also be stored in the
file. Finally, type log close.

a

15.3 Logging only what you type

Log files record everything that happens during a session, both what you type and what Stata
produces in response.

Stata can also produce command log files—files that contain only what you type. These files are
perfect for later going back and creating a Stata do-file.

cmdlog creates command log files, and its basic syntax is

cmdlog using filename |, append replace] creates filename.txt

cmdlog off temporarily suspends command logging
cmdlog on resumes command logging
cmdlog close closes the command log file

See [R] log for all the details.
Command logs are plain text files. If you typed

. cmdlog using session
(cmdlog C:\example\session.txt opened)
. use http://www.stata-press.com/data/r13/censusb
(Census Data)
. tabulate region [freq=pop]
(output omitted )
. summarize median_age
(output omitted )

. cmdlog close
(cmdlog C:\example\session.txt closed)
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file mycmds.txt would contain

use http://www.stata-press.com/data/r13/censusb
tabulate region [freq=popl]
summarize median_age

You can create both kinds of logs—full session logs and command logs—simultaneously, if you
wish. A command log file can later be used as a do-file; see [R] do.

15.4 The log-button alternative
The capabilities of the log command (but not the cmdlog command) are available from Stata’s
GUI interface; just click on the Log button or select Log from the File menu.

You can use the Viewer to view logs, even logs that are in the process of being created. Just select
File > View.... If you are currently logging, the filename to view will already be filled in with the
current log file, and all you need to do is click on OK. Periodically, you can click on the Refresh
button to bring the Viewer up to date.

You can also use the Viewer to view previous logs.

You can access the Viewer by selecting File > View..., or you can use the view command:

. view myoldlog.smcl

15.5 Printing logs
You print logs from the Viewer. Select File > View..., or type view logfilename from the command
line to load the log into the Viewer, and then right-click on the Viewer and select Print.

You can also print logs by other means; see [R] translate.

15.6 Creating multiple log files for simultaneous use

Programmers or advanced users may want to create more than one log file for simultaneous use.
For example, you may want a log file of your whole session but want a separate log file for part of
your session.

You can create multiple logs by using log’s name () option; see [R] log.
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16.1 Description

Rather than typing commands at the keyboard, you can create a text file containing commands
and instruct Stata to execute the commands stored in that file. Such files are called do-files because
the command that causes them to be executed is do.

A do-file is a standard text file that is executed by Stata when you type do filename. You can
use any text editor or the built-in Do-file Editor to create do-files; see [GSW] 13 Using the Do-file
Editor—automating Stata. Using do-files rather than typing commands with the keyboard or using
dialog boxes offers several advantages. By writing the steps you take to manage and analyze your
data in the form of a do-file, you can reproduce your work later. Also, writing a do-file makes
the inevitable debugging process much easier. If you decide to change one part of your analysis,
changing the relevant commands in your do-file is much easier than having to start back at square
one, as is often necessary when working interactively. In this chapter, we describe the mechanics of
do-files. Long (2009) cogently argues that do-files should be used in all research projects and offers
an abundance of time-tested advice in how to manage data and statistical analysis.

> Example 1

You can use do-files to create a batchlike environment in which you place all the commands you
want to perform in a file and then instruct Stata to do that file. Assume that you use your text editor
or word processor to create a file called myjob.do that contains these three lines:

begin myjob.do
use http://www.stata-press.com/data/r13/censusb

tabulate region

summarize marriage_rate divorce_rate median_age if state!="Nevada"

end myjob.do

183



184 [U] 16 Do-files

You then enter Stata and instruct Stata to do the file:

. do myjob

. use http://www.stata-press.com/data/r13/censusb
(1980 Census data by state)

. tabulate region

Census
region Freq. Percent Cum.
NE 9 18.00 18.00
N Cntrl 12 24.00 42.00
South 16 32.00 74.00
West 13 26.00 100.00
Total 50 100.00
. summarize marriage_rate divorce_rate median_age if state !="Nevada"
Variable Obs Mean Std. Dev. Min Max
marriage_r~e 49 .0106791 .0021746 .0074654 .0172704
divorce_rate 49 .0054268 .0015104 .0029436 .008752
median_age 49 29.52653 1.708286 24.2 34.7

You typed only do myjob to produce this output. Because you did not specify the file extension,
Stata assumed you meant do myjob.do; see [U] 11.6 Filenaming conventions.

N

16.1.1 Version

We recommend that the first line in your do-file declare the Stata release you used when you wrote
the do-file; myjob.do would read better as

begin myjob.do
version 13

use http://www.stata-press.com/data/r13/censusb

tabulate region

summarize marriage_rate divorce_rate median_age if state!="Nevada"

end myjob.do

We admit that we do not always follow our own advice, as you will see many examples in this
manual that do not include the version 13 line.

If you intend to keep the do-file, however, you should include this line because it ensures that your
do-file will continue to work with future versions of Stata. Stata is under continual development, and
sometimes things change in surprising ways.

For instance, in Stata 3.0, a new syntax for specifying the weights was introduced. If you had an
old do-file written for Stata 2.1 that analyzed weighted data and did not have version 2.1 at the
top, you would find that today’s Stata would flag some of the file’s lines as syntax errors. If you had
the version 2.1 line, it would work just as it used to.

Skipping ahead to Stata 10, we introduced xtset and declared that, to use the xt commands, you
must xtset your data first. Previously, you specified options on the end of each xt command that
identified the group and, optionally, the time variables. Despite this change, if you include version 9
or earlier at the top of your do-file, the xt commands will continue to work the old way.

For an overview of versioning and an up-to-date list of the issues that versioning does not address
automatically, see help version.
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When running an old do-file that includes a version statement, you need not worry about setting
the version back after it has completed. Stata automatically restores the previous value of version
when the do-file completes.

16.1.2 Comments and blank lines in do-files

You may freely include blank lines in your do-file. In the previous example, the do-file could just
as well have read

begin myjob.do
version 13

use http://www.stata-press.com/data/r13/censusb

tabulate region

summarize marriage_rate divorce_rate median_age if state!="Nevada"

end myjob.do

There are four ways to include comments in a do-file.
1. Begin the line with a ‘*’; Stata ignores such lines. * cannot be used within Mata.
2. Place the comment in /* */ delimiters.

3. Place the comment after two forward slashes, that is, //. Everything after the // to the end of
the current line is considered a comment (unless the // is part of http://...).

4. Place the comment after three forward slashes, that is, ///. Everything after the /// to the
end of the current line is considered a comment. However, when you use ///, the next line
joins with the current line. /// lets you split long lines across multiple lines in the do-file.

Q Technical note

The /* %/, //, and /// comment indicators can be used in do-files and ado-files only; you may
not use them interactively. You can, however, use the ‘*’ comment indicator interactively.
Q

myjob.do then might read

begin myjob.do
* a sample analysis job

version 13

use http://www.stata-press.com/data/r13/censusb

/* obtain the summary statistics: */

tabulate region

summarize marriage_rate divorce_rate median_age if state!="Nevada"

end myjob.do

or equivalently,

begin myjob.do
// a sample analysis job

version 13

use http://www.stata-press.com/data/r13/censusb

// obtain the summary statistics:

tabulate region

summarize marriage_rate divorce_rate median_age if state!="Nevada"

end myjob.do

The style of comment indicator you use is up to you. One advantage of the /* */ method is that it
can be put at the end of lines:
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begin myjob.do
* a sample analysis job
version 13
use http://www.stata-press.com/data/r13/censusb
tabulate region /* obtain summary statistics */
summarize marriage_rate divorce_rate median_age if state!="Nevada"

end myjob.do
In fact, /* */ can be put anywhere, even in the middle of a line:
begin myjob.do

* a sample analysis job
version 13

use /* confirm this is latest */ http://www.stata-press.com/data/r13/censusb

tabulate region /* obtain summary statistics */
summarize marriage_rate divorce_rate median_age if state!="Nevada"

end myjob.do

You can achieve the same results with the // and /// methods:
begin myjob.do

// a sample analysis job
version 13
use http://www.stata-press.com/data/r13/censusb
tabulate region // obtain summary statistics
summarize marriage_rate divorce_rate median_age if state!="Nevada"

end myjob.do

or
begin myjob.do

// a sample analysis job
version 13
use /// confirm this is latest
http://www.stata-press.com/data/r13/censusb
tabulate region // obtain summary statistics
summarize marriage_rate divorce_rate median_age if state!="Nevada"

end myjob.do

16.1.3 Long lines in do-files

When you use Stata interactively, you press Enter to end a line and tell Stata to execute it. If you
need to type a line that is wider than the screen, you simply do it, letting it wrap or scroll.

You can follow the same procedure in do-files—if your editor or word processor will let you—but
you can do better. You can change the end-of-line delimiter to ;’ by using #delimit, you can
comment out the line break by using /* */ comment delimiters, or you can use the /// line-join
indicator.
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> Example 2

In

the following fragment of a do-file, we temporarily change the end-of-line delimiter:

fragment of example.do
use mydata
#delimit ;
summarize weight price displ headroom rep78 length turn gear_ratio

if substr(company,1,4)=="Ford" |

substr(company,1,2)=="GM", detail ;

gen byte ford = substr(company,1,4)=="Ford"
#delimit cr
gen byte gm = substr(company,1,2)=="GM"

fragment of example.do

Once we change the line delimiter to semicolon, all lines, even short ones, must end in semicolons.
Stata treats carriage returns as no different from blanks. We can change the delimiter back to carriage
return by typing #delimit cr.

The #delimit command is allowed only in do-files—it is not allowed interactively. You need
not remember to set the delimiter back to carriage return at the end of a do-file because Stata will
reset it automatically.

> Example 3

4

The other way around long lines is to comment out the carriage return by using /* */ comment
brackets or to use the /// line-join indicator. Thus our code fragment could also read

fragment of example.do
use mydata
summarize weight price displ headroom rep78 length turn gear_ratio /*
*/ if substr(company,1,4)=="Ford" | /*
*/ substr(company,1,2)=="GM", detail
gen byte ford = substr(company,1,4)=="Ford"
gen byte gm = substr(company,1,2)=="GM"

or

fragment of example.do

fragment of example.do
use mydata
summarize weight price displ headroom rep78 length turn gear_ratio ///
if substr(company,1,4)=="Ford" | ///
substr(company,1,2)=="GM", detail
gen byte ford = substr(company,1,4)=="Ford"
gen byte gm = substr(company,1,2)=="GM"

fragment of example.do
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16.1.4 Error handling in do-files

A do-file stops executing when the end of the file is reached, an exit is executed, or an error
(nonzero return code) occurs. If an error occurs, the remaining commands in the do-file are not
executed.

If you press Break while executing a do-file, Stata responds as though an error has occurred,
stopping the do-file. This happens because the return code is nonzero; see [U] 8 Error messages and
return codes for an explanation of return codes.

> Example 4
Here is what happens when we execute a do-file and then press Break:

. do myjob2
. version 13

. use census
(Census data)

. tabulate region

Census

region Freq. Percent Cum.
—Break—
r(1);

end of do-file
—Break—
r(1);

When we pressed Break, Stata responded by typing —Break— and showed a return code of 1. Stata
seemingly repeated itself, typing first “end of do-file”, and then —Break— and the return code of 1
again. Do not worry about the repeated messages. The first message indicates that Stata was stopping
the tabulate because you pressed Break, and the second message indicates that Stata is stopping
the do-file for the same reason.

4

> Example 5

Let’s try our example again, but this time, let’s introduce an error. We change the file myjob2.do
to read

begin myjob2.do
version 13

use censas

tabulate region

summarize marriage_rate divorce_rate median_age if state!="Nevada"

end myjob2.do

To introduce a subtle typographical error, we typed use censas when we meant use censusb5. We
assume that there is no file called censas.dta, so now we have an error. Here is what happens
when you instruct Stata to do the file:
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. do myjob2
. version 13

. use censas
file censas.dta not found
r(601);

end of do-file
r(601);

When Stata was told to use censas, it responded with “file censas.dta not found” and a return code
of 601. Stata then typed “end of do-file” and repeated the return code of 601. The repeated message
occurred for the same reason it did when we pressed Break in the previous example. The use resulted
in a return code of 601, so the do-file itself resulted in the same return code. The important thing to
understand is that Stata stopped executing the file because there was an error.

4

Q Technical note

We can tell Stata to continue executing the file even if there are errors by typing do filename,
nostop. Here is the result:

. do myjob2, nostop
. version 13

. use censas
file censas.dta not found
r(601);

. tabulate region
no variables defined
r(111);

summarize marriage_rate divorce_rate median_age if state!="Nevada"
no variables defined
r(111);

end of do-file

None of the commands worked because the do-file’s first command failed. That is why Stata
ordinarily stops. However, if our file had contained anything that could work, it would have worked.
In general, we do not recommend coding in this manner, as unintended consequences can result when

errors do not stop execution.
a

16.1.5 Logging the output of do-files

You log the output of do-files just as you would an interactive session; see [U] 15 Saving and
printing output—Ilog files.
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Many users include the commands to start and stop the logging in the do-file itself:

begin myjob3.do
version 13

log using myjob3, replace

* a sample analysis job

use census

tabulate region // obtain summary statistics
summarize marriage_rate divorce_rate median_age if state!="Nevada"
log close

end myjob3.do

We chose to open with log using myjob3, replace, the important part being the replace option.
Had we omitted the option, we could not easily rerun our do-file. If myjob3.smcl had already existed
and log was not told that it is okay to replace the file, the do-file would have stopped and instead
reported that “file myjob3.smcl already exists”. We could get around that, of course, by erasing the
log file before running the do-file.

16.1.6 Preventing —more— conditions

Assume that you are running a do-file and logging the output so that you can look at it later. Then
Stata’s feature of pausing every time the screen is full is just an irritation: it means that you have to
sit and watch the do-file run so you can clear the —more—.

The way around this is to include the line set more off in your do-file. Setting more to off, as
explained in [U] 7 —-more- conditions, prevents Stata from ever issuing a —more—.

16.2 Calling other do-files

Do-files may call other do-files. Say that you wrote makedata.do, which infiles your data,
generates a few variables, and saves stepl.dta. Say that you wrote anlstepl.do, which performed
a little analysis on stepl.dta. You could then create a third do-file,

begin master.do
version 13
do makedata
do anlstepl

end master.do

and so in effect combine the two do-files.

Do-files may call other do-files, which, in turn, call other do-files, and so on. Stata allows do-files
to be nested 64 deep.

Be not confused: master.do above could call 1,000 do-files one after the other, and still the level
of nesting would be only two.
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16.3 Creating and running do-files

16.3.1

Creating and running do-files for Windows

1. You can execute do-files by typing do followed by the filename, as we did above.
. You can execute do-files by selecting File > Do....

3. You can use the Do-file Editor to compose, save, and execute do-files; see [GSW] 13 Using

the Do-file Editor—automating Stata. To use the Do-file Editor, click on the Do-file Editor
button, or type doedit in the Command window. Stata also has a Project Manager for managing
collections of do-files and other files. See [P] Project Manager.

. You can double-click on the icon for the do-file to launch Stata and open the do-file in the

Do-file Editor.

. You can run the do-file in batch mode. See [GSW] B.5 Stata batch mode for details, but the

short explanation is that you open a Window command window and type

C:\data> "C:\Program Files\Statal3\Stata" /s do myjob

or

C:\data> "C:\Program Files\Statai3\Stata" /b do myjob

to run in batch mode, assuming that you have installed Stata in the folder C:\Program
Files\Statal3. /b and /s determine the kind of log produced, but put that aside for a
second. When you start Stata in these ways, Stata will run in the background. When the do-file
completes, the Stata icon on the taskbar will flash. You can then click on it to close Stata. If
you want to stop the do-file before it completes, click on the Stata icon on the taskbar, and
Stata will ask you if you want to cancel the job. If you want Stata to exit when the do-file is
complete rather than flashing on the taskbar, also specify /e on the command line.

To log the output, you can start the log before executing the do-file or you can include the log using
and log close in your do-file.

16.3.2

When you run Stata in these ways, Stata takes the following actions:

a. Stata automatically opens a log. If you specified /s, Stata will open a SMCL log; if you
specified /b, Stata will open a plain text log. If your do-file is named xyz.do, the log
will be called xyz.smcl (/s) or xyz.log (/b) in the same directory.

b. If your do-file explicitly opens another log, Stata will save two copies of the output.

c. Stata ignores —more— conditions and anything else that would cause the do-file to stop
were it running interactively.

Creating and running do-files for Mac

. You can execute do-files by typing do followed by the filename, as we did above.
. You can execute do-files by selecting File > Do....

3. You can use the Do-file Editor to compose, save, and execute do-files; see [GSM] 13 Using the

Do-file Editor—automating Stata. Click on the Do-file Editor button, or type doedit in the
Command window. Stata also has a Project Manager for managing collections of do-files and
other files. See [P] Project Manager.

. You can double-click on the icon for the do-file to open the do-file in the Do-file Editor.
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5. Double-clicking on the icon for a do-file named Stata.do will launch Stata if it is not already
running and set the current working directory to the location of the do-file.

6. You can run the do-file in batch mode. See [GSM] B.3 Stata batch mode for details, but the
short explanation is that you open a Terminal window and type

% /Applications/Stata/Stata.app/Contents/Mac0S/Stata -s do myjob

or

% /Applications/Stata/Stata.app/Contents/Mac0S/Stata -b do myjob

to run in batch mode, assuming that you have installed Stata/IC in the folder
/Applications/Stata. -b and -s determine the kind of log produced, but put that aside for a
second. When you start Stata in these ways, Stata will run in the background. When the do-file
completes, the Stata icon on the Dock will bounce until you put Stata into the foreground. You
can then exit Stata. If you want to stop the do-file before it completes, right-click on the Stata
icon on the Dock, and select Quit.

To log the output, you can start the log before executing the do-file or you can include the log using
and log close in your do-file.

When you run Stata in these ways, Stata takes the following actions:

a. Stata automatically opens a log. If you specified -s, Stata will open a SMCL log; if you
specified -b, Stata will open a plain text log. If your do-file is named xyz.do, the log
will be called xyz.smcl (-s) or xyz.log (-b) in the same directory.

b. If your do-file explicitly opens another log, Stata will save two copies of the output.

c. Stata ignores —more— conditions and anything else that would cause the do-file to stop
were it running interactively.

16.3.3 Creating and running do-files for Unix

1. You can execute do-files by typing do followed by the filename, as we did above.
2. You can execute do-files by selecting File > Do....

3. You can use the Do-file Editor to compose, save, and execute do-files; see [GSU] 13 Using the
Do-file Editor—automating Stata. Click on the Do-file Editor button, or type doedit in the
Command window. Stata also has a Project Manager for managing collections of do-files and
other files. See [P] Project Manager.

4. At the Unix prompt, you can type
$ xstata do filename
or
$ stata do filename
to launch Stata and run the do-file. When the do-file completes, Stata will prompt you for the
next command just as if you had started Stata the normal way. If you want Stata to exit instead,
include exit, STATA clear as the last line of your do-file.

To log the output, you can start the log before executing the do-file or you can include the log using
and log close in your do-file.
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5. At the Unix prompt, you can type

$ stata -s do filename &
or

$ stata -b do filename &
to run the do-file in the background. The above two examples both involve the use of stata, not
xstata. Type stata, even if you usually use the GUI version of Stata, xstata. The examples
differ only in that one specifies the —s option and the other, the -b option, which determines
the kind of log that will be produced. In the above examples, Stata takes the following actions:

a. Stata automatically opens a log. If you specified -s, Stata will open a SMCL log; if you
specified -b, Stata will open a plain text log. If your do-file is named xyz.do, the log
will be called xyz.smcl (-s) or xyz.1log (-b) in the current directory (the directory from
which you issued the stata command).

b. If your do-file explicitly opens another log, Stata will save two copies of the output.

c. Stata ignores —more— conditions and anything else that would cause the do-file to stop
were it running interactively.

To reiterate: one way to run a do-file in the background and obtain a text log is by typing

$ stata -b do myfile &

Another way uses standard redirection:

$ stata < myfile.do > myfile.log &

The first way is slightly more efficient. Either way, Stata knows it is in the background and ignores
—more— conditions and anything else that would cause the do-file to stop if it were running
interactively. However, if your do-file contains either the #delimit command or the comment
characters (/* at the end of one line and */ at the beginning of the next), the second method will
not work. We recommend that you use the first method: stata -b do myfile &.

The choice between stata -b do myfile & and stata -s do myfile & is more personal. We
prefer obtaining SMCL logs (-s) because they look better when printed, and, in any case, they can
always be converted to text format with translate; see [R] translate.

16.4 Programming with do-files

This is an advanced topic, and we are going to refer to concepts not yet explained; see [U] 18 Pro-
gramming Stata for more information.

16.4.1 Argument passing

Do-files accept arguments, just as Stata programs do; this is described in [U] 18 Programming
Stata and [U] 18.4 Program arguments. In fact, the logic Stata follows when invoking a do-file
is the same as when invoking a program: the local macros are stored, and new ones are defined.
Arguments are stored in the local macros ‘1’, ‘2’, and so on. When the do-file completes, the
previous definitions are restored, just as with programs.

Thus, if you wanted your do-file to
1. use a dataset of your choosing,
2. tabulate a variable named region, and

3. summarize variables marriage_rate and divorce_rate,
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you could write the do-file

begin myxmpl.do
use ‘1’

tabulate region

summarize marriage_rate divorce_rate

end myxmpl.do

and you could run this do-file by typing, for instance,

. do myxmpl census
(output omitted )

The first command—use ‘1’ —would be interpreted as use censusb because census5 was the
first argument you typed after do myxmpl.

An even better version of the do-file would read

begin myxmpl.do
args dsname

use ‘dsname’

tabulate region

summarize marriage_rate divorce_rate

end myxmpl.do

The args command merely assigns a better name to the argument passed. args dsname does not
verify that what we type following do myxmpl is a filename—we would have to use the syntax
command if we wanted to do that—but substituting ‘dsname’ for ‘1’ does make the code more
readable.

If our program were to receive two arguments, we could refer to them as ‘1’ and ¢2’, or we could
put an ‘args dsname other’ at the top of our do-file and then refer to ‘dsname’ and ‘other’.

To learn more about argument passing, see [U] 18.4 Program arguments. Baum (2009) provides
many examples and tips related to do-files.

16.4.2 Suppressing output

There is an alternative to typing do filename; it is run filename. run works in the same way as
do, except that neither the instructions in the file nor any of the output caused by those instructions
is shown on the screen or in the log file.

For instance, with the above myxmpl.do, typing run myxmpl censusb results in

. run myxmpl census

All the instructions were executed, but none of the output was shown.

This is not useful here, but if the do-file contained only the definitions of Stata programs—see
[U] 18 Programming Stata—and you merely wanted to load the programs without seeing the code,
run would be useful.
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17.1 Description

Stata is programmable, and even if you never write a Stata program, Stata’s programmability is
still important. Many of Stata’s features are implemented as Stata programs, and new features are
implemented every day, both by StataCorp and by others.

1.

4.

You can obtain additions from the Stata Journal. You subscribe to the printed journal, but the
software additions are available free over the Internet.

You can obtain additions from the Stata listserver, Statalist, where an active group of users
advise each other on how to use Stata, and often, in the process, trade programs. Visit the
Stata website, http://www.stata.com, for instructions on how to subscribe; subscribing to the
listserver is free.

. The Boston College Statistical Software Components (SSC) archive is a distributed database

making available a large and constantly growing number of Stata programs. You can browse and
search the archive, and you can find links to the archive from http://www.stata.com. Importantly,
Stata knows how to access the archive and other places, as well. You can search for additions
by using Stata’s search, net command; see [R] search. You can immediately install materials
you find with search, net by using the hyperlinks that will be displayed by search in
the Results window or by using the net command. A specialized command, ssc, has several
options available to help you find and install the user-written commands that are available from
this site; see [R] ssc.

You can write your own additions to Stata.

This chapter is written for people who want to use ado-files. All users should read it. If you later
decide you want to write ado-files, see [U] 18.11 Ado-files.
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17.2 What is an ado-file?

An ado-file defines a Stata command, but not all Stata commands are defined by ado-files.

When you type summarize to obtain summary statistics, you are using a command built into
Stata.

When you type ci to obtain confidence intervals, you are running an ado-file. The results of using
a built-in command or an ado-file are indistinguishable.

An ado-file is a text file that contains a Stata program. When you type a command that Stata does
not know, it looks in certain places for an ado-file of that name. If Stata finds it, Stata loads and
executes it, so it appears to you as if the ado-command is just another command built into Stata.

We just told you that Stata’s ci command is implemented as an ado-file. That means that,
somewhere, there is a file named ci.ado.

Ado-files usually come with help files. When you type help ci (or select Help > Stata Command...,
and type ci), Stata looks for ci.sthlp, just as it looks for ci.ado when you use the ci command.
A help file is also a text file that tells Stata’s help system what to display.

17.3 How can | tell if a command is built in or an ado-file?

You can use the which command to determine whether a file is built in or implemented as an
ado-file. For instance, logistic is an ado-file, and here is what happens when you type which
logistic:

. which logistic

C:\Program Files\Statal3\ado\base\l\logistic.ado
*! version 3.5.1 03feb2012

summarize is a built-in command:

. which summarize
built-in command: summarize

17.4 How can | look at an ado-file?

When you type which followed by an ado-command, Stata reports where the file is stored:

. which logistic
C:\Program Files\Statal3\ado\base\l\logistic.ado
*! version 3.5.1 03feb2012

Ado-files are just text files containing the Stata program, so you can type them or view them in
Stata’s Viewer (or even look at them in your editor or word processor):

. type "C:\Program Files\Statal3\ado\base\l\logistic.ado"
*! version 3.5.1 03feb2012
program define logistic, eclass prop(or svyb svyj svyr swml mi) byable(onecall)
version 6.0, missing
(output omitted )
end

or

. viewsource logistic.ado
(output omitted )
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The type command displays the contents of a file. The viewsource command searches for a file
along the ado directories and displays the file in the Viewer. You can also look at the corresponding
help file in raw form if you wish. If there is a help file, it is stored in the same place as the ado-file:

. type "C:\Program Files\Statai3\ado\base\l\logistic.sthlp", asis

{smcl}

{* x! version 1.3.9 03apr2013}{...}

{viewerdialog logistic "dialog logistic"}{...}

{viewerdialog "svy: logistic" "dialog logistic, message(-svy-)

name (svy_logistic)"}{...}
{vieweralsosee "[R] logistic" "mansection R logistic"}{...}
(output omitted )

or

. viewsource logistic.sthlp
(output omitted )

17.5 Where does Stata look for ado-files?

Stata looks for ado-files in seven places, which can be categorized in three ways:

1. The official ado directory:
1. (BASE), the official directory containing the ado-files shipped with your version of Stata
and any updated ado-files that have been made available since then

II. Your personal ado-directories:
2. (SITE), the directory for ado-files your site might have installed
3. (PLUS), the directory for ado-files you personally might have installed
4. (PERSONAL), the directory for ado-files you might have written
5. (OLDPLACE), the directory where Stata users used to save their personally written ado-files

III. The current directory:
6. (.), the ado-files you have written just this instant or for just this project

The location of these directories varies from computer to computer, but Stata’s sysdir command
will tell you where they are on your computer:

. sysdir
STATA: C:\Program Files\Statal3\
BASE: C:\Program Files\Statal3\ado\base\
SITE: C:\Program Files\Statal3\ado\site\
PLUS: C:\ado\plus\

PERSONAL: C:\ado\personal\

OLDPLACE: C:\ado\
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17.5.1

17.5.2

Where is the official ado-directory?

This is the directory listed as BASE by sysdir:

. sysdir
STATA: C:\Program Files\Statal3\
BASE: C:\Program Files\Statal3\ado\base\
SITE: C:\Program Files\Statal3\ado\site\
PLUS: C:\ado\plus\

PERSONAL: C:\ado\personal\

OLDPLACE: C:\ado\

. BASE contains the ado-files we originally shipped to you and any updates you might have

installed since then. You can install updates by using the update command or by selecting
Help > Check for Updates; see [U] 17.8 How do I install official updates?.

Where is my personal ado-directory?

These are the directories listed as PERSONAL, PLUS, SITE, and OLDPLACE by sysdir:

. sysdir
STATA: C:\Program Files\Statal3\
BASE: C:\Program Files\Statal3\ado\base\
SITE: C:\Program Files\Statal3\ado\site\
PLUS: C:\ado\plus\

PERSONAL: C:\ado\personal\

OLDPLACE: C:\ado\

. PERSONAL is for ado-files you have written. Store your private ado-files here; see [U] 17.7 How

do I add my own ado-files?.

PLUS is for ado-files you personally installed but did not write. Such ado-files are usually
obtained from the SJ or the SSC archive, but they are sometimes found in other places, too. You
find and install such files by using Stata’s net command, or you can select Help > SJ and
User-written Programs; see [U] 17.6 How do I install an addition?.

. SITE is really the opposite of a personal ado directory—it is a public directory corresponding

to PLUS. If you are on a networked computer, the site administrator can install ado-files here,
and all Stata users will then be able to use them just as if they all found and installed them
in their PLUS directory for themselves. Site administrators find and install the ado-files just as
you would, using Stata’s net command, but they specify an option when they install something
that tells Stata to write the files into SITE rather than PLUS; see [R] net.

OLDPLACE is for old-time Stata users. Prior to Stata 6, all “personal” ado-files, whether personally
written or just personally installed, were written in the same directory—OLDPLACE. So that the
old-time Stata users do not have to go back and rearrange what they have already done, Stata
still looks in OLDPLACE.
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17.6 How do | install an addition?

Additions come in four types:
1. User-written additions, which you might find in the SJ, etc.

2. Updates to user-written additions
See [U] 17.9 How do I install updates to user-written additions?.

3. Ado-files you have written
See [U] 17.7 How do I add my own ado-files? If you have an ado-file obtained from
the Stata listserver or a friend, treat it as belonging to this case.

4. Official updates provided by StataCorp
See [U] 17.8 How do I install official updates?.

User-written additions you might find in the Stata Journal (SJ), etc., are obtained over the Internet.
To access them on the Internet,

1. select Help > SJ and User-written Programs, and click on one of the links
or
2. type net from http://www.stata.com.

What to do next will be obvious, but, in case it is not, see [GS] 19 Updating and extending
Stata—Internet functionality (GSM, GSU, or GSW). Also see [U] 28 Using the Internet to keep up
to date, [R] net, and [R] adoupdate.

17.7 How do | add my own ado-files?

You write a Stata program (see [U] 18 Programming Stata), store it in a file ending in .ado,
perhaps write a help file, and copy everything to the directory sysdir lists as PERSONAL:

. sysdir
STATA: C:\Program Files\Statal3\
BASE: C:\Program Files\Statal3\ado\base\
SITE: C:\Program Files\Statal3\ado\site\
PLUS: C:\ado\plus\

PERSONAL: C:\ado\personal\

OLDPLACE: C:\ado\

Here we would copy the files to C:\ado\personal.

While you are writing your ado-file, it is sometimes convenient to store the pieces in the current
directory. Do that if you wish; you can move them to your personal ado-directory when the program
is debugged.

17.8 How do | install official updates?

Updates are available over the Internet:

1. select Help > Check for Updates, and then click on http://www.stata.com
or

2. type update query.

What to do next should be obvious, but in case it is not, see [GS] 19 Updating and extending
Stata—Internet functionality (GSM, GSU, or GSW). Also see [U] 28 Using the Internet to keep up
to date and [R] net.
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The official updates include bug fixes and new features but do not change the syntax of an existing
command or change the way Stata works.

Once you have installed the updates, you can enter Stata and type help whatsnew (or select
Help > What’s New?) to learn about what has changed.

17.9 How do | install updates to user-written additions?

If you have previously installed user-written additions, you can check for updates to them by
typing adoupate. If updates are available, you can install them by typing adoupdate, update. See
[R] adoupdate.

17.10 Reference
Cox, N. J. 2006. Stata tip 30: May the source be with you. Stata Journal 6: 149-150.
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Stata programming is an advanced topic. Some Stata users live productive lives without ever
programming Stata. After all, you do not need to know how to program Stata to import data, create
new variables, and fit models. On the other hand, programming Stata is not difficult—at least if the
problem is not difficult—and Stata’s programmability is one of its best features. The real power of
Stata is not revealed until you program it.

Stata has two programming languages. One, known informally as “ado”, is the focus of this chapter.
It is based on Stata’s commands, and you can write scripts and programs to automate reproducible
analyses and to add new features to Stata.

The other language, Mata, is a byte-compiled language with syntax similar to C/C++, but with
extensive matrix capabilities. The two languages can interact with each other. You can call Mata
functions from ado-programs, and you can call ado-programs from Mata functions. You can learn all
about Mata in the Mata Reference Manual.

Stata also has a Project Manager to help you manage large collections of Stata scripts, programs,
and other files. See [P] Project Manager.

If you are uncertain whether to read this chapter, we recommend that you start reading and then
bail out when it gets too arcane for you. You will learn things about Stata that you may find useful
even if you never write a Stata program.

If you want even more, we offer courses over the Internet on Stata programming; see [U] 3.7.2 Net-
Courses. Baum (2009) provides a wealth of practical knowledge related to Stata programming.

18.1 Description

When you type a command that Stata does not recognize, Stata first looks in its memory for a
program of that name. If Stata finds it, Stata executes the program.

There is no Stata command named hello,

. hello
unrecognized command
r(199);

but there could be if you defined a program named hello, and after that, the following might happen
when you typed hello:

. hello
hi there

This would happen if, beforehand, you had typed

. program hello
1. display "hi there"
2. end

That is how programming works in Stata. A program is defined by

program progname
Stata commands
end

and it is executed by typing progname at Stata’s dot prompt.
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18.2 Relationship between a program and a do-file

Stata treats programs the same way it treats do-files. Below we will discuss passing arguments,
consuming results from Stata commands, and other topics, but everything we say applies equally to
do-files and programs.

Programs and do-files differ in the following ways:

1. You invoke a do-file by typing do filename. You invoke a program by simply typing the
program’s name.

2. Programs must be defined (loaded) before they are used, whereas all that is required to run a
do-file is that the file exist. There are ways to make programs load automatically, however, so
this difference is of little importance.

3. When you type do filename, Stata displays the commands it is executing and the results. When
you type progname, Stata shows only the results, not the display of the underlying commands.
This is an important difference in outlook: in a do-file, how it does something is as important
as what it does. In a program, the how is no longer important. You might think of a program
as a new feature of Stata.

Let’s now mention some of the similarities:
1. Arguments are passed to programs and do-files in the same way.

2. Programs and do-files both contain Stata commands. Any Stata command you put in a do-file
can be put in a program.

3. Programs may call other programs. Do-files may call other do-files. Programs may call do-files
(this rarely happens), and do-files may call programs (this often happens). Stata allows programs
(and do-files) to be nested up to 64 deep.

Now here is the interesting thing: programs are typically defined in do-files (or in a variant of do-files
called ado-files; we will get to that later).

You can define a program interactively, and that is useful for pedagogical purposes, but in real
applications, you will compose your program in a text editor and store its definition in a do-file.

You have already seen your first program:
program hello

display "hi there"
end

You could type those commands interactively, but if the body of the program were more complicated,
that would be inconvenient. So instead, suppose that you typed the commands into a do-file:

begin hello.do
program hello

display "hi there"
end

end hello.do

Now returning to Stata, you type

. do hello

. program hello
1. display "hi there"
2. end

end of do-file
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Do you see that typing do hello did nothing but load the program? Typing do hello is the same as
typing out the program’s definition because that is all the do-file contains. The do-file was executed,
but the statements in the do-file only defined the program hello; they did not execute it. Now that
the program is loaded, we can execute it interactively:

. hello
hi there

So, that is one way you could use do-files and programs together. If you wanted to create new
commands for interactive use, you could

1. Write the command as a program ... end in a do-file.
2. do the do-file before you use the new command.
3. Use the new command during the rest of the session.

There are more convenient ways to do this that would automatically load the do-file, but put that
aside. The above method would work.

Another way we could use do-files and programs together is to put the definition of the program
and its execution together into a do-file:

begin hello.do ———
program hello
display "hi there"
end
hello

end hello.do ———

Here is what would happen if we executed this do-file:

. do hello

. program hello
1. display "hi there"
2. end

. hello

hi there

end of do-file

Do-files and programs are often used in such combinations. Why? Say that program hello is long
and complicated and you have a problem where you need to do it twice. That would be a good reason
to write a program. Moreover, you may wish to carry forth this procedure as a step of your analysis
and, being cautious, do not want to perform this analysis interactively. You never intended program
hello to be used interactively—it was just something you needed in the midst of a do-file—so you
defined the program and used it there.

Anyway, there are many variations on this theme, but few people actually sit in front of Stata and
interactively type program and then compose a program. They instead do that in front of their text
editor. They compose the program in a do-file and then execute the do-file.

There is one other (minor) thing to know: once a program is defined, Stata does not allow you to
redefine it:

. program hello
hello already defined
r(110);
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Thus, in our most recent do-file that defines and executes hello, we could not rerun it in the same
Stata session:

. do hello

. program hello
hello already defined
r(110);

end of do-file
r(110);

That problem is solved by typing program drop hello before redefining it. We could do that
interactively, or we could modify our do-file:

begin hello.do
program drop hello
program hello
display "hi there"
end
hello
end hello.do

There is a problem with this solution. We can now rerun our do-file, but the first time we tried to
run it in a Stata session, it would fail:

. do hello

. program drop hello
hello not found
r(111);

end of do-file
r(111);

The way around this conundrum is to modify the do-file:

begin hello.do
capture program drop hello
program hello
display "hi there"
end
hello

end hello.do

capture in front of a command makes Stata indifferent to whether the command works; see
[P] capture. In real do-files containing programs, you will often see capture program drop before
the program’s definition.

To learn about the program command itself, see [P] program. It manipulates programs. program
can define programs, drop programs, and show you a directory of programs that you have defined.

A program can contain any Stata command, but certain Stata commands are of special interest to
program writers; see the Programming heading in the subject table of contents in the Glossary and
Index.
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18.3 Macros

Before we can begin programming, we must discuss macros, which are the variables of Stata
programs.

A macro is a string of characters, called the macroname, that stands for another string of characters,
called the macro contents.

Macros can be local or global. We will start with local macros because they are the most commonly
used, but nothing really distinguishes one from the other at this stage.

18.3.1 Local macros
Local macro names can be up to 31 (not 32) characters long.

One sets the contents of a local macro with the 1ocal command. In fact, we can do this interactively.
We will begin by experimenting with macros in this way to learn about them. If we type

. local shortcut "myvar thisvar thatvar"

then ‘shortcut’ is a synonym for “myvar thisvar thatvar”. Note the single quotes around
shortcut. We said that sentence exactly the way we meant to because

if you type ‘shortcut’,
ie., left-single-quote shortcut right-single-quote,
Stata hears myvar thisvar thatvar.

To access the contents of the macro, we use a left single quote (located at the upper left on most
keyboards), the macro name, and a right single quote (located under the " on the right side of most
keyboards).

The single quotes bracketing the macroname shortcut are called the macro-substitution characters.
shortcut means shortcut. ‘shortcut’ means myvar thisvar thatvar.

So, if you typed
. list ‘shortcut’
the effect would be exactly as if you typed
. list myvar thisvar thatvar

Macros can be used anywhere in Stata. For instance, if we also defined

. local cmd "list"

we could type

‘cmd’ ‘shortcut’

to mean list myvar thisvar thatvar.
For another example, consider the definitions

. local prefix "my"
. local suffix "var"

Then

‘cmd’ ‘prefix’ ‘suffix’

would mean list myvar.
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One other important note is on the way we use left and right single quotes within Stata, which
you will especially deal with when working with macros (see [U] 18.3 Macros). Single quotes (and
double quotes, for that matter) may look different on your keyboard, your monitor, and our printed
documentation, making it difficult to determine which key to press on your keyboard to replicate
what we have shown you.

For the left single quote, we use the grave accent, which occupies a key by itself on most computer
keyboards. On U.S. keyboards, the grave accent is located at the top left, next to the numeral 1. On
some non-U.S. keyboards, the grave accent is produced by a dead key. For example, pressing the
grave accent dead key followed by the letter a would produce a; to get the grave accent by itself,
you would press the grave accent dead key followed by a space. This accent mark appears in our
printed documentation as ‘.

For the right single quote, we use the standard single quote, or apostrophe. On U.S. keyboards,
the single quote is located on the same key as the double quote, on the right side of the keyboard
next to the Enter key.

18.3.2 Global macros

Let’s put aside why Stata has two kinds of macros—local and global—and focus right now on
how global macros work.

Global macros can have names that are up to 32 (not 31) characters long. You set the contents of
a global macro by using the global rather than the local command:

. global shortcut "alpha beta"
You obtain the contents of a global macro by prefixing its name with a dollar sign: $shortcut is
equivalent to “alpha beta”.

In the previous section, we defined a local macro named shortcut, which is a different macro.
‘shortcut’ is still “myvar thisvar thatvar”.

Local and global macros may have the same names, but even if they do, they are unrelated and
are still distinguishable.

Global macros are just like local macros except that you set their contents with global rather
than local, and you substitute their contents by prefixing them with a $ rather than enclosing them
in €.

18.3.3 The difference between local and global macros
The difference between local and global macros is that local macros are private and global macros
are public.
Say that you have written a program
program myprog

code using local macro alpha
end

The local macro alpha in myprog is private in that no other program can modify or even look at
alpha’s contents. To make this point absolutely clear, assume that your program looks like this:
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program myprog
code using local macro alpha
mysub
more code using local macro alpha
end

program mysub
code using local macro alpha
end

myprog calls mysub, and both programs use a local macro named alpha. Even so, the local macros
in each program are different. mysub’s alpha macro may contain one thing, but that has nothing to
do with what myprog’s alpha macro contains. Even when mysub begins execution, its alpha macro
is different from myprog’s. It is not that mysub’s inherits myprog’s alpha macro contents but is then
free to change it. It is that myprog’s alpha and mysub’s alpha are entirely different things.

When you write a program using local macros, you need not worry that some other program
has been written using local macros with the same names. Local macros are just that: local to your
program.

Global macros, on the other hand, are available to all programs. If both myprog and mysub use
the global macro beta, they are using the same macro. Whatever the contents of $beta are when
mysub is invoked, those are the contents when mysub begins execution, and, whatever the contents
of $beta are when mysub completes, those are the contents when myprog regains control.

18.3.4 Macros and expressions

From now on, we are going to use local and global macros according to whichever is convenient;
whatever is said about one applies to the other.

Consider the definitions

. local one 2+2
. local two = 2+2

(which we could just as well have illustrated using the global command). In any case, note the
equal sign in the second macro definition and the lack of the equal sign in the first. Formally, the
first should be

. local one "2+2"

but Stata does not mind if we omit the double quotes in the local (global) statement.
local one 2+2 (with or without double quotes) copies the string 2+2 into the macro named one.

local two = 2+2 evaluates the expression 2+2, producing 4, and stores 4 in the macro named
two.

That is, you type
local macname contents
if you want to copy contents to macname, and you type
local macname = expression
if you want to evaluate expression and store the result in macname.

In the second form, expression can be numeric or string. 2+2 is a numeric expression. As an
example of a string expression,

. local res = substr("this",1,2) + "at"

stores that in res.
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Because the expression can be either numeric or string, what is the difference between the following
statements?

. local a "example"
. local b = "example"

Both statements store example in their respective macros. The first does so by a simple copy operation,
whereas the second evaluates the expression "example", which is a string expression because of
the double quotes that, here, evaluates to itself. You could put a more complicated expression to be
evaluated on the right-hand side of the second syntax.

There are some other issues of using macros and expressions that look a little strange to programmers
coming from other languages, at least the first time they see them. Say that the macro ‘i’ contains
5. How would you increment i so that it contains 5 + 1 = 6? The answer is

local i = ‘i’ + 1
Do you see why the single quotes are on the right but not the left? Remember, ‘i’ refers to the
contents of the local macro named i, which, we just said, is 5. Thus, after expansion, the line reads

local i =5+ 1

which is the desired result.

There is a another way to increment local macros that will be more familiar to some programmers,
especially C programmers:

local ++i
As C programmers would expect, local ++i is more efficient (executes more quickly) than local
i = i+1, but in terms of outcome, it is equivalent. You can decrement a local macro by using

local --i

local --i is equivalent to local i = i-1 but executes more quickly. Finally,

local i++

will not increment the local macro i but instead redefines the local macro i to contain ++. There is,
however, a context in which i++ (and i--) do work as expected; see [U] 18.3.7 Macro increment
and decrement functions.

18.3.5 Double quotes

Consider another local macro, ‘answ’, which might contain yes or no. In a program that was
supposed to do something different on the basis of answ’s content, you might code

if "‘answ’" == "yes" {
¥
else {
3
Note the odd-looking " ‘answ’", and now think about the line after substitution. The line reads
either
if "yes" == “yes" {
or

if "no" == "yes" {
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either of which is the desired result. Had we omitted the double quotes, the line would have read

if no == "yes" {

(assuming ‘answ’ contains no), and that is not at all the desired result. As the line reads now, no
would not be a string but would be interpreted as a variable in the data.

The key to all this is to think of the line after substitution.

Double quotes are used to enclose strings: "yes", "no", "my dir\my file", " ‘answ’" (meaning
that the contents of local macro answ, treated as a string), and so on. Double quotes are used with
macros,

local a "example"

if "‘answ’" == "yes" {
}

and double quotes are used by many Stata commands:

. regress lnwage age ed if sex=="female"
. gen outa = outcome if drug=="A"

. use "person file"

Do not omit the double quotes just because you are using a “quoted” macro:

==n¢

. regress lnwage age ed if sex=="‘x’"
. gen outa = outcome if drug=="‘firstdrug’"

. use "‘filename’"

Stata has two sets of double-quote characters, of which "" is one. The other is ‘""’. They both
work the same way:

. regress lnwage age ed if sex==‘"female"’
. gen outa = outcome if drug==‘"A"’

. use ‘"person file"’

No rational user would use ‘""’ (called compound double quotes) instead of "" (called simple double
quotes), but smart programmers do use them:

local a ‘"example"’

if tntansw)u: == ‘"yes“’ {

Why is ‘"example"’ better than "example", ‘" ‘answ’"’ better than "‘answ’", and ‘"yes"’
better than "yes"? The answer is that only ‘"‘answ’"’ is better than " ‘answ’"; ‘"example"’
and ‘"yes"’ are no better—and no worse—than "example" and "yes".

‘"fansw’"’ is better than " ‘answ’" because the macro answ might itself contain (simple or
compound) double quotes. The really great thing about compound double quotes is that they nest.
Say that ‘answ’ contained the string “I "think" so”. Then,

Stata would find if "‘answ’"=="yes"
confusing because it would expand to if "I "think" so"=="yes"
Stata would not find if ‘"‘answ’"’==‘"yes"’

confusing because it would expand to if ‘"I "think" so"’==‘"yes"’
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Open and close double quote in the simple form look the same; open quote is " and so is close
quote. Open and close double quote in the compound form are distinguishable; open quote is ‘" and
close quote is "’, and so Stata can pair the close with the corresponding open double quote. ‘"I
"think" so"’ is easy for Stata to understand, whereas "I "think" so" is a hopeless mishmash.
(If you disagree, consider what "A"B"C" might mean. Is it the quoted string A"B"C, or is it quoted
string A, followed by B, followed by quoted string C?)

Because Stata can distinguish open from close quotes, even nested compound double quotes are
understandable: ‘"I ‘"think"’ so"’. (What does "A"B"C" mean? Either it means ‘"A¢"B"’>C"’
or it means ‘"A"’B¢"C" J.)

Yes, compound double quotes make you think that your vision is stuttering, especially when
combined with the macro substitution ¢’ characters. That is why we rarely use them, even when
writing programs. You do not have to use exclusively one or the other style of quotes. It is perfectly
acceptable to code

local a "example"

if ‘"‘answ’"’ == "yes" {

using compound double quotes where it might be necessary (‘" ‘answ’"’) and using simple double
quotes in other places (such as "yes"). It is also acceptable to use simple double quotes around
macros (for example, " “answ’") if you are certain that the macros themselves do not contain double
quotes or (more likely) if you do not care what happens if they do.

Sometimes careful programmers should use compound double quotes. Later you will learn that
Stata’s syntax command interprets standard Stata syntax and so makes it easy to write programs
that understand things like

. myprog mpg weight if strpos(make,"VW")!=0

syntax works—we are getting ahead of ourselves—by placing the if exp typed by the user in the
local macro if. Thus ¢if’ will contain “if strpos(make,"VW")!=0" here. Now say that you are
at a point in your program where you want to know whether the user specified an if exp. It would
be natural to code

if ‘ll‘if}ll) !: nn {
// the if exp was specified
}
else {
// it was not
}

We used compound double quotes around the macro ‘if’. The local macro ‘if’ might contain
double quotes, so we placed compound double quotes around it.

18.3.6 Extended macro functions

In addition to allowing =exp, local and global provide extended functions. The use of an
extended function is denoted by a colon (:) following the macro name, as in

local 1bl : variable label myvar
local filenames : dir "." files "*.dta"

local xi : word ‘i’ of ‘list’
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Some macro extended functions access a piece of information. In the first example, the variable label
associated with variable myvar will be stored in macro 1bl. Other macro extended functions perform
operations to gather the information. In the second example, macro filenames will contain the
names of all the .dta datasets in the current directory. Still other macro extended functions perform
an operation on their arguments and return the result. In the third example, xi will contain the ¢i’th
word (element) of ‘list’. See [P] macro for a list of the macro extended functions.

Another useful source of information is c(), documented in [P] creturn:

local today "‘c(current_date)’"
local curdir "‘c(pwd)’"

local newn = c(N)+1

c() refers to a prerecorded list of values, which may be used directly in expressions or which may
be quoted and the result substituted anywhere. c (current_date) returns today’s date in the form
”dd MON yyyy”. Thus the first example stores in macro today that date. c (pwd) returns the current
directory, such as C:\data\proj. Thus the second example stores in macro curdir the current
directory. c(N) returns the number of observations of the data in memory. Thus the third example
stores in macro newn that number, plus one.

Note the use of quotes with c(). We could just as well have coded the first two examples as
local today = c(current_date)

local curdir = c(pwd)

c() is a Stata function in the same sense that sqrt() is a Stata function. Thus we can use c()
directly in expressions. It is a special property of macro expansion, however, that you may use the
c() function inside macro-expansion quotes. The same is not true of sqrt ().

In any case, whenever you need a piece of information, whether it be about the dataset or about
the environment, look in [P] macro and [P] creturn. It is likely to be in one place or the other, and
sometimes, it is in both. You can obtain the current directory by using

local curdir = c(pwd)
or by using

local curdir : pwd

When information is in both, it does not matter which source you use.

18.3.7 Macro increment and decrement functions

We mentioned incrementing macros in [U] 18.3.4 Macros and expressions. The construct

command that makes reference to ‘i’
local ++i

occurs so commonly in Stata programs that it is convenient (and faster when executed) to collapse
both lines of code into one and to increment (or decrement) i at the same time that it is referred to.
Stata allows this:
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while (‘++i’ < 1000) {

}
while (¢i++’ < 1000) {

3
while (¢--i> > 0) {

while (‘i-=> > 0) {

b
Above we have chosen to illustrate this by using Stata’s while command, but ++ and -- can be used
anyplace in any context, just so long as it is enclosed in macro-substitution quotes.

When the ++ or -- appears before the name, the macro is first incremented or decremented, and
then the result is substituted.

When the ++ or —- appears after the name, the current value of the macro is substituted and then
the macro is incremented or decremented.

Q Technical note

Do not use the inline ++ or —- operators when a part of the line might not be executed. Consider

if (‘i’==0) local j = ‘k++’

Versus

if (‘i’==0) {
local j = ‘k++’

}

The first will not do what you expect because macros are expanded before the line is interpreted.
Thus the first will result in k always being incremented, whereas the second increments k only when

¢§ir==(.

a

18.3.8 Macro expressions

Typing

command that makes reference to ‘=exp’

is equivalent to

local macroname = exp
command that makes reference to ‘macroname’

although the former runs faster and is easier to type. When you use ‘=exp’ within some larger

command, exp is evaluated by Stata’s expression evaluator, and the results are inserted as a literal
string into the larger command. Then the command is executed. For example,
summarize ué

summarize u‘=2+2’
summarize u‘=4*(cos(0)==1)’
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all do the same thing. exp can be any valid Stata expression and thus may include references to
variables, matrices, scalars, or even other macros. In the last case, just remember to enclose the
submacros in quotes:

replace ‘var’ = ‘group’[‘=¢j’+1’]
Also, typing
command that makes reference to  : extended macro function’

is equivalent to
local macroname : extended macro function
command that makes reference to ‘macroname’
Thus one might code

format y ‘:format x’

to assign to variable y the same format as the variable x.

Q Technical note

There is another macro expansion operator, . (called dot), which is used in conjunction with
Stata’s class system; see [P] class for more information.

There is also a macro expansion function, macval (), which is for use when expanding a macro—
‘macval (name) > —which confines the macro expansion to the first level of name, thereby suppressing
the expansion of any embedded references to macros within name. Only two or three Stata users have
or will ever need this, but, if you suspect you are one of them, see [P] macro and then see [P] file

for an example.
a

18.3.9 Advanced local macro manipulation

This section is really an aside to help test your understanding of macro substitution. The tricky
examples illustrated below sometimes occur in real programs.

1. Say that you have macros x1, x2, x3, and so on. Obviously, ‘x1’ refers to the contents of x1,
‘x2’ to the contents of x2, etc. What does ‘x¢i’’ refer to? Suppose that ‘i’ contains 6.
The rule is to expand the inside first:
‘x¢i’’ expands to ‘x6’
‘x6° expands to the contents of local macro x6
So, there you have a vector of macros.

2. We have already shown adjoining expansions: ‘alpha’‘beta’ expands to myvar if ‘alpha’
contains my and ‘beta’ contains var. What does ‘alpha’‘gamma’ ‘beta’ expand to when
gamma is undefined?

Stata does not mind if you refer to a nonexistent macro. A nonexistent macro is treated as a macro
with no contents. If local macro gamma does not exist, then
‘gamma’ expands to nothing
It is not an error. Thus ‘alp